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Bio-Rads tekniska support
Bio-Rad-avdelningen för teknisk support i USA är öppen måndag till fredag kl. 5.00–17.00 PT (Pacific
Time).

Telefon: 1-800-424-6723, alternativ 2

E-post: Support@bio-rad.com (endast USA och Kanada)

För teknisk assistans utanför USA och Kanada kontaktar du det lokala kontoret för teknisk support
eller klickar på länken Contact us (Kontakta oss) på www.bio-rad.com.

Meddelande
Ingen del av denna publikation får reproduceras eller överföras i någon form eller på något sätt, vare
sig elektroniskt eller mekaniskt, inklusive fotokopiering, inspelning eller i något informationslager eller
söksystem, utan skriftligt tillstånd från Bio-Rad.

Bio-Rad förbehåller sig rätten att när som helst ändra sina produkter och tjänster. Denna handbok kan
ändras utan föregående meddelande. Även om företaget arbetar för att garantera noggrannhet, tar
Bio-Rad inget ansvar för fel eller utelämnanden eller för skada som uppstår på grund av hur den här
informationen tillämpas och används.

BIO-RAD är ett varumärke som tillhör Bio-Rad Laboratories, Inc.

BIO-RAD, HARD-SHELL och MICROSEAL är varumärken som tillhör Bio-Rad Laboratories, Inc. i
vissa jurisdiktioner.

SYBR är ett varumärke som tillhör Thermo Fisher Scientific Inc. Bio-Rad Laboratories, Inc. har licens
att sälja reagenser som innehåller SYBR Green I för användning i realtids-PCR, endast för
forskningssyften.

EvaGreen är ett varumärke som tillhör Biotium, Inc. Bio-Rad Laboratories, Inc. licensieras av Biotium,
Inc. för att sälja reagenser som innehåller EvaGreen-färgämne för användning i realtids-PCR, endast
för forskningssyften.

Alla varumärken som används häri tillhör respektive ägare.

Copyright © 2022 av Bio-Rad Laboratories, Inc. Med ensamrätt.

http://www.bio-rad.com/


Avsedd användning

Avsedd användning
CFX96 Dx-system och CFX96 DeepWell Dx-systemmed CFX Manager Dx-program är avsedda för
att utföra fluorescensbaserad PCR för att detektera och kvantifiera nukleinsyrasekvenser. System och
program är avsedda för in vitro-diagnostiskt bruk av utbildade laboratorietekniker. Systemen är
avsedda att användas med tredje partens diagnostiska nukleinsyratester vilka har tillverkats och
märkts för diagnostiska syften.

Symbollexikon
Viktigt! Viktiga ändringar har markerats!

Tillverkare Partinummer

Används före För in vitro-diagnostik

Temperaturgräns Katalognummer

Se bruksanvisningen Antal tester

För användning med Serienummer

Endast receptbelagd användning Innehåller latex
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Označenie CE - Nariadenie (EÚ) č.
2017/746 o zdravotníckych pomôckach na

diagnostiku in vitro

Översättningar
Produktdokument kan tillhandahållas på ytterligare språk på elektroniska medier.
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Säkerhet och efterlevnad av föreskrifter
För säker användning av CFX96™Dx System eller CFX96 DeepWell Dx Systemmed CFX Manager™
Dx Software, som benämns CFX Dx-system i detta dokument, rekommenderar Bio-Rad starkt att du
följer säkerhetsspecifikationerna som anges i det här avsnittet och i den här handboken.

Viktigt! Systemen CFX96 Dx och CFX96 DeepWell Dx är godkända för användning som in vitro-
diagnostiska (IVD) medicinska enheter.

Säkerhetsvarningsetiketter
Varningsetiketter på instrumentet och i den här handboken varnar för möjliga skaderisker. I Tabell 1
definieras alla säkerhetsvarningsetiketter.

Ikon Betydelse

Varning för risk för skada på personer eller utrustning
Om du använder CFX Dx-systemet innan du har läst den här handboken finns risk
för personskada. Använd av säkerhetsskäl inte det här instrumentet på sätt som
inte specificeras i den här handboken. Endast kvalificerad laboratoriepersonal med
utbildning i säker användning av den elektriska utrustningen får använda
instrumentet. Hantera alltid samtliga systemkomponenter försiktigt och med rena
och torra händer.

Varning vid hantering av biologiskt riskmaterial
Vid hantering av prover som utgör biologiska risker ska rekommenderade
försiktighetsåtgärder och riktlinjer samt lokala riktlinjer som är specifika för ditt
laboratorium och din arbetsplats följas.

Varning för risk för brännskada
En termocykler genererar tillräckligt mycket hetta för att orsaka allvarliga
brännskador. Använd hela tiden skyddsglasögon eller annat skydd för ögonen
under drift. Låt alltid provblocket återgå till inaktiv temperatur innan du öppnar
locket och tar ut proverna. Använd alltid största möjliga säkerhetsavstånd för att
undvika oavsiktliga brännskador på huden.

Tabell 1. Säkerhetsvarningsetiketternas betydelse
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Säkerhet och efterlevnad av föreskrifter

Ikon Betydelse

Varning för explosionsrisk
Provblocken kan under normal användning bli så heta att de får vätskor att koka
och explodera.

Tabell 1. Säkerhetsvarningsetiketternas betydelse, forts.

Specifikationer av säker användning och efterlevnad
I Tabell 2 listas specifikationerna för säker användning av Bio-Rads CFX Dx-system för realtids-PCR-
detektion. De medföljande avskärmade kablarna måste användas med dessa instrument för att
säkerställa överensstämmelse med FCC:s gränsvärden för klass A.

Användningsaspekt Villkor för säker användning

Nominell ineffekt 100–240 V AC, 50–60 Hz, 850 Wmax

Överspänningskategori II

Säkringar 10 A, 250 V, 5 x 20 mm, glas (antal: 2)

Miljö Endast inomhusbruk

Användningstemperatur 15–31 °C

Förvaringstemperatur –20 till 60 °C

Relativ luftfuktighet Upp till 80 % (icke-kondenserande)

Altitud Upp till 2 000 meter över havet

Föroreningsgrad 2

Tabell 2. Villkor för säker användning

Efterlevnad av föreskrifter
Det realtidsbaserade PCR-systemet CFX Dx har testats och befunnits uppfylla alla tillämpliga krav i
följande säkerhetsrelaterade och elektromagnetiska standarder:

n IEC 61010-1:2010 (3:e upplagan), EN61010-1:2010 (3:e upplagan). Elektrisk utrustning för
mätning, kontroll och laboratorieändamål. Del 1: Allmänna krav
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Faror

n IEC 61010-2-010:2014, EN 61010-2-010:2014. Säkerhetskrav för elektrisk utrustning för
mätning, kontroll och laboratorieändamål. Del 2-010: Särskilda fordringar på värmeapparater för
laboratoriebruk

n IEC 61010-2-081:2015, EN 61010-2-081:2015. Säkerhetskrav för elektrisk utrustning för
mätning, kontroll och laboratorieändamål. Del 2-081: Särskilda fordringar på hel- och
halvautomatiska laboratorieutrustningar för analys och liknande ändamål (inkluderar tillägg 1)

n IEC 61010-2-101:2015 (2:a upplagan.). Säkerhetskrav för elektrisk utrustning för mätning,
kontroll och laboratorieändamål. Särskilda krav för medicinsk utrustning för in vitro-diagnostik
(IVD).

n IEC 61326-1:2012 (klass A), EN 61326-1:2013 (klass A). Elektrisk utrustning för mätning, kontroll
och laboratorieändamål. EMC-krav, del 1: Allmänna krav

n IEC 61326-2-6:2012, EN 61326-2-6:2013 (klass A). Elektrisk utrustning för mätning, kontroll och
laboratorieändamål. EMC-krav. Särskilda krav för medicinsk utrustning för in vitro-diagnostik
(IVD).

Viktigt! Denna utrustning genererar, använder och kan utstråla radiofrekvent energi och kan, om
den inte installeras och används enligt den medföljande dokumentationen med anvisningar,
orsaka skadliga störningar av radiokommunikation. Användning av dessa system i ett
bostadsområde orsakar sannolikt oönskad interferens, i vilket fall korrigering av interferensen
bekostas av användaren själv.

Faror
CFX Dx-systemet för realtids-PCR-detektion har konstruerats för att fungera säkert när det används
på det sätt som anvisas av tillverkaren. Om CFX Dx-systemet för realtids-PCR-detektion eller någon
tillhörande komponent används på ett sätt som inte anvisas av tillverkaren kan instrumentets
integrerade skydd försämras. Bio-Rad Laboratories, Inc. ansvarar inte för personskador eller skador
som har orsakats av att den här utrustningen har använts på ett ospecificerat sätt eller för
modifieringar av instrumentet som inte har utförts av Bio-Rad eller en auktoriserad agent. Service av
CFX Dx-systemet för realtids-PCR-detektion ska endast utföras av utbildad Bio-Rad-personal.

Biologiska risker
Det realtidsbaserade PCR-detektionssystemet CFX Dx är en laboratorieprodukt. Om prover som
utgör biologiska risker förekommer, följ nedanstående riktlinjer samt alla lokala riktlinjer som är
specifika för ditt laboratorium och din arbetsplats.

Obs! Inga biologiskt farliga ämnen avges under normal användning av det här instrumentet.
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Säkerhet och efterlevnad av föreskrifter

Allmänna försiktighetsåtgärder

n Bär alltid laboratorierock, laboratoriehandskar och tättslutande skyddsglasögon med sidoskydd.

n Håll händerna borta från mun, näsa och ögon.

n Skydda eventuella skär- eller skrubbsår fullständigt innan du arbetar med potentiellt smittförande
material.

n Tvätta händerna noga med tvål och vatten innan du lämnar laboratoriet efter att du har arbetat
med potentiellt smittförande material.

n Ta av dig armbandsur och smycken innan du arbetar vid bänken.

n Förvara allt smittsamt eller potentiellt smittsamt material i okrossbara, läckagesäkra behållare.

n Ta av skyddskläderna innan du lämnar laboratoriet.

n Använd inte din behandskade hand för att skriva, svara i telefon, trycka på en strömbrytare eller
vidröra något som andra personer kan komma att vidröra utan handskar.

n Byt handskar ofta. Ta omedelbart av handskarna när de är märkbart kontaminerade.

n Material som inte kan saneras ordentligt ska inte exponeras för potentiellt smittsamt material.

n När ett arbete som involverar biologiskt riskavfall avslutats ska arbetsområdet saneras med
lämpligt desinfektionsmedel (t.ex. hushållsblekmedel som utspätts 1:10).

Särskilda IVD-försiktighetsåtgärder

n Alla patientprover är potentiellt biologiskt riskavfall och ska hanteras enligt grundläggande
försiktighetsåtgärder.

n Inga biologiskt farliga ämnen avges under normal användning av det här instrumentet.

Ytdekontaminering

VARNING! Förhindra elektriska stötar genom att alltid stänga av och koppla ur
instrumentet innan du utför dekontamineringsprocedurer.

Följande områden kan rengöras med valfritt desinfektionsmedel av sjukhuskvalitet med baktericid,
virucid eller fungicid effekt:

n Yttre lock och hölje

n Inre yta i reaktionsblocket och reaktionsblockets brunnar

n Kontrollpanel och skärm
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Faror

Se anvisningarna från produkttillverkaren när du ska bereda och applicera desinfektionsmedlet. Skölj
alltid reaktionsblocket och reaktionsblockbrunnarna flera gånger med vatten efter applicering av
desinfektionsmedel. Torka reaktionsblocket och reaktionsblockets brunnar ordentligt efter sköljning
med vatten.

Viktigt! Använd inte slipande eller frätande rengöringsmedel eller starka alkaliska lösningar.
Dessa medel kan repa ytor och skada reaktionsblocket, med förlust av exakt termisk kontroll som
följd.

Kassering av smittförande material

Kassera följande potentiellt kontaminerade material i enlighet med gällande bestämmelser:

n Kliniska prover

n Reagenser

n Förbrukade reaktionskärl eller andra förbrukningsartiklar som kan vara kontaminerade

Kemiska faror
Det realtidsbaserade PCR-detektionssystemet CFX Dx innehåller inga potentiellt farliga kemiska
material.

Explosions- eller brandfaror
Det realtidsbaserade PCR-detektionssystemet CFX Dx medför inga ovanliga brand- eller
explosionsfaror när utrustningen används på rätt sätt enligt Bio-Rad-laboratoriers specifikationer.

Elektriska faror
Det realtidsbaserade PCR-detektionssystemet CFX Dx har ingen ovanlig grad av elektrisk risk för
användarna om det installeras och används på rätt sätt utan fysiska modifieringar, och om det ansluts
till en kraftkälla med rätt specifikation.

Transport
Genomför dekontamineringsprocedurer sommåste utföras innan du flyttar eller fraktar det
realtidsbaserade PCR-detektionssystemet CFX Dx, dess optiska reaktionsmodul eller
termocyklerbasen. Flytta och frakta alltid det realtidsbaserade PCR-detektionssystemet CFX Dx och
optiska reaktionsmoduler i separata behållare med medföljande förpackningsmaterial som skyddar
instrumentet från skador. Kontakta en lokal Bio-Rad-återförsäljare om du inte hittar lämpliga behållare.

Användarhandbok | 17



Säkerhet och efterlevnad av föreskrifter

Batteri
CFX Dx-systemets termocykler använder ett 3 V litiumbatteri av knappcellstyp och ett laddningsbart
4,8 V nickel-metallhydridbatteri för bibehållande av tidsinställningar och körningsdata i händelse av
förlust av nätspänning. Om tiden och/eller körningsdata inte är inställda när du slår på enheten igen
kan det tyda på att batterierna börjar laddas ur. Kontakta i så fall Bio-Rad Teknisk support för hjälp.

Försök inte byta batterierna. Kontakta Bio-Rad Teknisk support.

Kassering
Det realtidsbaserade PCR-detektionssystemet CFX Dx innehåller elektrisk utrustning som ska
kasseras som osorterat avfall och måste insamlas separat enligt EU-direktiv 2012/19/EU om elektriskt
och elektroniskt avfall – WEEE-direktivet. Före kassering ska du kontakta den lokala Bio-Rad-
representanten och få landsspecifika instruktioner.

Garanti
Det realtidsbaserade PCR-detektionssystemet CFX Dx och dess tillbehör täcks av en Bio-Rad-
standardgaranti. Kontakta ditt lokala Bio-Rad-kontor för utförlig information om garantin.
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Kapitel 1 Inledning
Bio-Rads CFX Dx realtids-PCR-amplifieringssystem för in vitro-diagnostik (IVD) innefattar den
senaste tekniken vilket möjliggör PCR-kvantifiering med standardkurva, genuttrycksanalys, allelisk
diskriminering och ändpunktsanalys.

CFX Dx -system består av två maskinmoduler och program:

n CFX96™Dx eller CFX96 DeepWell Dx optisk reaktionsmodul (ORM)

n C1000™Dx termocykler

n CFXManager™ Dx-program

Vid användning med CFX Manager Dx-programvara kan du

n generera omedelbara resultat med Startup Wizard (Startguiden)

n ange eller redigera brunnsinformation före, under eller efter en körning

n tolka komplexa data och förtydliga din genuttrycksstudie med sådana verktyg som PrimePCR™-
kontrollanalys och referensgensväljaren

n sammanställa heltäckande rapporter om dina realtids-PCR-data

CFX Dx PCR-detektionssystem
I Tabell 3 listas Bio-Rads IVD PCR-produkter som levereras tillsammans med CFX Dx-system.

Obs! Ett CFX Dx-system levereras med CFX Manager Dx-programmet, C1000 Dx termocykler,
och antingen CFX96 Dx eller CFX96 DeepWell Dx optisk reaktionsmodul.

Artikelnr Beskrivning

1845097-IVD CFX96 Dx ORM *

1844095-IVD CFX96 DeepWell Dx ORM

1841000-IVD C1000 Dx termocykler

12007917 CFX Manager Dx-program v3.1

Tabell 3. CFX IVD PCR-detektionssystem

* Optisk reaktionsmodul
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Kapitel 1 Inledning

Ytterligare information
I det här dokumentet förklaras hur du på ett säkert sätt konfigurerar och använder de realtidsbaserade
PCR-detektionssystemen CFX96 Dx och CFX96 DeepWell Dx som har CE-IVD-märkning. Dessa
system benämns som CFX Dx-system i det här dokumentet. Dessutom förklarar det här dokumentet
hur du använder CFX Manager Dx-programvara med CFX Dx-system.

Tips: Klicka på Bio-Rad-logotypen i det övre högra hörnet av valfritt CFX Manager Dx-
programvara-fönster för att öppna webbplatsen för Bio-Rad. Webbplatsen innehåller länkar till
tekniska kommentarer, handböcker, produktinformation och teknisk support. Den här
webbplatsen erbjuder även många tekniska resurser för ett flertal metoder och applikationer
relaterade till PCR, realtidsbaserad PCR och genuttryck.
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Kapitel 2 Konfigurera C1000 Dx-termocyklern
I det här kapitlet beskrivs hur du konfigurerar CFX Dx-systemets C1000 Dx-termocykler på din
arbetsplats.

Tips: Innan du konfigurerar termocyklern bör du bekanta dig med enheten och dess optiska
reaktionsmodul, portar och tillbehör.

Platskrav
Tabellerna i det här avsnittet beskriver krav på rum, miljö och elförsörjning som är nödvändiga för en
korrekt installation och användning av CFX Dx-system-termocyklern.

Obs! Installera din CFX Dx-system-termocykler på en plan, torr yta med tillräckligt kalluftsflöde
för korrekt funktion.

Bänkutrymmeskrav

Objekt Specifikation

Ineffekt Upp till 850 W

Frekvens 50–60 Hz, enfas

USB-portar 5 A, 1 B

Dimensioner B: 33 cm

D: 46 cm

H: 36 cm

Vikt 21 kg

Tabell 4. CFX Dx-system-termocykler – bänkutrymmeskrav
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Kapitel 2 Konfigurera C1000 Dx-termocyklern

Miljökrav

Parameter Område Fuktighetsområde

Driftförhållanden 15–31 °C

59–87,8 °F

0–80 % relativ luftfuktighet,
icke-kondenserande

Förvaringsförhållanden 15–31 °C

59–87,8 °F

0–80 % relativ luftfuktighet,
icke-kondenserande

Tabell 5. Miljökrav för CFX Dx-system-termocyklern

Spänningskrav
Elförsörjningen av CFX Dx-system-termocyklern måste vara stabil och inom specifikationerna för
säker drift. Spänningskabeln som är ansluten till inspänningsporten måste vara klassificerad för
7 ampere eller mer.

Objekt Specifikation

Inspänning 100–240 V AC; 50–60 Hz, enfas

Högsta effektförbrukning <850 watt

Antal eluttag Minst två eluttag:

n 1 uttag för termocyklern

n 1 uttag för datorn som kör CFX Manager Dx-programvaran

Tabell 6. Spänningskrav för CFX Dx-system
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Systemöversikt

Systemöversikt
Bilderna i det här avsnittet visar huvudkomponenterna i C1000 Dx termocyklerbas.

Framifrån

1. Optisk reaktionsmodul – innehåller ett optiskt system som samlar in fluorescensdata och
ett termocyklerblock. CFX Dx-system för realtids-PCR-detektion stöder antingen en
CFX96™Dx- eller en CFX96 DeepWell Dx-modul.

2. Status LED (Statuslampa) – anger när blocket används.

3. Lockknapp – öppnar eller stänger den optiska reaktionsmodulens lock och förseglar
reaktionskammaren.

4. C1000™ Dx-termocyklerbas – förser systemet med spänning och kommunikation samt
rymmer CFX96 Dx och CFX96 DeepWell optiska reaktionsmoduler.

5. Skärm och knappar på frontpanelen – ger kontroll över systemet i fristående läge.
Viktigt! För att säkerställa dataintegriteten för IVD-genstudier stöder inte CFX
Manager Dx-programvaran data som har genererats av termocyklern i fristående läge.

6. Uppvärmt inre lock – upprätthåller locktemperaturen för att förhindra kondensering och
avdunstning.

7. Prov-/reaktionsblock – rymmer reaktionskärl, däribland rör och mikroplattor.

FÖRKLARING
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Kapitel 2 Konfigurera C1000 Dx-termocyklern

Vy bakifrån

1. Ethernet-port – ansluter C1000 Dx termocykler till nätverket.

2. USB Type B-portar – ansluter C1000 Dx termocykler till en dator som kör CFX Manager
Dx-programvaran.

3. USB Type A-portar – överför data till och från ett USB-flashminne.
Viktigt! För att säkerställa dataintegriteten för IVD-genstudier stöder inte CFX
Manager Dx-programvaran data som har genererats av termocyklern i fristående läge.

4. Seriell testport – endast för servicetestning.

5. Kylventiler – kyler termocyklern.
Viktigt! Blockera inte kylventilerna. Säkerställ optimal prestanda genom att se till att
luft kan cirkulera bakom termocyklerbasen.

6. Spänningsingång – nätspänning (växelström), använd den medföljande nätsladden.

7. Strömbrytare – vippströmbrytare med vilken du slår på och stänger av termocyklern.

8. Säkringar – säkringsspecifikationer finns i Specifikationer av säker användning och
efterlevnad på sidan 14.

FÖRKLARING
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Optiska reaktionsmoduler

Optiska reaktionsmoduler
Termocyklern C1000 Dx är kompatibel med nedanstående Bio-Rad optiska reaktionsmoduler för
realtids-PCR.

n CFX96 Dx optisk reaktionsmodul

n CFX96 DeepWell Dx optisk reaktionsmodul

Utvald CFX Dx optisk reaktionsmodul och termocyklern levereras i separata lådor. CFX Manager Dx-
programmet medföljer den optiska reaktionsmodulen.

Viktigt! Den optiska reaktionsmodulen är kalibrerad med termocyklerbasen som den levereras
tillsammans med. Därför ska den optiska reaktionsmodulen inte användas med en annan
termocyklerbas och termocyklerbasen ska inte användas med en annan optisk reaktionsmodul.

Båda de optiska reaktionsmodulerna inkluderar ett fullständigt justerbart uppvärmt lock som klarar att
köras pålitligt med många olika typer av reaktionskärl. Varje optisk reaktionsmodul innehåller kylfläktar
för snabb uppvärmning och nedkylning.

I varje CFX Dx optisk reaktionsmodul ingår följande komponenter:

n Uppvärmt inre lock – upprätthåller locktemperaturen för att förhindra kondensering och
avdunstning.

n Prov-/reaktionsblock – rymmer reaktionskärl, inklusive rör och mikroplattor.

n Lockknapp – öppnar och stänger locket samt förseglar reaktionskammaren.

n Statuslampa – när den lyser visar det att blocket används.

Rekommenderade provvolymer
När du använder C1000 Dx -termocyklern bestäms maximal provvolym av vilken typ av
reaktionsmodul som används. I Tabell 7 visas rekommenderade volymer för användning med varje
reaktionsmodul.

Antal brunnar Antal block
Rekommenderad provvolym, µl

(Övre gräns)

96-brunnars 1 10–50

96 brunnar, djupa 1 10–125

Tabell 7. Storleks- och volymgräns för reaktionsmoduler
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Kapitel 2 Konfigurera C1000 Dx-termocyklern

Installera C1000 Dx-termocyklern
Basen för C1000 Dx-termocykler fraktas i en separat låda från den optiska reaktionsmodulen. Paketet
innehåller:

n Bas för C1000 Dx-termocyklern

n Nätsladd

n 1 USB-kabel

Installera C1000 Dx-termocyklern:

1. Packa upp och ställ in basen för C1000 Dx-termocyklern.

2. Sätt fast reaktionsmodulen på basen.

3. Ta bort låsskruven.

I det här avsnittet förklaras dessa moment utförligt.

Packa upp och ställa in C1000 Dx termocykler
Viktigt! Innan du börjar använda termocyklern måste du läsa informationen i Säkerhet och
efterlevnad av föreskrifter på sidan 13 och Säkerhetsvarningsetiketter på sidan 13.

Tips: Säkerställ under inställningen att det finns tillräckligt med utrymme nära termocyklern för en
dator på vilken du kan köra CFX Manager Dx-programmet.

För att packa upp och ställa in termocyklerbasen

1. Lokalisera förpackningen som innehåller termocyklerbasen.

2. Ta ut basen från förpackningsmaterialet.

Tips: Spara förpackningsmaterialet för framtida bruk. Kontakta ditt lokala Bio-Rad-kontor om
någon del saknas eller är skadad.

3. Placera termocyklerbasen på en plan, torr yta med tillräckligt kalluftsflöde för att fungera korrekt.

4. Lokalisera nätkabeln i förpackningen och för in den ena änden i nätanslutningen på baksidan av
termocyklern.

Viktigt! Slå inte på strömmen till instrumentet ännu.

5. Sätt fast IVD-reaktionsmodulen på basen. Fortsätt till Sätta fast den optiska reaktionsmodulen på
sidan 27.
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Installera C1000 Dx-termocyklern

Sätta fast den optiska reaktionsmodulen
Bio-Rad levererar CFX96 Dx eller CFX96 DeepWell optisk reaktionsmodul med dess C1000 Dx
termocyklerbas (men i en separat förpackning). Packa försiktigt upp den optiska reaktionsmodulen
och kontrollera att nätsladden och USB-kablarna medföljer i förpackningen.

Viktigt! Varje optisk reaktionsmodul kalibreras med termocyklerbasen innan den levereras.
Därför ska du inte använda den optiska reaktionsmodulen med någon annan termocyklerbas.

C1000 Dx termocyklerbas måste stå på en plan, torr yta med tillräckligt kalluftsflöde för att fungera
korrekt.

Så här sätter du fast reaktionsmodulen på termocyklerbasen

1. Ställ C1000 Dx termocykler på en lämplig plats med låsspärren nere.

2. Medan du lyfter den optiska reaktionsmodulen i handtagsfördjupningarna ovanför
sidoluftventilerna placerar du modulen i basen till C1000 Dx reaktionsmodul. Lämna 2 cm
utrymme framtill. När den är i basen ska den optiska modulen täcka Bio-Rad-logotypen på
basens framsida.

3. Lyft låsspärren tills den är jäms med sidorna på modulbasen. Genom den här åtgärden flyttas
modulen framåt och låses på plats.
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Kapitel 2 Konfigurera C1000 Dx-termocyklern

4. Kontrollera att modulen är helt och jämnt placerad i C1000 Dx termocyklerbas. Det ska inte finnas
något extra utrymme mellan modulen och basen.

5. Anslut nätsladden på baksidan av C1000 Dx termocyklerbas och i ett lämpligt eluttag. Tryck
sedan på strömbrytaren på baksidan av C1000 Dx termocyklerbas för att starta systemet.

Ta bort transportskruven
Viktigt! Bio-Rads optiska reaktionsmoduler levereras med en röd transportskruv i det inre locket
som stabiliserar den optiska reaktionsmodulen under frakten. Du måste ta bort transportskruven
för att kunna använda den optiska reaktionsmodulen.

Så här tar du bort transportskruven

1. C1000 Dx termocykler känner av att transportskruven har satts in i den optiska reaktionsmodulen
och visar ett meddelande som instruerar dig att ta bort skruven.

2. Följ anvisningarna för att ta bort transportskruven. På följande bild visas transportskruvens plats.
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Installera C1000 Dx-termocyklern

Obs! Du måste sätta in transportskruven igen om reaktionsmodulen behöver returneras av
någon anledning. Spara skruven på en säker och tillgänglig plats.

Ladda provplattor
För att säkerställa att prover värms upp och kyls ned på ett enhetligt sätt måste plattor vara i fullständig
kontakt med reaktionsblocket. Gör följande för att säkerställa tillräcklig kontakt:

n Bekräfta att blocket är rent innan du laddar prover.

n Tryck ned de enskilda rören, rörremsorna eller mikroplattorna ordentligt i blockbrunnarna.

n När du använder ett eller några få rör bör du använda rörramen (artikelnr 1849000 eller 1849001)
eller ladda minst ett tomt rör i varje hörn av blocket för att säkerställa att locket utövar ett jämnt
tryck på enskilda rör.
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Kapitel 2 Konfigurera C1000 Dx-termocyklern

Ladda plattor i den optiska reaktionsmodulen

Viktigt! När du kör CFX Dx-system ska du alltid fördela rörremsorna jämnt eller lägga till rörlock i
hörnbrunnarna för att säkerställa att det varma locket anlägger ett jämnt fördelat tryck över
blocket.

För att ladda plattor i den optiska reaktionsmodulen

1. Gör något av följande för att öppna det motoriserade locket:

n Klicka på Open Lid (Öppna lock) i rutan Detected Instruments (Hittade instrument) i CFX
Manager Dx-programmet.

n På fliken Start Run (Starta körning) klickar du på Open Lid (Öppna lock).

n Tryck på lockknappen på instrumentets framsida.

2. Placera mikroplattan, enskilda rör eller rörremsor med förseglade lock i blocket.

Viktigt! Verifiera att rören är helt förseglade för att förhindra läckage.

Tips: För optimala resultat, ladda provvolymer på 10–25 µl för CFX Dx-system.

3. För en noggrann dataanalys ska du verifiera att reaktionerna i blocket är orienterade på exakt
samma sätt som brunnsinnehållet på fliken Plate (Platta) i CFX Manager Dx-programmet.

Tips: Du kan redigera brunnsinnehållet med CFX Manager Dx-programmet före, under eller
efter körningen.

4. Gör något av följande för att stänga det motoriserade locket:

n Tryck på lockknappen på instrumentet.

n Klicka på Close Lid (Stäng lock) i rutan Detected Instruments (Hittade instrument) i
programmet.

n På fliken Start Run (Starta körning) klickar du på Close Lid (Stäng lock).

Viktigt! Se till att ingenting blockerar locket när det stängs. Även om det finns en
säkerhetsmekanism som ska förhindra att locket stängs om det känner av ett hinder ska du
inte placera någonting i vägen för locket innan du stänger.
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PCR-plastartiklar och reagensförbrukningsmaterial

För att hitta och beställa rekommenderat plastförbrukningsmaterial för CFX Dx-systemet går du till
Bio-Rads webbplats. Du kan nå denna webbplats från menyposten
Help > PCR Plastic Consumables Web Site (Hjälp > Webbplats för PCR-plastförbrukningsmaterial) i
CFX Manager Dx-programmet. Se dessutom Plastics Selector (Plastväljare) och Reagents Selector
(Reagensväljare) för att enkelt hitta och beställa förbrukningsartiklar av plast och reagenser som
behövs för just din maskinvara och dina PCR-behov.

Detektera anslutna instrument
Under installationen installerar CFX Manager Dx-programvara-installationsprogrammet automatiskt
instrumentdrivrutinerna på datorn som kör CFX Manager Dx-programvara. CFX Manager Dx
detekterar anslutna instrument när du startar programvaran.

Viktigt! Du måste koppla ifrån C1000 Dx termocykler från CFX Manager Dx-datorn innan du
installerar programvaran. Du behöver inte stänga av termocyklern under
programvaruinstallationen.

Så här detekterar du anslutna instrument

1. Om du inte har gjort det ännu sätter du in den fyrkantiga (han-) änden av den medföljande USB
Type B-kabeln i USB Type B-porten på baksidan av basen på .

2. Sätt in den andra (port-) änden i en USB-port på CFX Manager Dx-datorn.

3. Om inte termocyklern är igång trycker du på strömbrytaren på baksidan av instrumentet för att slå
på det.

4. Starta CFX Manager Dx-programvara.

Programvaran detekterar automatiskt det anslutna instrumentet och visar dess namn i rutan Detected
Instruments (Hittade instrument) i hemfönstret.

Obs! Om inte instrumentet visas i rutan Detected Instruments (Hittade instrument) kontrollerar du
att USB-kabeln sitter fast ordentligt. Du installerar om drivrutinerna genom att välja Tools >
Reinstall Instrument Drivers (Verktyg > Installera om instrumentdrivrutiner) i hemfönstret i CFX
Manager Dx-programvara.
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Lossa reaktionsmodul
Viktigt! Stäng av strömmen till C1000 Dx termocykler innan du lossar en reaktionsmodul (se
Stänga av C1000 Dx termocykler på sidan 32). Kylflänsar inuti reaktionsmodulen kan vara varma
omedelbart efter körning av ett protokoll eller en inkubation. Säkerställ att flänsarna har svalnat
innan du lossar reaktionsmodulen.

Lossa en optisk reaktionsmodul från termocyklerbasen

1. På baksidan av termocyklerbasen trycker du ned låskolven för att låsa upp och frigöra den optiska
reaktionsmodulen.

2. Lyft försiktigt upp din optiska reaktionsmodul ur facket i handtagsfördjupningarna på ömse sidor.

3. Ställ din optiska reaktionsmodul på en ren, plan yta där den inte kan få stötar, bli skrapad eller
falla ned.

Stänga av C1000 Dx termocykler
Så här stänger du av termocyklern

1. Efter en körning trycker du på öppna locket-knappen framtill på CFX optisk reaktionsmodul för att
komma åt proverna som är laddade i blocket.

2. Ta ut proverna och tryck på stäng locket-knappen för att stänga locket.

3. Tryck på strömbrytaren på baksidan av C1000 Dx termocykler för att stänga av systemet.
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programvara

I det här kapitlet beskrivs hur du installerar programvaran CFX Manager™ Dx.

CFX Manager Dx-programvara krävs för att analysera realtidsbaserade PCR-data från systemen
CFX96™Dx och CFX96 DeepWell Dx. Du kan också använda den här programvaran för att
kontrollera dessa system i ett programvarukontrollerat läge.

Information om hur du installerar CFX Dx-system-termocyklern och den optiska reaktionsmodulen
finns i Konfigurera C1000 Dx-termocyklern på sidan 21.
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Systemkrav
I Tabell 8 listas minimisystemkraven och de rekommenderade systemkraven för datorn som kör CFX
Manager Dx-programvara (den så kallade CFX Manager Dx-datorn).

System Minimikrav Rekommenderat krav

Operativsystem Microsoft Windows 7 SP1
Pro

Något av följande:

n Microsoft Windows 7 SP2 Pro (32- och 64-
bitars)

n Microsoft Windows 10 Pro (endast 64-
bitars)

n Microsoft Windows 10 Enterprise (endast
64-bitars)

Viktigt! Säker start måste vara avaktiverat i både Microsoft Windows 10 Pro och Enterprise.

Portar 2 USB 2.0-
höghastighetsportar

2 USB 2.0-höghastighetsportar

Hårddiskutrymme 128 GB 128 GB

Processorhastighet 2,4 GHz, Dual Core 2,4 GHz, Quad Core

RAM 4 GB RAM 8 GB RAM

Skärmupplösning 1 024 x 768 med True
Color-läge

1 280 x 1 024 med True Color-läge

PDF-läsare Adobe PDF Reader eller Windows PDF
Reader från en av Microsoft Office-
programsviterna som stöds:

n 2007

n 2010

n 2013

Tabell 8. Datorkrav för CFX Manager Dx-programvara
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Installera CFX Manager Dx-programvara
Viktigt! Du måste koppla från alla anslutna instrument från CFX Manager Dx-datorn innan du
installerar eller uppgraderar programvaran. Du behöver inte stänga av termocyklern under
programvaruinstallationen. Säkerställ att du har sparat alla körningar och att inga experiment
körs.

Obs! Om du installerar CFX Manager Dx-programvara påWindows 10 ska du kontrollera att
Säker start är avaktiverat innan du inleder installationen.

För att installera CFX Manager Dx-programvara

1. Koppla från eventuella anslutna instrument från datorn vid behov.

Sök upp och koppla bort instrumentets USB-kabel på CFX Manager Dx-datorn. Den ände som är
ansluten till instrumentet kan sitta kvar på plats.

2. Logga in på CFX Manager Dx-datorn med administratörsbehörighet.

3. Sätt in CD-skivan med CFX Manager Dx-programvaran i datorns CD-enhet.

4. Programvarans startsida bör visas automatiskt. Dubbelklicka på Install Software (Installera
programvara) på startsidan för programvaran.

Obs! Om startsidan inte visas automatiskt går du till CD-enheten och öppnar mappen CFX_
Manager och dubbelklickar sedan på setup.exe för att starta programinstallationsguiden.

Tips: Klicka på knappen Documentation (Dokumentation) i installationsguiden för att hitta
sökbara kopior av versionsinformationen, instrumenthandböckerna och annan
dokumentation.

5. Följ anvisningarna på skärmen för att slutföra installationen. När den är avslutad visas ikonen för
CFX-hanteringsprogrammet på datorns skrivbord.

6. När installationen är slutförd är det säkert att ta ut CD-skivan.

Detektera anslutna instrument
Under installationen installerar CFX Manager Dx-programvarans installationsprogram automatiskt
instrumentdrivrutinerna på CFX Manager Dx-datorn. CFX Manager Dx detekterar anslutna instrument
när du startar programvaran.
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Så här detekterar du anslutna instrument

1. Om du inte har gjort det ännu sätter du in den fyrkantiga (han-) änden av den medföljande USB
Type B-kabeln i USB Type B-porten på baksidan av instrumentets bas.

2. Sätt in den andra (port-) änden i en USB-port på CFX Manager Dx-datorn.

3. Om inte instrumentet är igång trycker du på strömbrytaren på baksidan av instrumentet för att slå
på det.

4. Starta CFX Manager Dx.

Programvaran detekterar automatiskt det anslutna instrumentet och visar dess namn i rutan Detected
Instruments (Hittade instrument) i hemfönstret.

Obs! Om inte instrumentet visas i rutan Detected Instruments (Hittade instrument) kontrollerar du
att USB-kabeln sitter fast ordentligt. Du installerar om drivrutinerna genom att välja Tools >
Reinstall Instrument Drivers (Verktyg > Installera om instrumentdrivrutiner) i hemfönstret i CFX
Manager Dx.

Programvarufiler
I Tabell 9 listas filtyperna i CFX Manager Dx-programvara.

Filtyp Tillägg Information

Protocol (Protokoll) .prcl Innehåller information om protokollinställning för att utföra
en PCR-körning.

Platta .pltd Innehåller information om plattinställning för att utföra en
PCR-körning.

Data .pcrd Innehåller resultaten av en experimentkörning och PCR-
analys.

PrimePCR™-körning .csv Innehåller protokollet och plattlayouten för PrimePCR-
plattor.

Genstudie .mgxd Innehåller resultaten av flera PCR-körningar och
genuttrycksanalyser.

LIMS .plrn Innehåller information om plattinställning och -protokoll
som krävs för att utföra en LIMS-kompatibel körning.

Tabell 9. CFX Manager Dx-programvara filtyper
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Rekommenderade cybersäkerhetsåtgärder
Bio-Rad rekommenderar att du rådfrågar din IT-avdelning för implementering av
cybersäkerhetsåtgärder för datorn som används med CFX96 Dx-systemet. Exempel:

n Installera och konfigurera lämpliga virusskyddsprogram och brandväggar.

Viktigt! Konfigurera virusskanningen så att den sker utanför arbetstid eller när instrumentet
inte är aktivt. Om en virussökning påbörjas medan CFX Manager Dx kör ett experiment kan
körningen avbrytas och data gå förlorade.

n CFXManager Dx-programvara har ingen timeoutfunktion om användaren är inaktiv under en
session. Implementera säkerhetsåtgärder genomWindows- eller tredjepartsverktyg (till exempel
en skärmsläckare som kräver inloggning).

n Säkerhet för flyttbara medier:

o Använd lösenord och kryptering på USB-enheten för att skydda dina data.

o Inaktivera funktioner för automatisk körning och uppspelning för alla flyttbara
lagringsenheter.

o Använd USB-skanning när USB-minnen är anslutna.

n Använd en säkerhetskopieringslösning för att underlätta återställning av data.
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Kapitel 4 Arbetsytan
CFXManager™ Dx-programvaran tillhandahåller ett gränssnitt för att ställa in plattor, utveckla PCR-
protokoll, köra dem på CFX Dx-instrument och analysera data från PCR-körningar.

CFX Manager Dx-programvaran har fem primära arbetsytor:

n Hemfönstret

n Startup Wizard (Startguide)

n Fönstret Protocol Editor (Protokollredigerare)

n Fönstret Plate Editor (Plattredigerare)

n Fönstret Data Analysis (Dataanalys)

I det här kapitlet visas och beskrivs alla dessa arbetsytor.
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Hemfönstret
CFXManager Dx-programvara öppnas i hemfönstret och visar Startup Wizard (Startguide) där du kan
ställa in ett experiment, utföra eller upprepa en körning eller analysera en befintlig körning. Från
hemfönstret kan du även visa program- och instrumentloggar, skapa och hantera användare, och få
åtkomst till flera användbara verktyg. För mer information, se Kapitel 5, Hemfönstret.
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Startup Wizard (Startguide)
Med Startup Wizard (Startguide) konfigurerar och kör du snabbt användardefinierade experiment eller
väljer och kör ett PrimePCR™-experiment. Med guiden går det även att upprepa en körning och att
analysera kördata.
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Fönstret Protocol Editor (Protokollredigerare)
I Protocol Editor (Protokollredigerare) kan du skapa, öppna, granska och redigera ett protokoll. Du kan
också modifiera locktemperaturen för det öppna protokollet. Funktionerna för Protocol Editor
(Protokollredigerare) beskrivs i Kapitel 6, Skapa protokoll.
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Fönstret Plate Editor (Plattredigerare)
Du kan skapa, öppna, granska och redigera plattor i Plate Editor (Plattredigerare). Plattredigerarens
funktioner beskrivs i Kapitel 7, Förbereda plattor.
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Fönstret Data Analysis (Dataanalys)
I fönstret Data Analysis (Dataanalys) kan du visa och jämföra körningsdata, göra statistiska analyser,
exportera data och skapa publiceringsfärdiga rapporter. Funktionen Data Analysis (Dataanalys)
beskrivs i Kapitel 9, Dataanalysöversikt. Se även Kapitel 10, Dataanalysinformation.
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Kapitel 5 Hemfönstret
CFXManager™ Dx-programvaran tillhandahåller ett gränssnitt för att skapa PCR-protokoll, köra dem
på CFX Dx-system och analysera PCR-kördata.

I det här kapitlet presenteras CFX Manager Dx-programvara och beskrivs funktionerna som är
tillgängliga i hemfönstret.

Användarhandbok | 45



Kapitel 5 Hemfönstret

Hemfönster
CFXManager Dx öppnas i hemfönstret och visar Startup Wizard (Startguide) där du kan konfigurera
en körning, utföra eller upprepa en körning eller analysera en befintlig körning. Från hemfönstret kan
du även visa program- och instrumentloggar, skapa och hantera användare, och få åtkomst till flera
användbara verktyg.

1. Programvarans titelfält visar namnet på programvaran och inloggad användare.

2. Menyraden ger snabb åtkomst till menykommandon för File (Arkiv), View (Visa), Run (Kör),
Tools (Verktyg), Window (Fönster) och Help (Hjälp).

3. Kommandon på verktygsraden ger snabb åtkomst till menyalternativ.

4. Den vänstra rutan visar instrument som är anslutna till CFX Manager Dx-datorn och har
knappar som du kan använda för att styra locket och visa instrumentens status.

5. Huvudrutan visar arbetsfönstret. Standardarbetsfönstret på startskärmen är Startup Wizard
(Startguide).

6. Statusfältet visar namnen på de anslutna instrumenten och den inloggade användaren.

FÖRKLARING
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Menykommandon för File (Arkiv)
New (Ny) – öppnar en dialogruta där du kan välja att skapa ett nytt protokoll, en ny platta eller en ny
genstudie.

Open (Öppna) – öppnar en dialogruta där du kan välja att gå till och öppna ett befintligt protokoll, en
befintlig platta, en befintlig datafil, en befintlig genstudie, en befintlig LIMS-fil, eller en befintlig
PrimePCR™-körfil.

Recent Data Files (Senaste datafiler) – visar en lista över nyligen öppnade PCR-filer.

Repeat a Run (Upprepa en körning) – öppnar Utforskaren på platsen för de sparade PCR-filerna där
du kan hitta en körning som ska upprepas.

Exit (Avsluta) – stänger CFX Manager Dx.

Kommandon i menyn View (Visa)
Application Log (Applikationslogg) – visar en programanvändningslogg från installation till dagens
datum.

Run Reports (Körningsrapporter) – visar en lista med körningsrapporter.

Start Wizard (Startguide) – visar Start Wizard (Startguiden) i huvudrutan.

Run Setup (Körningsinställning) – visar fönstret Run Setup (Körningsinställning) i huvudrutan.

Instrument Summary (Instrumentsammanfattning) – visar fönstret Instrument Summary
(Instrumentsammanfattning) i huvudrutan.

Detected Instruments (Hittade instrument) – växlar mellan att visa och att inte visa anslutna
instrument i den vänstra rutan. Som standard visar programmet anslutna instrument i den vänstra
rutan.

Toolbar (Verktygsrad) – växlar mellan att visa och att inte visa verktygsraden högst upp på skärmen.
Som standard visar programmet verktygsraden.

Status Bar (Statusfält) – växlar mellan att visa och att inte visa statusfältet längst ned på skärmen.
Som standard visar programmet statusfältet.

Show (Visa) – öppnar en dialogruta från vilken du kan

n Visa eller blockera statusloggen.

n Öppna och visa CFX Manager Dx-datamappen.

n Öppna och visa användarens datamapp.

n Öppna och visa LIMS-filmappen.
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n Öppna och visa PrimePCR-mappen.

n Visa körningshistoriken.

n Visa egenskaperna för alla anslutna instrument.

Kommandon i menyn User (Användare)
Select User (Välj användare) – öppnar inloggningsskärmen där du kan välja en användare i listrutan
User Name (Användarnamn) och logga in i programmet.

Change Password (Ändra lösenord) – öppnar dialogrutan Change Password (Ändra lösenord) där
användare kan ändra sitt lösenord för CFX Manager Dx-programvara.

User Preferences (Användarinställningar) – öppnar dialogrutan User Preferences
(Användarinställningar) där användare kan ändra standardinställningarna för

n sändning och mottagande av e-postaviseringar vid avslutad körning

n lagring av datafiler

n generering av protokoll med Protocol Editor (Protokollredigerare) eller Protocol AutoWriter
(Protokollförslag)

n generering av plattor

n dataanalys

n genuttrycksanalys

n fastställande av datakvalitet

n export av CFX Dx-instrumentdata.

User Administration (Användarhantering) – öppnar dialogrutan öppnar dialogrutan User
Administration (Användarhantering) där administratörer kan skapa användare, modifiera
rollbehörigheter och tilldela roller till användare.

Bio-Rad Service Login (Bio-Rad-serviceinloggning) – endast Bio-Rad teknisk servicepersonal. Välj
inte det här kommandot.
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Kommandon i menyn Run (Körning)
User-defined Run (Användardefinierad körning) – öppnar fönstret Run Setup (Körningsinställning)
där du kan konfigurera användardefinierade protokoll och plattor och sedan köra ett PCR-experiment
på valda instrument.

PrimePCR Run (PrimePCR-körning) – öppnar fliken Start Run (Starta körning) i fönstret Run Setup
(Körningsinställning), och PrimePCR-standardprotokollet och plattlayouten som blir inläst beror på
vilket instrument som väljs.

End-Point Only Run (Körning endast med slutpunkt) – öppnar fliken Start Run (Starta körning) i
fönstret Run Setup (Körningsinställning), och standardslutpunktsprotokollet och plattlayouten som blir
inläst beror på vilket instrument som väljs.

Qualification Run (Körning med kvalificering) – öppnar fliken Start Run (Starta körning) i fönstret Run
Setup (Körningsinställning), med Bio-Rad-standardprotokollet för kvalificering och plattlayouten läses
in för det valda instrumentet.

Kommandon i menyn Tools (Verktyg)
Master Mix Calculator (Master Mix-kalkylator) – öppnar mastermixkalkylatorn där du kan skapa en
reaktionsblandning och skriva ut beräkningarna.

Protocol AutoWriter (Protokollförslag) – öppnar dialogrutan Protocol AutoWriter (Protokollförslag)
där du enkelt kan skapa ett nytt protokoll.

Ta Calculator (Ta-kalkylator) – öppnar Ta-kalkylator där du enkelt kan beräkna
hybridiseringstemperaturen för primrar.

Dye Calibration Wizard (Fluoroforkalibrering) – öppnar guiden Dye Calibration (Fluoroforkalibrering)
där du kan kalibrera ett instrument för en ny fluorofor.

Reinstall Instrument Drivers (Ominstallera instrumentdrivrutiner) – ominstallerar drivrutinerna som
styr kommunikation med Bio-Rads realtids-PCR-system.

Zip Data and Log Files (Zip-data och loggfiler) – öppnar en dialogruta där du kan välja filer som ska
komprimeras och sparas i en zip-fil för lagring eller för att skickas med e-post.

Batch Analysis (Batch-analys) – öppnar dialogrutan Batch Analysis (Batch-analys) där du kan ställa
in parametrar för analys av fler än en datafil åt gången.

Options (Alternativ) – öppnar en dialogruta där du kan

n Konfigurera inställningarna för din e-postserver.

n Konfigurera exportinställningar för LIMS och andra datafiler.
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Kommandon i menyn Help (Hjälp)
Tips: Hjälpmenyn är tillgänglig i menyraden i alla CFX Manager Dx-programvara-fönster.

Open Operation Manual (Öppna bruksanvisning) – öppnar en PDF av denna manual.

Gene Expression Gateway Web Site (Webbplats för genuttryck) – öppnar Bio-Rads hemsida för
CFX Dx-system.

PCR Reagents Web Site (Webbplats för qPCR-reagenser) – öppnar Bio-Rads webbplats för PCR -
reagenser, där du kan beställa PCR-reagenser, supermixer, färger och kit.

PCR Plastic Consumables Web Site (Webbplats för qPCR-förbrukningsartiklar av plast) – öppnar
Bio-Rads webbplats för PCR-plast- och förbrukningsartiklar, där du kan beställa PCR-plattor,
plattförseglingar, rör och lock, och andra tillbehör av plast.

Software Web Site (Webbplats för program) – öppnar Bio-Rads webbplats för PCR-analysprogram,
där du kan beställa uppdaterade versioner av Bio-Rads CFX Manager Dx-programvara.

About (Om) – visar CFX Manager Dx copyright- och versionsinformation.

Kommandon i verktygsraden

– öppnar Utforskaren i Windows där du kan navigera till och öppna en datafil eller en
genstudiefil.

– öppnar Master Mix Calculator (Master Mix-kalkylator).

– öppnar fönstret Run Setup (Körningsinställning).

– öppnar fönstret Run Setup (Körningsinställning), och PrimePCR-standardprotokollet och
plattlayouten som blir inläst beror på vilket instrument som väljs.

– öppnar Startup Wizard (Startguide).
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Startup Wizard (Startguide)
När CFX Manager Dx startar visar arbetsytan Startup Wizard (Startguide). Från Startup Wizard
(Startguide) kan du

n Välj ett instrument från de hittade instrumenten och konfigurera en användardefinierad körning
eller en PrimePCR-körning.

n Öppna och upprepa en körning.

n Öppna en datafil för att analysera resultat från en enskild körning eller en genstudiefil för resultat
från flera genuttryckskörningar.

Dessa moment förklaras utförligt i kapitlen nedan.

Statusfält
På den vänstra sidan av statusfältet längst ned i huvudfönstret i programmet visas aktuell status för de
hittade instrumenten. På den högra sidan av statusfältet visas namnet på aktuell användare samt
datum och tid.
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Rutan Detected Instruments (Hittade instrument)
I rutan Detected Instruments (Hittade instrument) visas alla instrument som är anslutna till CFX Manager
Dx-datorn. Som standard visas varje instrument som en ikon med serienumret som namn.

På följande bild visas exempelvis fyra hittade instrument:

n Två C1000™ termocykler med CFX96™DeepWell reaktionsmoduler (CFX96DW1 och
CFX96DW2)

n Två C1000™ termocykler med CFX96™ reaktionsmoduler (CFX96l01 och CFX96l02)

I den här rutan kan du göra följande:

n Visa ett valt instruments egenskaper och kalibrerade färgämnen.

Information om instrumentegenskaper finns i Visa egenskaper för ett instrument på sidan 56.

n Visa ett anslutet instruments status.

n Öppna det valda instrumentets motoriserade lock.

n Stänga det valda instrumentets motoriserade lock.

n Se statusen för alla anslutna instrument.
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Så här ser du ett anslutet instruments status

u I rutan Detected Instruments (Hittade instrument) väljer du målinstrumentet och gör något av
följande:

n Klicka på View Status (Visa status) i avsnittet Selected Instrument (Valt instrument).

n Högerklicka och välj View Status (Visa status) på menyn som öppnas.

Dialogrutan Run Details (Körningsdetaljer) visas med fliken Run Status (Körningsstatus). Det
valda instrumentets status visas under körningsstatusrutan, till exempel:

Så här öppnar och stänger du locket på ett instrument

u I rutan Detected Instruments (Hittade instrument) väljer du målinstrumentet och gör något av
följande:

n Klicka på Open Lid (Öppna lock) eller Close Lid (Stäng lock) i avsnittet Selected Instrument
(Valt instrument).

n Högerklicka och välj lämplig åtgärd på menyn som öppnas.

n Öppna dialogrutan Run Details (Körningsdetaljer), välj fliken Run Status (Körningsstatus)
och klicka på Open Lid (Öppna lock) eller Close Lid (Stäng lock).

Så här ser du statusen för alla hittade instrument

u Gör något av följande:

n I avsnittet All Instruments (Alla instrument) i rutan Detected Instruments (Hittade instrument)
klickar du på View Summary (Visa sammanfattning).

n På menyraden väljer du View > Instrument Summary (Visa > Instrumentsammanfattning).
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Dialogrutan Instrument Summary (Instrumentsammanfattning) öppnas:

Tips: Om systemet endast detekterar ett instrument visas inte avsnittet All Instruments (Alla
instrument) i rutan Detected Instruments (Hittade instrument). Du visar
instrumentsammanfattningen för ett enstaka instrument genom att välja View > Instrument
Summary (Visa > Instrumentsammanfattning).
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Reglage i verktygsraden Instrument Summary (Instrumentsammanfattning)

I Tabell 10 listas reglagen och funktionerna i verktygsraden Instrument Summary
(Instrumentsammanfattning).

Knapp Knappnamn Funktion

Create a new Run
(Skapa en ny körning)

Skapar en körning på valt block genom
att öppna fönstret Run Setup
(Körningsinställning).

Stop (Stoppa) Stoppar den aktuella körningen på valda
block.

Pause (Pausa) Pausar den aktuella körningen på valda
block.

Resume (Återuppta) Återupptar körningen på valda block.

Flash Block Indicator
(Blockets indikatorlampa)

Gör att indikatorlampan på locket till
valda block börjar blinka.

Open Lid (Öppna lock) Öppnar det valda blockets motoriserade
lock.

Close Lid (Stäng lock) Stänger det valda blockets motoriserade
lock.

Hide Selected Blocks
(Dölj valda block)

Dölj de valda blocken i listan Instrument
Summary (Instrumentsammanfattning)

Show All Blocks (Visa
alla block)

Visa de valda blocken i listan Instrument
Summary (Instrumentsammanfattning)

Show (Visa) Välj vilka block som ska visas i listan.
Välj ett av alternativen för att visa alla
detekterade block, alla inaktiva block,
alla block som körs med den aktuella
användaren eller alla block som körs.

Tabell 10. Reglage i verktygsraden Instrument Summary (Instrumentsammanfattning)
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Visa egenskaper för ett instrument
I rutan Detected Instruments (Hittade instrument) kan du visa information om ett valt instrument,
inklusive dess egenskaper, status för låsskruven och en lista med kalibrerade färger (fluoroforer).

Så här visar du instrumentegenskaper

u I rutan Detected Instruments (Hittade instrument) högerklickar du på målinstrumentet och väljer
Properties (Egenskaper) på menyn som visas.

Fliken Properties (Egenskaper)

Fliken Properties (Egenskaper) visar teknisk information om det valda instrumentet, inklusive modell,
komponenternas serienummer och versioner av fast programvara. Instrumentets standardnamn (dess
serienummer) visas på flera platser, inklusive rutan Detected Instruments (Hittade instrument) och i
rubrikfältet för dialogrutan Instrument Properties (Instrumentegenskaper). Du kan ändra namn på ett
instrument så att det blir enklare att identifiera.

Så här ändrar du namn på ett instrument

u Skriv ett namn i rutan Rename (Ändra namn) överst på fliken Properties (Egenskaper) på fliken
Instrument Properties (Instrumentegenskaper) och klicka på Rename (Ändra namn).

Det nya namnet visas på raden Nickname (Alias) på fliken Properties (Egenskaper) samt på
rubrikraden i rutorna Instrument Properties (Instrumentegenskaper) och Detected Instruments
(Hittade instrument).

56 | Systemen CFX96 Dx och CFX96 DeepWell Dx



Hemfönster

Fliken Shipping Screw (Låsskruv)

Fliken Shipping Screw (Låsskruv) visar aktuell status för det valda instrumentets förpackningsskruv
(Removed (Borttagen) eller Installed (Installerad)). Fliken har också instruktioner för installation eller
borttagning av den röda låsskruven.

Tips: Om programvaran detekterar förpackningsskruven visar dialogrutan Instrument Properties
(Instrumentegenskaper) automatiskt fliken Shipping Screw (Låsskruv). Följ anvisningarna för att
ta bort skruven.

Obs! Du måste ta bort låsskruven innan instrumentet kan användas. Se Ta bort transportskruven
på sidan 28 för mer information.

Fliken Calibrated Dyes (Kalibrerade fluoroforer)

Fliken Calibrated Dyes (Kalibrerade fluoroforer) visar kalibrerade fluoroforer och plattor för det valda
instrumentet.

För att se detaljerad information om en kalibrering klickar du på motsvarande Info-knapp i kolumnen
Detail (Information).
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Innan du börjar

Ställa in User Preferences (Användarinställningar)
Tips: Det är inte nödvändigt att utföra dessa åtgärder för att kunna använda CFX Manager Dx-
programvara. Du kan utan risk hoppa över detta avsnitt eller utföra dessa åtgärder när som helst.

I CFX Manager Dx kan du anpassa din arbetsmiljö. Om din administratör har skapat
programanvändare kan varje användare anpassa sin egen arbetsmiljö. Om din administratör inte har
skapat användare gäller preferensändringar för var och en som loggar in i CFX Manager Dx. (För
information om att skapa CFX Manager Dx-användare, se Bilaga B, Hantera CFX Manager Dx-
användare och roller.)

I exempelvis menyn Users > User Preferences (Användare > Användarinställningar) kan du göra
följande:

n Ställa in e-postmeddelande för avslutad körning.

n Ändra standardinställningarna för

o Platsen för att spara filer

o Filerna för körningsinställning

o Filnamnsprefix

n Ställa in standardparametrar som ska användas vid skapandet av ett nytt protokoll och en ny
platta.

n Ställa in standardparametrar för dataanalys och genuttryck.

n Anpassa standardparametrarna för kvalitetskontroll.

n Anpassa parametrarna för dataexport.

I menyn Tools (Verktyg) kan du göra följande:

n Skapa en masterblandning.

n Kalibrera färger för ett specifikt instrument.

Obs! Masterblandningen och färgkalibreringen är tillgängliga för alla som loggar in i CFX
Manager Dx.

I det här avsnittet förklaras utförligt hur dessa åtgärder utförs.
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Ställa in e-postaviseringar

Du kan ansluta CFX Manager Dx till den utgående e-postservern och skicka e-postaviseringar om
slutförda körningar till en lista av användare. Du kan också välja att bifoga en datafil och en
analysrapport till användarlistan. Information om hur du konfigurerar anslutningen mellan CFX
Manager Dx och SMTP-servern finns i Ansluta CFX Manager Dx till en SMTP-server på sidan 60.

Obs! En användares möjlighet att få tillgång till konfigurationsfunktioner för e-post beror på
användargruppen och behörigheterna som användaren tilldelats av administratören. Information
om hur du hanterar användare och deras roller finns i Hantera användare på sidan 259.

Så här ställer du in e-postaviseringar

1. Välj Users > User Preferences (Användare > Användarinställningar) för att öppna dialogrutan
User Preferences (Användarinställningar).

Dialogrutan User Preferences (Användarinställningar) öppnas med fliken Email (E-post).

Obs! Du meddelas ifall systemet detekterar att du inte ställt in en giltig SMTP-server för CFX
Manager Dx. Klicka på Configure Outgoing Email (Konfigurera utgående e-post) för att
öppna dialogrutan Options (Alternativ) och konfigurera e-postens SMTP-server. Mer
information finns i Ansluta CFX Manager Dx till en SMTP-server på sidan 60.

2. Skriv in e-postadresserna till alla personer som du planerar att informera om slutförda körningar i
rutan To (Till). Alla mottagare får ett e-postmeddelande när körningen har slutförts.

Obs! Du måste ange varje e-postadress på en separat rad. Tryck på Enter eller Retur efter
varje adress.

3. (Valfritt:) Ange e-postadressen till mottagare som du planerar att skicka en kopia av varje e-
postavisering till i cc-textrutan.

4. (Valfritt:) Som standard får alla mottagare en kopia av datafilen som bilaga. Avmarkera den här
kryssrutan om du inte vill bifoga en kopia av datafilen.
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5. (Valfritt:) Välj Attach Analysis Report (Bifoga analysrapport) för att bifoga en PDF-fil med
analysrapporten i e-postmeddelandet.

6. Klicka på OK för att spara ändringarna och stänga dialogrutan User Preferences
(Användarinställningar).

Så här redigerar du en mottagares e-postadress

u Ändra e-postadressen efter behov och klicka på OK.

Så här tar du bort en e-postmottagare

1. Välj e-postmottagaren och tryck på Delete-tangenten.

2. Klicka på OK för att spara ändringarna och stänga dialogrutan.

Viktigt! Om du klickar på Restore Defaults (Återställ standardinställningar) i dialogrutan User
Preferences (Användarinställningar) återställs alla inställningar på alla flikar till de ursprungliga
fabriksinställningarna. Var försiktig när du klickar på den här knappen.

Ansluta CFX Manager Dx till en SMTP-server

Viktigt! Vissa kommersiella leverantörer av webbmailtjänster (t.ex. Yahoo! och Gmail) har höjt
säkerheten för e-post. Om du använder dessa konton måste du aktivera inställningen Tillåt
mindre säkra appar i deras kontoinställningar för att CFX Manager Dx ska kunna skicka e-post.
Se säkerhetsinformationen för din leverantör av webbmailtjänster för mer information.

Du måste etablera en anslutning från CFX Manager Dx till din e-post innan programmet kan skicka e-
postmeddelande.

För att ansluta CFX Manager Dx till en e-postserver

1. Gör något av följande:

n Välj User > User Preferences (Användare > Användarinställningar) och klicka på Configure
Outgoing Email (Konfigurera utgående e-post) på fliken Email (E-post).

n Välj Tools > Options (Verktyg > Alternativ).
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Dialogrutan Options (Alternativ) visas med fliken Email (E-post).

2. Ange följande information för ditt företag:

n SMTP Server Name (Namn på SMPT-server) – namnet på den utgående e-postservern för
ditt företag.

n Port – portnumret för SMTP-servern. Detta är vanligtvis 25.

n Use SSL (Använd SSL) – alternativet Secure Sockets Layer (SSL). Vissa SMTP-servrar
kräver denna inställning. Om det inte krävs på ditt företag kan du avmarkera den här
kryssrutan.

n Use Default “From” Address (Använd standardadress för avsändare) – namnet på e-
postservern på ditt företag. Vissa SMTP-servrar kräver att all skickad e-post ska ha en
avsändaradress som kommer från en viss domän, t.ex. namn@DittFöretag.com. Om så är
fallet avmarkerar du denna kryssruta och anger en giltig e-postadress.

n Authentication Required (Autentisering krävs) – om din plats kräver kontoautentisering ska
du verifiera att denna kryssruta är ifylld.

n User Name (Användarnamn) – namnet på det autentiserade kontot. Detta krävs endast om
Autentisering krävs är valt.

n Password (Lösenord) – lösenordet för det autentiserade kontot. Detta krävs endast om
Autentisering krävs är valt.
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3. För att verifiera att SMTP-serverinställningarna är korrekta, anger du en giltig e-postadress i
textrutan Test Email Address (Testa e-postadress) och klickar på Test Email (Testa e-post).

Obs! Vissa SMTP-servrar tillåter inte bilagor och andra tillåter bilagor endast upp till en viss
storlek. Om du planerar att skicka datafiler och/eller rapporter via e-post med CFX Manager
Dx, välj Test Attachment (Testa bilaga) och ställ in Attachment Size in MB (Bilagans storlek i
MB) på 5 megabyte (MB) eller mer.

4. Klicka på OK för att spara ändringarna och stänga dialogrutan.

Ändra Default File Settings (Standardfilinställningar)

På fliken Files (Filer) i dialogrutan User Preference (Användarpreferens) kan du ändra följande:

n Standardplatsen för att spara CFX Manager Dx-filer

n Standardfilerna för körningsinställning

n Standardparametrar för filnamn

För att ändra standardfilinställningarna

1. Välj Users > User Preferences (Användare > Användarinställningar) för att öppna dialogrutan
User Preferences (Användarinställningar).

2. I dialogrutan User Preferences (Användarinställningar) väljer du fliken Files (Filer).
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3. I sektionen Default Folder for File Creation (Standardmapp för filskapande) går du till och väljer en
standardmapp där du vill spara nya filer. Du kan välja olika platser för varje filtyp:

n Protocol (Protokoll)

n Plate (Platta)

n Data File (Datafil)

n Gene Study (Genstudie)

4. I sektionen File Selection for Run Setup (Filval för körningsinställning) går du till och väljer
målprotokollet och plattfilerna som ska visas när du öppnar fönstret Experiment Setup
(Experimentinställning).

5. I sektionen Data File (Datafil) definierar du prefix och/eller suffix för datafiler. För varje del väljer
du ett nytt värde från dess nedrullningsbara lista. Du kan även ange anpassade prefix- och
suffixvärden i textrutorna Prefix och Suffix.

CFX Manager Dx förhandsvisar filnamnet nedanför valrutorna.

6. Klicka på OK för att spara ändringarna och stänga dialogrutan.

Viktigt! Om du klickar på Restore Defaults (Återställ standardinställningar) i dialogrutan User
Preferences (Användarinställningar) återställs alla inställningar på alla flikar till de ursprungliga
fabriksinställningarna. Var försiktig när du klickar på den här knappen.
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Ställa in standardprotokollparametrar

Så här ställer du in standardprotokollparametrar för Protocol Editor
(Protokollredigerare) och Protocol AutoWriter (Automatisk protokollskrivare)

1. Välj Users > User Preferences (Användare > Användarinställningar) för att öppna dialogrutan
User Preferences (Användarinställningar).

2. Välj fliken Protocol (Protokoll) i dialogrutan User Preferences (Användarinställningar).

3. I avsnittet Protocol Editor (Protokollredigerare) anger du värden för följande inställningar som
visas i Protocol Editor (Protokollredigerare):

n Sample volume (Provvolym) – volymen av varje prov i brunnarna (i µl).

n Lid Shutoff temperature (Lockavstängningstemperatur) – den temperatur i ºC vid vilken
lockvärmaren stängs av under en körning.

4. I avsnittet Protocol AutoWriter (Automatisk protokollskrivare) anger du värdena för följande
inställningar som visas i Protocol AutoWriter (Automatisk protokollskrivare):

n Annealing temperature (Hybridiseringstemperatur) – temperatur i ºC för experiment som
använder iProof™ DNA-polymeras, iTaq™DNA-polymeras eller andra polymeraser.

n Amplicon length (Amplikonlängd) – längden på amplikonen i bp.

5. Klicka på OK för att spara ändringarna och stänga dialogrutan.

Viktigt! Om du klickar på Restore Defaults (Återställ standardinställningar) i dialogrutan User
Preferences (Användarinställningar) återställs alla inställningar på alla flikar till de ursprungliga
fabriksinställningarna. Var försiktig när du klickar på den här knappen.
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Ställa in standardplattparametrar

Ändringar som görs på fliken Plate (Platta) är tillgängliga för alla användare av programvaran.
Ändringar som görs under plattinställningen är tillgängliga för användare när du har sparat och stängt
plattfilen.

I dialogrutan User Preferences (Användarinställningar) kan du göra följande:

n Ställa in standardplattparametrarna.

n Lägga till nya namn på mål och prover i deras respektive bibliotek.

n Ta bort namn på mål och prover i deras respektive bibliotek.

Så här ställer du in standardplattparametrar

1. Välj Users > User Preferences (Användare > Användarinställningar) för att öppna dialogrutan
User Preferences (Användarinställningar).

2. Välj fliken Plate (Platta) i dialogrutan User Preferences (Användarinställningar).
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3. Ange värdena för följande inställningar för en ny plattfil. Följande värden visas i fönstret Plate
Editor (Plattredigerare):

n Plate type (Plattyp)

n Plate size (Plattstorlek)

n Units (Enheter) – koncentrationen av startmallen för brunnar som innehåller standarder.

CFX Manager Dx använder dessa enheter för att skapa en standardkurva på fliken Data
Analysis Quantification (Dataanalyskvantifiering).

n Scientific notation (Grundpotensform) – när detta väljs visar CFX Manager Dx
koncentrationsenheterna i grundpotensform.

n Scan mode (Skanningsläge) – antalet eller typen av kanaler som ska skannas under en
körning.

n Fluorophores (Fluoroforer) – standardfluoroforerna som visas i reglagen för brunnladdning i
Plate Editor (Plattredigerare).

n Libraries (Bibliotek) – namn på mål och prover som du normalt använder i experiment:

o Target names (Målnamn) – namnen på målgener och -sekvenser.

o Sample names (Provnamn) – namnen på experimentprover eller en identifierande
egenskap för proverna (t.ex. Mouse1, Mouse2, Mouse3 (Mus 1, 2, 3)).

4. Klicka på OK för att spara ändringarna och stänga dialogrutan.

Så här lägger du till nya mål och prover

u I tillämplig biblioteksruta anger du namnet på målet eller provet och klickar på OK.

Så här tar du bort namnet på mål och prover

u Välj namnet i tillämplig biblioteksruta, tryck på Delete-tangenten och klicka på OK.

Viktigt! Namn som du tar bort från biblioteket tas bort från programvaran och är inte längre
tillgängliga för användare. Klicka på Restore Defaults (Återställ standardinställningar) för att
återställa CFX Manager Dx-standardnamnen. Om du klickar på Restore Defaults (Återställ
standardinställningar) i dialogrutan User Preferences (Användarinställningar) återställs alla
inställningar på alla flikar till de ursprungliga fabriksinställningarna. Var försiktig när du tar bort
CFX Manager Dx-standardnamn och klickar på den här knappen.
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Ställa in standardparametrar för dataanalys

Så här ställer du in standardparametrar för dataanalys

1. Välj Users > User Preferences (Användare > Användarinställningar) för att öppna dialogrutan
User Preferences (Användarinställningar).

2. I dialogrutan User Preferences (Användarinställningar) väljer du fliken Data Analysis
(Dataanalys).

3. I avsnittet Analysis Mode (Analysläge) väljer du läget som data ska analyseras i (Fluorophore
(Fluorofor) eller Target (Mål)).

4. I avsnittet PCR Quantitation (PCR-kvantifiering) ställer du in standardparametrarna för följande
alternativ:

n Baseline Setting (Baslinjeinställning) – baslinjemetoden för analysläget.

n Cq Determination Mode (Cq-bestämningsläge) – läget i vilket Cq-värdena beräknas för
varje fluorescenskurva (antingen regression eller enkelt tröskelvärde).
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n Threshold Calc. Mode (Läge för tröskelvärdesberäkning) – slutpunktsmålmängden.

Standard är Auto. Med andra ord beräknar programvaran slutpunktsmålet automatiskt. För
att ställa in ett specifikt tröskelvärde avmarkerar du kryssrutan Auto och anger ett
slutpunktsvärde beräknat i RFU (Relative Fluorescence Units). Det högsta värdet är
65 000,00 RFU. Datafiler för efterföljande körningar använder denna
tröskelvärdesinställning.

n Baseline Calc. Mode (Läge för baslinjeberäkning) – baslinjevärdet för alla kurvor.

Standard är Auto. Med andra ord beräknar programvaran baslinjen för alla kurvor
automatiskt. Du ställer in ett specifikt baslinjevärde genom att avmarkera kryssrutan Auto
och ange minimi- och maximivärden för cykelintervallet (1 till 9 999). Datafiler för
efterföljande körningar använder detta cykelintervall.

n Log View (Logaritmisk visning) – avgör hur programvaran visar amplifieringsdata:

o On (På) – amplifieringsdata visas i ett semilogaritmiskt diagram.

o Off (Av) – (standard) amplifieringsdata visas i ett linjärt diagram.

5. I avsnittet End Point (Slutpunkt) väljer du antalet slutcykler som ska beräknas medeltalet av när
slutpunktsberäkningar utförs:

n PCR – antalet slutcykler för vilka ska beräknas medeltalet för kvantifieringsdata (standard
är 5).

n End Point Only run (Körning av endast slutpunkter) – antalet slutcykler som ska beräknas
medeltalet av för slutpunktsdata (standard är 2).

6. I avsnittet Melt Curve (Smältkurva) väljer du topptypen som ska detekteras (positiv eller negativ).

7. I avsnittet Well Selector (Brunnsväljare) väljer du hur brunnsetiketter ska visas (efter provtyp,
målnamn eller provnamn).

8. Klicka på OK för att spara ändringarna och stänga dialogrutan.

Viktigt! Om du klickar på Restore Defaults (Återställ standardinställningar) i dialogrutan User
Preferences (Användarinställningar) återställs alla inställningar på alla flikar till de ursprungliga
fabriksinställningarna. Var försiktig när du klickar på den här knappen.
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Ställa in standardparametrar för genuttrycksdatafil

För att ställa in standardparametrar för en ny genuttrycksdatafil

1. Välj Users > User Preferences (Användare > Användarinställningar) för att öppna dialogrutan
User Preferences (Användarinställningar).

2. Välj fliken Gene Expression (Genuttryck) i dialogrutan User Preferences (Användarinställningar).

3. Specificera värdena för följande inställningar:

n Relative to (I relation till) – graf för genuttrycksdata i relation till antingen en kontroll (med
början vid 1) eller till noll:

o Zero (Noll) – programmet ignorerar kontrollen. Detta är standarden när inget
kontrollprov är tilldelat i fönstret Experiment Settings (Experimentinställning).

o Control (Kontroll) – programmet beräknar data i relation till kontrollprovet som är tilldelat
i fönstret Experiment Setup (Experimentinställning).

n X-axis (X-axel) – graf för provet eller målet på x-axeln.

n Y-axis (Y-axel) – graf för linjär, log2 eller log10-skala på y-axeln.

n Scaling (Skalning) – skalningsalternativet för grafen (standardalternativet är utan skalning):

o Highest (Högst) – programmet skalar grafen enligt den högsta datapunkten.
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o Lowest (Lägst) – programmet skalar grafen enligt den lägsta datapunkten.

o Unscaled (Utan skalning) – programmet visar data utan skalning i grafen.

n Mode (Läge) – analysläget, antingen relativ kvantitet (∆Cq) eller normaliserat uttryck (∆∆Cq).

n Error Bar (Felstapel) – datavariationen visas som antingen standardavvikelse (Std. Dev.)
(SD) eller medelvärdets standardfel (Std. Error Mean) (SEM).

n Error Bar Multiplier (Felstapelmultiplikator) – standardavvikelsemultiplikator som används
för att rita en graf av felstaplarna (standarden är 1).

Du kan öka multiplikatorn till antingen 2 eller 3.

n Sample Types to Exclude (Provtyper att exkludera) – provtyper som ska exkluderas från
analysen.

Du kan välja ett eller flera prover som ska exkluderas från analysen. För att exkludera alla
provtyper rensar du kryssrutorna för valda provtyper.

4. Klicka på OK för att spara ändringarna och stänga dialogrutan.

Viktigt! Om du klickar på Restore Defaults (Återställ standardinställningar) i dialogrutan User
Preferences (Användarinställningar) återställs alla inställningar på alla flikar till de ursprungliga
fabriksinställningarna. Var försiktig när du klickar på den här knappen.

Anpassa kvalitetskontrollregler

I CFX Manager Dx kan du ange kvalitetskontrollregler som tillämpas på data i fönstret Data Analysis
(Dataanalys). Programvaran validerar data i förhållande till reglerna som du anger.

Obs! Alla kvalitetskontrollregler är aktiverade som standard.

Tips: Du kan enkelt utesluta brunnar som inte klarar en kvalitetskontrollparameter från analys i
kvalitetskontrollmodulen för fönstret Data Analysis (Dataanalys).

Så här anpassar du kvalitetskontrollregler

1. Välj Users > User Preferences (Användare > Användarinställningar) för att öppna dialogrutan
User Preferences (Användarinställningar).

2. I dialogrutan User Preferences (Användarinställningar) väljer du fliken QC (Kvalitetskontroll).
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där:

n NTC – ingen mallkontroll

n NRT – inget omvänt transkriptas

n Efficiency (Effektivitet) – reaktionseffektivitet

n Std Curve R^2 – R-kvadratvärde för standardkurva

n Replicate group Cq Std Dev (Beräkning av standardavvikelse för replikatgrupp) –
standardavvikelse beräknad för varje replikatgrupp

3. Gör något av följande för varje kvalitetskontrollsregel:

n Om du vill använda standardvärdet gör du ingenting.

n För att ändra värdet klickar du på textrutan Value (Värde) och klickar på Retur.

n Avmarkera relevant kryssruta för Use (Använd) för att inaktivera regeln.

4. Klicka på OK för att spara ändringarna och stänga dialogrutan.

Viktigt! Om du klickar på Restore Defaults (Återställ standardinställningar) i dialogrutan User
Preferences (Användarinställningar) återställs alla inställningar på alla flikar till de ursprungliga
fabriksinställningarna. Var försiktig när du klickar på den här knappen.
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Anpassa parametrarna för dataexport

Det går att exportera CFX Manager Dx-data i följande format:

n Text (.txt)

n CSV (.csv)

n Excel 2007 (.xlsx)

n Excel 2003 (.xls)

n XML (.xml)

n HTML (.html)

Du kan ange typen av data som ska exporteras och anpassa utmatningen av exporterade data.

Så här anpassar du dataexportparametrar

1. Välj Users > User Preferences (Användare > Användarinställningar) för att öppna dialogrutan
User Preferences (Användarinställningar).

2. Välj fliken Custom Export (Anpassad export) i dialogrutan User Preferences
(Användarinställningar).
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3. I listrutan Export Format (Exportformat) väljer du formatet som data ska exporteras i.

4. I avsnittet Data to Export (Data som ska exporteras) markerar eller avmarkerar du kryssrutorna
för typen av data som ska exporteras. De valda objekten visas i listrutan Exported Columns
(Exporterade kolumner).

Obs! Som standard ingår körningsinformation i rubriken. Avmarkera den här kryssrutan om
du inte vill att körningsinformation ingår.

5. Du kan ändra den utmatade visningsordningen för de valda objekten.

I listrutan Exported Columns (Exporterade kolumner) markerar du objektet och klickar på
pilknapparna till vänster om listan för att flytta det uppåt eller nedåt.

6. Det går att ändra de utmatade kolumnnamnen för de valda objekten:

a. Klicka på Customize Column Names (Anpassa kolumnnamn).

Dialogrutan Column Name Customizer (Anpassare av kolumnnamn) öppnas.

b. För varje standardkolumnnamn som du vill ändra skriver du in det nya namnet i dess fält
Custom Name (Anpassat namn).

c. Gör något av följande:

n Klicka på OK för att spara ändringarna och återgå till fliken Custom Export (Anpassad
export). Det nya namnet visas i parentes bredvid standardkolumnnamnet i listrutan
Exported Columns (Exporterade kolumner).

n Klicka på Cancel (Avbryt) för att rensa ändringarna och återgå till fliken Custom Export
(Anpassad export).

7. Klicka på OK för att spara ändringarna och stänga dialogrutan.

Viktigt! Om du klickar på Restore Defaults (Återställ standardinställningar) i dialogrutan User
Preferences (Användarinställningar) återställs alla inställningar på alla flikar till de ursprungliga
fabriksinställningarna. Var försiktig när du klickar på den här knappen.

Skapa en reaktionsmasterblandning
Med CFX Manager Dxs Master Mix Calculator (Master Mix-kalkylator) kan du enkelt beräkna den
nödvändiga volymen av varje komponent i huvudblandningen. Du kan skriva ut tabellen för
masterblandningsberäkningar på standardskrivaren och spara beräkningarna för varje mål för senare
användning.
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Så här skapar du en reaktionsmasterblandning i Master Mix Calculator (Master Mix-
kalkylator)

1. Gör något av följande för att öppna Master Mix Calculator (Master Mix-kalkylator):

n Välj Tools > Master Mix Calculator (Verktyg > Master Mix-kalkylator).

n Klicka på Master Mix Calculator (Master Mix-kalkylator) i verktygsraden.

Master Mix Calculator (Master Mix-kalkylator) öppnas.

2. Välj en detektionsmetod i avsnittet Reaction (Reaktion):

n SYBR®Green/EvaGreen

n Probes (Prober)

3. Klicka på Create New (Skapa ny) i avsnittet Target (Mål) för att välja ett nytt mål. Ett nytt målnamn
visas i målets listruta.
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4. (Valfritt:) Så här ändrar du standardmålnamnet:

a. Markera målets namn i målets listruta.

b. Skriv in ett nytt målnamn i rutan Target (Mål).

c. Tryck på Enter-tangenten.

5. Justera start- och slutkoncentrationerna för de framåtriktade och bakåtriktade primrarna samt
eventuella prober.

6. I avsnittet Master Mix Setup (Huvudblandningsinställning) justerar du värdena för

n Number of reactions (Antal reaktioner) som ska köras

n Reaction volume (Reaktionsvolym) per brunn

n Template volume (Mallvolym) per brunn

n Supermix concentration (Supermix-koncentration) per brunn

n Excess reaction volume (Reaktionsvolymsöverskott) per brunn

7. (Valfritt:) Utför stegen 2–6 för så många mål som behövs.

8. I avsnittet Choose Target to Calculate (Välj mål som ska kalibreras) väljer du målet som ska
kalibreras.

Tips: Du kan bara beräkna ett eller flera eller alla mål samtidigt.

De beräknade volymerna av komponenterna som krävs för varje valt mål visas i tabellen för
masterblandning.

9. Klicka på Set as Default (Ställ in som standard) för att ställa in de inmatade kvantiteterna i
avsnitten Target (Mål) och Master Mix Setup (Masterblandningsinställning) som nya
standardvärden.

10. Klicka på OK för att spara innehållet i dialogrutan Master Mix Calculator (Master Mix-kalkylator).

Så här skriver du ut tabellen för masterblandningsberäkningar

u Du skriver ut en tabell för masterblandningsberäkningar genom att klicka på Print (Skriv ut).

Tabellen med beräkningar skrivs ut på standardskrivaren.
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Så här sparar du tabellen för masterblandningsberäkningar som en PDF-fil

u Ändra standardskrivaren till en PDF-drivrutin och klicka på Print (Skriv ut) i Master Mix Calculator
(Master Mix-kalkylator).

Så här tar du bort mål

u Välj målet i målets listruta och klicka på Remove (Ta bort).

Viktigt! När du tar bort ett mål från mållistan tas det även bort från
masterblandningsberäkningar som det används i. Var försiktig när du tar bort ett mål.
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Kalibrera nya färger
Systemen CFX96™Dx är fabrikskalibrerade för vanliga fluoroforer i plattor med vita brunnar och
transparenta brunnar. Tabell 11 listas fluoroforerna och kanalen för vilka varje instrument kalibreras.

Obs! Systemen CFX96 har också en kanal som är dedicerad till FRET-kemi. Den här kanalen
kräver inte kalibrering för specifika färgämnen.

Fluoroforer Kanal Excitation, nm Detektion, nm

FAM, SYBR® Green I 1 450–490 515–530

VIC, HEX, CAL Fluor Gold 540, Cal
Fluor Orange 560

2 515–535 560–580

ROX, Texas Red, CAL Fluor Red 610,
TEX 615

3 560–590 610–650

CY5, Quasar 670 4 620–650 675–690

Quasar 705, Cy5.5 5 672–684 705–730

Tabell 11. Fabrikskalibrerade fluoroforer och kanaler
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Så här kalibrerar du nya färgämnen för CFX-system

1. Välj målinstrumentet i rutan Detected Instruments (Hittade instrument) i startfönstret.

2. Välj Tools > Calibration Wizard (Verktyg > Kalibreringsguide) för att öppna guiden Dye Calibration
(Färgämneskalibrering).

Fluoroforer som redan har kalibrerats för målinstrumentet visas i tabellen Calibrated
Fluorophores (Kalibrerade fluoroforer).

3. Välj fluoroforen som ska kalibreras i listrutan i avsnittet Calibrate New or Existing Fluorophores
(Kalibrera nya eller befintliga fluoroforer).

Om inte fluoroforen finns i listan skriver du in dess namn i textrutan för att lägga till det i listan.

4. Välj plattyp för fluoroforen.

Om inte plattypen finns i listan skriver du in dess namn i textrutan för att lägga till det i listan.

5. Välj en kanal för fluoroforen.

6. Välj en plattkolumn för fluoroforen.

7. (Valfritt:) Ange en färg som ska associeras med fluoroforen.

8. Klicka på Add to Plate (Lägg till i platta) för att lägga till fluoroforen.

9. (Valfritt:) Upprepa stegen 3–8 och lägg till alla fluoroforer som du planerar att kalibrera för plattan.

10. När du har lagt till alla fluoroforer klickar du på View Plate (Visa platta) för att öppna fönstret Pure
Dye Plate Display (Visning av rena plattfärgämnen).

Använd det här fönstret som vägledning för att ladda färgämnen i plattan.
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11. Bered en 96-brunnsplatta för färgämneskalibreringen:

a. Pipettera färgämneslösning i varje brunn enligt mönstret som visas i Pure Dye Plate Display
(Visning av rena plattfärgämnen).

b. För varje fluorofor fyller du fyra brunnar med 50 µl (96-brunnsplatta) av 300 nM
färgämneslösning. Observera att minst hälften av plattan innehåller tomma brunnar.

c. Försegla plattan med förseglingsmetoden som ska användas i experimentet.

12. Placera kalibreringsplattan i blocket och stäng locket.

13. I guiden Dye Calibration (Färgämneskalibrering) klickar du på Calibrate (Kalibrera) följt av OK för
att bekräfta att plattan är i blocket.

14. När CFX Manager Dx-programvara slutför kalibreringskörningen öppnas en dialogruta. Klicka på
Yes (Ja) för att slutföra kalibreringen och öppna Dye Calibration Viewer (Visningsprogram för
färgämneskalibrering).

15. Klicka på OK för att stänga fönstret.
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Ett protokoll är en uppsättning steg som exekveras i en specifik sekvens. I CFX Manager™ Dx-
programvaran associeras alla steg med alternativen på instrumentet. Till exempel instruerar stegen
instrumentet att styra block- och locktemperaturen, använda en temperaturskillnad i hela blocket, göra
en plattavläsning eller utföra en smältkurvanalys. Varje alternativ specificeras för olika platt- och
körningstyper.

CFX Manager Dx har två alternativ för att skapa protokoll: Protocol Editor (Protokollredigerare) och
Protocol AutoWriter (Protokollförslag).

I Protocol Editor (Protokollredigerare) finns följande funktioner:

n Standardprotokollsreglage för att snabbt skapa protokoll

n Möjlighet att snabbt beräkna en gradient för det valda antalet rader

n Möjlighet att snabbt beräkna körtiden för den valda plattypen

n Möjlighet att redigera protokollsteg

n Möjlighet att spara protokoll för återanvändning

n Möjlighet att skriva ut protokollet på en standardskrivare

Protocol AutoWriter (Protokollförslag) genererar automatiskt ett anpassat PCR-protokoll med stegen
”hot start”, initial denaturering, hybridisering och extension utifrån dina angivna parametrar. Du kan
sedan visa en grafisk representation av det föreslagna protokollet och redigera, köra eller spara
protokollet.
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Fönstret Protocol Editor (Protokollredigerare)
Använd Protocol Editor (Protokollredigerare) för att skapa, öppna, granska och redigera ett protokoll.
Som standard öppnas Protocol Editor (Protokollredigerare) och visar ett realtidsbaserat
tvåstegsprotokoll för en platta med 96 brunnar.

1. Menyraden ger snabb åtkomst till kommandon för File (Arkiv), Settings (Inställningar) och
Tools (Verktyg).

2. Med verktygsraden kan du snabbt spara och skriva ut protokollet, fastställa var ett steg ska
infogas, ange provvolym samt visa beräknad protokollkörningstid.

3. Huvudrutan visar en grafisk representation av protokollet.

4. Den nedre rutan visar protokollskissen.

5. Den vänstra rutan visar protokollkontroller som du kan lägga till för att anpassa protokollet.

FÖRKLARING

Menykommandon för File (Arkiv)
Save (Spara) – sparar det aktuella protokollet.

Save As (Spara som) – sparar det aktuella protokollet med ett nytt namn eller på en ny plats.

Close (Stäng) – stänger Protocol Editor (Protokollredigerare).
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Kommando i menyn Settings (Inställningar)
Lid Settings (Lockinställningar) – öppnar dialogrutan Lid Setting (Lockinställning) i vilken du kan
ändra eller ställa in locktemperaturen.

Kommandon i menyn Tools (Verktyg)
Gradient Calculator (Gradientkalkylator) – öppnar en dialogruta där du kan välja blocktyp för ett
gradientsteg. Standard är 96 brunnar.

Run time Calculator (Kalkylator för körningstid) – öppnar en dialogruta där du kan välja plattyp och
skanningsläge för att beräkna uppskattad körningstid i fönstret Run Setup (Körningsinställning).
Standard är 96 brunnar, alla kanaler.

Kommandon i verktygsraden

– sparar den aktuella protokollfilen.

– skriver ut det valda fönstret.

– använd det här kommandot för att välja var steg ska infogas i relation till det
aktuella valda steget.

– använd det här kommandot för att ange en provvolym i µl. Provvolymer
skiljer sig åt beroende på typen av block:

n För ett block med 96 djupa brunnar är intervallet 0–125 µl.

n För ett block med 96 brunnar är intervallet 0–50 µl.

– visar beräknad körningstid baserat på protokollsteg, stigningshastighet och
den valda typen av block.

– visar hjälpinformation om protokoll.
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Protokollredigeringskontroller
Den vänstra rutan i fönstret Protocol Editor (Protokollredigerare) har kontroller med vilka du kan skapa
protokoll.

Varje kontroll består av en uppsättning parametrar som representerar ett steg i protokollet. Du kan
ändra varje parameter och lägga till eller ta bort dem för att anpassa protokollet. Den här sektionen
beskriver alternativen i varje kontroll.

n Insert Step (Infoga steg) – infogar ett steg före eller efter det valda
steget. Du kan redigera temperatur- och hålltidsvärden i protokollets
grafiska visning eller i protokollöversikten.

n Insert Gradient (Infoga gradient) – infogar ett gradientsteg baserat
på typ av brunnsblock som har valts i gradientkalkylatorn. Du kan
redigera gradientintervallet i rutan Gradient som visas när ett
gradientsteg infogas.

n Insert GOTO (Infoga GOTO) – infogar ett cykliskt (loop-) steg som
instruerar programvaran att upprepa specifika steg i sekvens för ett
visst antal cykler. Repetitionerna inleds när den första cykeln är
avslutad. Du kan till exempel instruera programvaran att utföra 39

repetitioner av steg 2–4. Efter den slutliga repetitionen kommer programvaran att ha utfört steg 2–
4 totalt 40 gånger. Du kan redigera återgå-till-steget (GOTO) och antalet cykler antingen i den
grafiska visningen eller i protokollöversikten.

n Insert Melt Curve (Infoga smältkurva) – infogar ett lässteg för smältkurvan.

n Insert Plate Read to Step (Infoga plattavläsning i steg) – lägger till ett plattläsningskommando i
det valda steget. En plattläsning mäter fluorescensmängden i slutet av en cykel.
Plattläsningsteget är vanligen det sista steget i en GOTO-loop.

Tips: När du har lagt till ett plattläskommando i ett steg ändras knappen till Remove Plate
Read (Ta bort plattavläsning) när du väljer ett steg.

n Remove Plate Read (Ta bort plattavläsning) – tar bort ett plattläsningskommando från det valda
steget.

Tips: När du har tagit bort ett plattläskommando från ett steg ändras knappen till Add Plate
Read to Step (Lägg till plattavläsning till steg) när du väljer steget.
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n Step Options (Stegalternativ) – öppnar dialogrutan Step Options (Stegalternativ) och visar
tillgängliga alternativ för det valda steget. Se Step Options (Stegalternativ) på sidan 85 för
ingående information om stegalternativen.

Tips: Du kan också använda Step Options (Stegalternativ) genom att högerklicka på steget i
den grafiska visningen.

n Delete Step (Ta bort steg) – tar bort det valda steget från protokollet.

Step Options (Stegalternativ)

Öppna dialogrutan Step Options (Stegalternativ) för att visa alternativ som du kan lägga till, ändra eller
ta bort från ett steg.

n Plate Read (Plattläsning) – genom att välja det här alternativet lägger du till en plattläsning i
steget.

n Temperature (Temperatur) – anger måltemperaturen för det valda steget.

n Gradient – anger gradientintervallet för steget. Intervallet är 1–24 °C.

Obs! En gradient körs med den lägsta temperaturen framtill i blocket (rad H i den här bilden)
och den högsta temperaturen baktill på blocket (rad A i den här bilden).

n Increment (Ökning) – mängden för ökning (eller minskning) av temperaturen för det valda steget.
Det här värdet adderas till måltemperaturen med varje cykel. Området är ± 0,1–10 °C.

Obs! För att minska temperaturen skriver du ett minustecken (–) före det numeriska värdet
(till exempel –5 °C).

n Ramp Rate (Upprampningstal) – upprampningstal för det valda steget. Intervallet beror på
blockstorleken.
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n Time (Tid) – hålltiden för det valda steget.

n Extend (Förläng) – den tid (i sekunder) med vilken du vill förlänga eller förkorta det valda steget.
Det här alternativet läggs till hålltiden i varje cykel. Intervallet är 1–60 sekunder.

n Beep (Pip) – om det här alternativet väljs ljuder ett pip i slutet av steget.

Tips: När du anger ett nummer utanför alternativintervallet ändrar programvaran numret till
det närmaste värdet inom intervallet.
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Skapa ett protokoll i Protocol Editor (Protokollredigerare)
I Protocol Editor (Protokollredigerare) kan du skapa anpassade protokollfiler. Det går även att redigera
och spara tidigare sparade protokollfiler eller provprotokollfiler som levererats med CFX Manager Dx-
programvara.

Gör följande för att skapa en ny protokollfil:

n Öppna en protokollfil i Protocol Editor (Protokollredigerare).

Tips: Du kan öppna ett nytt eller befintligt protokoll i Protocol Editor (Protokollredigerare).

n Ställ in det nya protokollet.

n Lägg till protokollsteg i protokollkontrollsrutan.

n Redigera stegens egenskaper.

n Spara protokollet.

Tips: Information om hur du skapar ett nytt protokoll av en tidigare sparad eller provprotokollfil
finns i Öppna ett befintligt protokoll i Protocol Editor (Protokollredigerare) på sidan 89.

Öppna en ny protokollfil i Protocol Editor (Protokollredigerare)
CFXManager Dx har flera alternativ för att öppna en ny protokollfil:

n Från hemfönstret

n Från dialogrutan Startup Wizard (Startguide)

n Från dialogrutan Run Setup (Körningsinställning)

Så här öppnar du en ny protokollfil i hemfönstret

u Välj File > New > Protocol (Arkiv > Ny > Protokoll).

Fönstret Protocol Editor (Protokollredigerare) öppnas och visar standardprotokollfilen.

Tips: Information om hur du ställer in standardprotokollet finns i Ändra Default File Settings
(Standardfilinställningar) på sidan 62.
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Så här öppnar du en ny protokollfil i Startup Wizard (Startguide)

1. Gör något av följande i hemfönstret för att öppna Startup Wizard (Startguide) om den inte är i vyn:

n Välj View > Startup Wizard (Visa > Startguide).

n Klicka på Startup Wizard (Startguide) i verktygsraden.

Som standard visar Startup Wizard (Startguide) fliken Run setup (Körningsinställningar) med
CFX96™-instrumenttypen vald.

2. Välj vid behov instrumenttyp från listrutan.

3. Klicka på User-defined (Användardefinierad) som Run type (Körningstyp).

Dialogrutan Run Setup (Körningsinställning) öppnas med fliken Protocol (Protokoll) och visar
standardprotokollfilen.

4. Klicka på Create New (Skapa ny).

Fönstret Protocol Editor (Protokollredigerare) öppnas och visar standardrealtidsprotokollet.

Så här öppnar du ett nytt protokoll i dialogrutan Run Setup (Körningsinställning)

1. Gör något av följande i hemfönstret för att öppna dialogrutan Run Setup (Körningsinställning):

n Välj Run > User-defined Run (Körning > Användardefinierad körning).

n Klicka på User-defined Run Setup (Användardefinierad körningsinställning) på
verktygsraden.

Dialogrutan Run Setup (Körningsinställningar) öppnas med fliken Protocol (Protokoll) och visar
standardprotokollfilen.

2. Klicka på Create New (Skapa ny).

Fönstret Protocol Editor (Protokollredigerare) öppnas och visar standardrealtidsprotokollet.
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Öppna ett befintligt protokoll i Protocol Editor
(Protokollredigerare)
CFXManager Dx tillhandahåller provprotokollfiler som du kan redigera och spara som anpassade nya
protokoll. Du kan också skapa ett nytt protokoll utifrån ett befintligt anpassat protokoll.

Så här öppnar du en provprotokollfil

1. Välj File > Open > Protocol (Arkiv > Öppna > Protokoll) i hemfönstret.

Utforskaren i Windows öppnas som standard på platsen för mappen Sample Files (Provfiler) för
CFX Manager Dx.

2. Öppna mappen Sample files (Provfiler). Följande mappar visas:

n ConventionalProtocols (Konventionella protokoll) – innehåller exempelprotokollfiler för
traditionell PCR-analys.

n DataFiles (Datafiler) – innehåller exempeldatafiler som du kan använda för att utforska
funktionerna i CFX Manager Dx.

n MeltCalibration (Smältkalibrering) – innehåller exempelprotokollfiler för användning med
Bio-Rad-programvaran för precisionssmältanalys.

n Plates (Plattor) – innehåller exempelplattfiler.

n RealTimeProtocols (Realtidsprotokoll) – innehåller exempelprotokollfiler för realtidsbaserad
PCR-analys.

3. Öppna protokollmappen för typen av körning som du vill genomföra, antingen
ConventionalProtocols (Konventionella protokoll) eller RealTimeProtocols (Realtidsprotokoll).

4. Välj önskat protokoll och klicka på Open (Öppna).

Protokollet öppnas i fönstret Protocol Editor (Protokollredigerare).

5. Välj File > Save As (Arkiv > Spara som) och spara protokollet med ett nytt namn eller i en ny
mapp.

Så här öppnar du ett befintligt protokoll

1. Gör något av följande i fönstret Home (Hem):

n Välj File > Open > Protocol (Arkiv > Öppna > Protokoll). Gå till och välj målprotokoll och klicka
på Open (Öppna).

n Öppna Startup Wizard (Startguide) och gör något av följande:

o Klicka på Edit Selected (Redigera valt) för att redigera protokollet som visas.
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o Klicka på Select Existing (Välj befintligt) och gå till målfilen för att redigera ett annat
befintligt protokoll.

Protokollet öppnas i fönstret Protocol Editor (Protokollredigerare).

2. Välj File > Save As (Arkiv > Spara som) och spara protokollet med ett nytt namn eller i en ny
mapp.

Ställa in ett nytt protokoll
Tips: Om protokollfilen innehåller de nödvändiga parametrarna (t.ex. om du redigerar en befintlig
plattfil) kan du hoppa över det här avsnittet. Gå till Lägga till steg till ett protokoll på sidan 91.

Följande parametrar krävs för nya protokollfiler:

n Block type (Blocktyp)

n Scan mode (Skanningsläge) för vald blocktyp

n Lid temperature (Locktemperatur)

n Sample volume (Provvolym)

Ställa in Block Type (Blocktyp)

CFXManager Dx beräknar automatiskt stegvisa temperaturökningar för gradientsteg baserat på
blocktypen.

Obs! Plattypen som är inställd i Protocol Editor (Protokollredigerare) måste vara densamma som
plattan i reaktionsmodulen.

För att ställa in blocktypen

u I fönstret Protocol Editor (Protokollredigerare) väljer du Tools > Gradient Calculator (Verktyg >
Gradientkalkylator) och väljer lämplig plattyp i den nedrullningsbara listan som visas.

Välja Scan Mode (Skanningsläge) för vald Block Type (Blocktyp)

Välj målets blocktyp och skanningsläge för att bestämma protokollets körtid.

Så här väljer du blocktyp och skanningsläge

u I fönstret Protocol Editor (Protokollredigerare) väljer du Tools > Run time Calculator (Verktyg >
Körtidskalkylator) och väljer lämplig plattyp och skanningsläge i listrutan som visas.

Justera locktemperaturen

CFXManager Dx ställer in standardlocktemperaturen på 105,0 °C.
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Du kan ändra standardinställningarna eller stänga av lockvärmaren enligt vad som krävs för
protokollet.

Tips: Du kan ändra standardlocktemperaturen i dialogrutan User Preferences
(Användarinställningar). Se Ställa in standardprotokollparametrar på sidan 64.

För att justera locktemperaturen

1. I fönstret Plate Editor (Plattredigerare) väljer du Settings > Lid Settings (Inställningar >
Lockinställningar).

Dialogrutan Lid Settings (Lockinställningar) visas.

2. Gör något av följande:

n Välj User Defined (Användardefinierad) och skriv in ett temperaturvärde i textrutan.

n Välj Turn Off Lid Heater (Stäng av lockvärmare).

3. Klicka på OK för att acceptera ändringarna och stänga dialogrutan

Ställa in Sample Volume (Provvolym)

Som standard ställer CFX Manager Dx in provvolymen för varje brunn på 25 µl. Men CFX Dx-system-
intervallet är dock 0–125 µl.

Instrumentet använder ett av två kontrollägen för att bestämma när provet når måltemperaturen i ett
protokoll:

n Calculated mode (Beräknat läge) – när provvolymen är inställd på en volym som är lämplig för
blocket, beräknar instrumentet provtemperaturen baserat på provvolymen. Detta är
standardläget.

n Block mode (Blockläge) – när provvolymen är inställd på noll (0) µl, registrerar instrumentet
provtemperaturen som identisk med den uppmätta blocktemperaturen.

För att ställa in provvolymen för ett specifikt block

u I fönstret Plate Editor (Plattredigerare) ställer du in rätt värde i textrutan Sample Volume
(Provvolym) i verktygsraden.

Tips: Du kan ändra standardprovvolymen i dialogrutan User Preferences
(Användarinställningar). Se Ändra Default File Settings (Standardfilinställningar) på sidan 62.

Lägga till steg till ett protokoll
För att lägga till ett steg till ett protokoll

1. Öppna protokollet i fönstret Protocol Editor (Protokollredigerare).
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2. Bestäm var det nya steget ska infogas. I verktygsraden väljer du Before (Före) eller After (Efter) i
den nedrullningsbara listan Step (Steg).

3. I diagrammet väljer du steget före eller efter vilket du tänker infoga det nya steget.

4. Klicka på Insert Step (Infoga steg) i den vänstra rutan.

5. För att ändra temperaturen eller hålltiden klickar du på standardvärdet i diagrammet eller på
protokollramen och skriver ett nytt värde.

6. (Valfritt) Klicka på Step Options (Stegalternativ) i den vänstra rutan för att visa dialogrutan Step
Options (Stegalternativ) och ändra de tillgängliga alternativen för det valda steget.

Tips: Du kan få åtkomst till dialogrutan Step Options (Stegalternativ) i högerklickmenyn i
antingen diagramrutan eller protokollramrutan.

7. Klicka på OK och sedan på Yes (Ja) för att spara ändringar i protokollet.

Dialogrutan Save As (Spara som) visas

8. Skriv in ett nytt namn för den nya protokollfilen i dialogrutan Save As (Spara som) och klicka på
Save (Spara).

Infoga ett gradientsteg
Så här infogar du ett gradientsteg

1. Kontrollera att plattstorleken för gradienten är densamma som blocktypen för instrumentet, 96-
brunnars.

2. Om inte det har gjorts väljer du plattstorlek för gradienten:

Välj Tools > Gradient Calculator (Verktyg > Gradientkalkylator) och välj lämplig brunnstyp i
listrutan.

3. Välj Before (Före) eller After (Efter) i listrutan Insert Step (Infoga steg) i verktygsraden.

4. Välj steget före eller efter vilket du planerar att infoga gradientsteget i diagram- eller
dispositionsfönstret.

5. Klicka på Insert Gradient (Infoga gradient) i den vänstra rutan. Det nya gradientsteget markeras i
diagram- eller dispositionsfönstret, exempelvis:
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Temperaturen för varje rad i gradienten visas i tabellen Gradient i den högra rutan.

6. Du redigerar gradienttemperatursintervallet genom att göra något av följande:

n Klicka på standardtemperaturen i diagram- eller dispositionsfönstret och ange en ny
temperatur.

n Klicka på Step Options (Stegalternativ) för att komma till gradientintervallet i fönstret Step
Options (Stegalternativ).

n Ändra värdet Range (Område) i tabellen Gradient.

7. Du redigerar hålltiden genom att klicka på standardtiden i grafik- eller textvyn och ange en ny tid.

8. Klicka på OK och sedan på Yes (Ja) för att spara ändringarna.
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Infoga ett GOTO-steg
Obs! Du kan inte infoga ett GOTO-steg inom en GOTO-uppsättning. Du kan inte skapa
inbäddade GOTO-loopar.

Så här infogar du ett GOTO-steg

1. I verktygsraden väljer du Before (Före) eller After (Efter) i listrutan Insert Step (Infoga steg).

2. I diagrammet väljer du steget före eller efter vilket du tänker infoga det nya GOTO-steget.

3. Klicka på Insert GOTO (Infoga GOTO) i den vänstra rutan.

4. För att redigera GOTO-stegnumret eller antalet GOTO-upprepningar väljer du standardnumret i
grafen eller översiktsrutan och anger ett nytt värde.

5. Klicka på OK och sedan på Yes (Ja) för att spara ändringarna.

Infoga ett smältkurvsteg
Tips: Du kan inte infoga ett smältkurvsteg i en GOTO-loop.

Obs! Smältkurvsteget inkluderar ett uppehåll på 30 sek i början av steget som inte visas i
protokollet.

Så här infogar du ett smältkurvsteg

1. I verktygsraden väljer du Before (Före) eller After (Efter) i listrutan Insert Step (Infoga steg).

2. Välj steget före eller efter där du vill infoga smältkurvsteget i diagrammet.
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3. Klicka på Insert Melt Curve (Infoga smältkurva) i den vänstra rutan. Det nya smältkurvsteget
markeras i grafen och översiktsrutan, till exempel:

4. För att ändra smälttemperaturområdet eller ökningstiden väljer du standardnumret i grafen eller
översiktsrutan och anger ett nytt värde.

5. Klicka på OK och sedan på Yes (Ja) för att spara ändringarna.
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Lägga till eller ta bort ett plattavläsningssteg
Tips: När du har lagt till ett plattavläsningskommando i ett steg ändras knappen till Remove Plate
Read (Ta bort plattavläsning) när du väljer ett steg.

Så här lägger du till en plattavläsning i ett steg

1. I verktygsraden väljer du Before (Före) eller After (Efter) i listrutan Insert Step (Infoga steg).

2. I diagrammet väljer du steget före eller efter vilket du tänker infoga plattläsningssteget.

3. Klicka på Add Plate Read to Step (Lägg till plattavläsning till steg) i den vänstra rutan för att lägga
till en plattavläsning för det valda steget.

4. Klicka på OK och sedan på Yes (Ja) för att spara ändringarna.

Så här tar du bort en plattavläsning från ett steg

u Välj steget som innehåller plattavläsningen på grafen och klicka på Remove Plate Read (Ta bort
plattavläsning) i den vänstra rutan.

Ändra stegalternativ
Så här ändrar du stegalternativen för ett valt steg

1. Välj målsteget i diagram- eller dispositionsfönstret.

2. Klicka på Step Options (Stegalternativ) i den vänstra rutan för att öppna dialogrutan Step Options
(Stegalternativ).

Eller högerklicka på målsteget i endera ruta och välj Step Options (Stegalternativ) på menyn som
öppnas.

3. Så här lägger du till, ändrar och tar bort alternativ:

n Ange ett värde i lämplig textruta.

n Redigera ett värde i den specifika textrutan.

n Markera eller avmarkera en kryssruta.

4. Klicka på OK för att spara ändringarna och stänga dialogrutan Step Options (Stegalternativ).

5. Klicka på OK och sedan på Yes (Ja) för att spara protokollet.
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Ta bort ett steg
Så här tar du bort ett steg i protokollet

1. Välj steget i grafen eller översiktsrutan.

2. Klicka på Delete Step (Ta bort steg) i den vänstra rutan för att ta bort det valda steget.

3. Klicka på OK och sedan på Yes (Ja) för att spara protokollet.

Kopiera, exportera eller skriva ut ett protokoll
Så här kopierar du ett protokoll

u Högerklicka på protokolldispositionen och välj Copy Protocol (Kopiera protokoll).

Du kan klistra in dispositionen i en .txt-, .xls-, .doc- eller .ppt-fil.

Så här exporterar du ett protokoll

1. Högerklicka på protokolldispositionen och välj Export Protocol (Exportera protokoll).

Dialogrutan Save As (Spara som) visas.

2. (Valfritt:) Gå till mappen i Utforskaren där du vill spara protokollfilen.

3. I File name (Filnamn) skriver du ett namn på den exporterade protokollfilen.

4. Klicka på Save (Spara).

Så här skriver du ut ett protokoll

u Högerklicka på protokolldispositionen och välj Print (Skriv ut).

Du kan skriva ut protokolldispositionen på din standardskrivare.
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Skapa ett protokoll med Protocol AutoWriter
(Protokollförslag)

Viktigt! Bio-Rad garanterar inte att körning av ett protokoll som skapats med Protocol AutoWriter
(Protokollförslag) alltid resulterar i en realtids-PCR produkt.

Protocol AutoWriter (Protokollförslag) i CFX Manager Dx skapar automatiskt cykling-protokoll
baserade på följande inmatningsparametrar:

n Amplicon length (Amplikonlängd) – förväntad längd på PCR-produkten

n Annealing temperature (Hybridiseringstemperatur) – reaktions-Ta för de primrar som används

Om Ta är okänd, kan du använda Ta calculator (Ta-kalkylator) för att beräkna den automatiskt
baserat på dina primersekvenser.

Obs! Ta justeras från informationen om primerns smälttemperatur (Tm) som baseras på det
valda enzymet och protokollhastigheten.

n Enzyme type (Enzymtyp) – DNA-polymerasenzymet (iTaq™, iProof™ DNA-polymeras, eller
Övrig)

Om du använder ett annat enzym än iTaq eller iProof DNA-polymeras, kan du ange ytterligare
information, inklusive gradientintervall, hot-start-aktiveringstid (i sek), och slutlig förlängningstid (i
sek).

n Run speed (Körningshastighet) – reaktionshastigheten (standard, snabb eller ultrasnabb)

Protocol AutoWriter (Protokollförslag) optimerar protokollet beroende på den valda
hastighetsinställningen. Den totala körningstiden bestäms av antalet steg och cykler,
inkubationstid vid varje steg, och tiden det tar att nå enhetlighet vid måltemperaturen.

Med användning av parametrar som du anger och standardriktlinjer för PCR, skapar Protocol
AutoWriter (Protokollförslag) automatiskt ett anpassat PCR-protokoll med steg för hot start, initial
denaturering, hybridisering och förlängning. Du kan sedan visa en grafisk representation av det
föreslagna protokollet och redigera, köra eller spara protokollet.
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För att skapa ett nytt protokoll med CFX Manager Dx Protocol AutoWriter
(Protokollförslag)

1. I hemfönstret väljer du Tools > Protocol AutoWriter (Verktyg > Protokollförslag).

Dialogrutan Protocol AutoWriter (Protokollförslag) visas.

2. Gör följande i sektionen Enter Target Values/Enzyme (Ange målvärden/enzym):

n Ange annealing temperature (hybridiseringstemperatur) (Ta) för primrar, om den är känd.

Tips: Använda Ta Calculator (Ta-kalkylator) på sidan 100 för mer information.

Obs! För information om beräkningarna som används i Ta Calculator (Ta-kalkylator), se
Breslauer et al. 1986.

n Ange amplicon length (amplikonlängd) i baspar (bp).

n Välj en enzymtyp från listan med alternativ (iTaq™DNA polymerase (DNA-polymeras),
iProof™ DNA polymerase (DNA-polymeras), eller Other (Annan)).

Tips: Om du väljer Other (Annan) som enzymtypen, blir parametrarna i sektionen
Additional Parameters (Optional) (Ytterligare parametrar) (valfritt) aktiva.

Användarhandbok | 99



Kapitel 6 Skapa protokoll

3. Om du valde Other (Annan) som enzymtypen kan du lägga till en eller alla av följande parametrar
till protokollet:

n Gradient range (Gradientintervall)

n Hot start activation temperature (Aktiveringstemperatur för hot start)

n Final extension time (Slutlig förlängningstid)

4. I sektionen Type (Typ), flytta glidreglaget för att välja protokollhastighet (Standard, Fast (Snabb)
eller Ultrafast (Ultrasnabb)). CFX Manager Dx justerar den totala körningstiden.

5. Välj vilken typ av PCR som ska utföras (standard är Real-time PCR (Realtids-PCR)).

Vid real-time PCR (realtids-PCR) lägger CFX Manager Dx till ett plattavläsningssteg för att samla
in fluorescensdata.

6. Granska protokollet i sektionen Preview (Förhandsgranskning). Du kan göra ändringar om det
behövs.

7. Gör något av följande:

n Klicka på OK för att spara det nya protokollet. När protokollet är sparat öppnas det i Startup
Wizard (Startguide). Klicka på Edit Selected (Redigera valt) för att göra eventuella ändringar i
protokollet. Du kan till exempel behöva ändra locktemperaturen och provvolymen.

n Klicka på Cancel (Avbryt) för att stänga fönstret utan att spara protokollet.

Använda Ta Calculator (Ta-kalkylator)
Om hybridiseringstemperaturen för primern är okänd kan du beräkna värdet med hjälp av Ta
Calculator (Ta-kalkylator). Med det värdet kan du skapa protokollet i Protocol AutoWriter
(Protokollförslag) eller Protocol Editor (Protokollredigerare).

Om Ta Calculator (Ta-kalkylator)
Ta Calculator (Ta-kalkylator) beräknar Tm-värdet för varje primer och Ta-värdet för protokollet i
standardhastighet.

Ta för protokollet baseras på de genomsnittliga Tm-primervärdena med följande regler tillämpade:

n Om skillnaden mellan Tm-primervärdena är > 4 °C gäller att Ta = (det lägre av Tm-primervärdena
+ 2) – 4 °C

n Om skillnaden mellan Tm-värdena är ≤ 4 °C gäller att Ta = (genomsnittet av Tm-primervärdena) –
4 °C

100 | Systemen CFX96 Dx och CFX96 DeepWell Dx



Använda Ta Calculator (Ta-kalkylator)

Räkningsmetod för baspar

För varje primer använder Ta Calculator (Ta-kalkylator) räkningsmetoden för baspar för sekvenser av
14 baspar (bp) eller färre.

Tm = ((w*A + x*T) * 2) + ((y*G + z*C) * 4)

där w, x, y och z är numren för baserna A, T, G respektive C i sekvensen.

Metoden Nearest Neighbor

För sekvenser som är längre än 14 bp används metoden nearest neighbor (närmsta granne). I
metoden nearest neighbor (närmsta granne), baseras beräkningarna av smälttemperatur på det
termodynamiska förhållandet mellan entropi (ordning eller ett mått på oligonukleotidens
slumpmässighet), entalpi (värme som frigörs eller absorberas av oligonukleotiden), fri energi och
temperatur.

∆H = ∆G + T* ∆S

där:

n ∆H = Entalpivärde, kal/mol*K

n T = temperatur, Kelvin

n ∆S = Entropivärde, kal/mol*K

n ∆G = Gibbs fria energi i kal/mol*K

Förändringen av entropi och entalpi beräknas direkt genom summering av värdena för nukleotidparen
som visas i Tabell 12 (Breslauer et al. 1986).

Förhållandet mellan den fria energin och koncentrationen av reaktanter och produkter vid ekvilibrium
räknas ut med:

∆G = R*T*ln ((DNA * Primer)/(DNA + Primer))

där R är gaskonstanten (1,986 kal/mol*K).

Om du ersätter G i de två ekvationerna och lösningen med T får du

T = ∆H/(∆S + R*Ln((DNA * Primer)/(DNA + Primer)))

förutsatt att koncentrationen av DNA och DNA-primerkomplex är likvärdig.
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Det har fastställts empiriskt att det sker en förändring på 5 kcal fri energi (3,4 kcal) (Sugimoto et al.
1996) under övergången från ensträngat DNA till B-forms-DNA. Detta är förmodligen spiralens
initieringsenergi. Slutligen, om du lägger till en justering för salt får du ekvationen som används av Ta-
kalkylator:

T = (∆H – 5(kcal/K*mol))/(∆S + (R * ln(1/(primer)))) + 16,6 log10 (SaltMolaritet)

Det behövs ingen justeringskonstant för saltkoncentration, eftersom de olika parametrarna bestämdes
vid 1 M NaCl, och log10 för 1 är noll.

De termodynamiska beräkningarna förutsätter att hybridisering sker vid pH 7,0. Tm-beräkningarna
förutsätter att sekvenserna inte är symmetriska och innehåller minst ett G eller C.

Oligonukleotidsekvensen ska vara minst 14 baser lång för att ge rimliga Tm-värden. Mindre än 14
baser använder basparsräkningsmetoden (se Tabell 12 som följer).

Interaktion ∆H ∆S ∆G

AA TT 9,1 24 1,5

AT TA 8,6 23,9 1,5

AC TG 6,5 17,3 1,3

AG TC 7,8 20,8 1,6

TA AT 6 16,9 0,9

TT AA 9,1 24 1,9

TC AG 5,6 13,5 1,6

TG AC 5,8 12,9 1,9

CA GT 5,8 12,9 1,9

CT GA 7,8 20,8 1,6

CC GG 11 26,6 3,1

CG GC 11,9 27,8 3,6

GA CT 5,6 13,5 1,6

GT CA 6,5 17,3 1,3

Tabell 12. Breslauers interaktionskonstanter
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Interaktion ∆H ∆S ∆G

GC CG 11,1 26,7 3,1

GG CC 11 26,6 3,1

Tabell 12. Breslauers interaktionskonstanter, forts.
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Använda Ta Calculator (Ta-kalkylator)

Så här använder du Ta Calculator (Ta-kalkylator)

1. Gör något av följande för att öppna Ta Calculator (Ta-kalkylator):

n Klicka på Ta Calculator (Ta-kalkylator) om du befinner dig i Protocol AutoWriter
(Protokollförslag).

n Välj Tools > Ta Calculator (Verktyg > Ta-kalkylator) i hemfönstret.

Dialogrutan Ta Calculator (Ta-kalkylator) öppnas.

2. Skriv eller klistra in framåtprimersekvensen i textrutan Forward Primer (Framåtprimer).

Tips: Du kan också använda knapparna A, T, G, C till vänster i dialogrutan för att ange
sekvensen.

3. Skriv eller klistra in den omvända primersekvensen i textrutan Reverse Primer (Omvänd primer)
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4. Klicka på Calculate (Beräkna).

Ta Calculator (Ta-kalkylator) beräknar och visar Tm för varje primer samt genomsnittliga värden
för Tm och Ta, till exempel:

Om det skiljer mer än 4 °C mellan primer-Tm-värden använder Protocol AutoWriter det lägre
primer-Tm-värdet + 2 °C som bas för beräkning av Ta-värdet, som du kan modifiera ytterligare
genom att ändra enzym- och reaktionshastigheten.

Ta Calculator (Ta-kalkylator) genererar en hybridiseringstemperatur för standardhastighet med
iTaq DNA-polymeras. När du använder en annan enzym justerar hastighetsinställningarna
automatiskt Ta.

5. Gör något av följande:

n Klicka på OK om du öppnade Ta Calculator (Ta-kalkylator) från Protocol AutoWriter
(Protokollförslag). Du återgår till Protocol AutoWriter (Protokollförslag).
Hybridiseringstemperaturen ändras automatiskt.

n Om du öppnade Ta Calculator (Ta-kalkylator) från menyn Tools (Verktyg), registrera
beräkningarna och klicka på Cancel (Avbryt) för att stänga kalkylatorn.
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En plattfil innehåller information om körningsparametrar, t.ex. skanningsläge, fluoroforer och
brunnsinnehåll. Efter körningen länkar CFX Manager™ Dx-programmet brunnsinnehållet till de
fluorescensdata som samlats in under körningen och tillämpar lämplig analys i fönstret Data Analysis
(Dataanalys). Exempelvis används brunnar som är laddade med standardprovtyp för att generera en
standardkurva.

CFX Manager Dx-programvara erbjuder två alternativ för att skapa plattor: Plate Editor
(Plattredigerare) för körningar av realtids-PCR och Setup Wizard (Inställningsguide) för analys av
normaliserat genuttryck.

I Plate Editor (Plattredigerare) ingår följande funktioner:

n Standardfluoroforer och provtyper att tilldela till plattbrunnar

n Möjlighet att ställa in referensmål och kontrollprov för genuttrycksanalys

n Möjlighet att redigera plattinställning före, under eller efter en körning

n Möjlighet att spara plattfiler för återanvändning

n Möjlighet att skriva ut plattfilen på en standardskrivare

Setup Wizard (Inställningsguide) vägleder dig genom skapandet av en plattlayout för analys av
normaliserat genuttryck. Setup Wizard (Inställningsguide) kan användas före, under och efter en
körning.
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Fönstret Plate Editor (Plattredigerare)
Du använder Plate Editor (Plattredigerare) för att skapa anpassade plattor eller ändra befintliga
plattor.

1. Menyraden ger snabb åtkomst till kommandona i File (Arkiv) och Settings (Inställningar)
liksom alternativ för plattredigeringsverktyg.

2. Verktygsraden ger snabb åtkomst till viktiga plattladdningsfunktioner.

3. I huvudrutan visas plattans kontur och plattalternativen efterhand som du lägger till dem.

4. I den högra rutan visas alternativ som du använder för att anpassa din platta.

5. I den nedre rutan visas plattypen och du får snabb åtkomst till visningsalternativ.

FÖRKLARING
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Menykommandon för File (Arkiv)
Save (Spara) – sparar plattdatafilen i den plats som anges på fliken File (Arkiv) i dialogrutan User
Preferences (Användarinställningar) Se Ändra Default File Settings (Standardfilinställningar) på
sidan 62 för mer information. Det här menyobjektet är endast tillgängligt när en ny plattfil skapas.

Save As (Spara som) – sparar den öppna plattdatafilen med valfritt nytt namn. Det här menyobjektet
är endast tillgängligt när en ny plattfil skapas.

Extrakt Plate (Extrahera platta) – öppnar en dialogruta där du kan extrahera eller spara plattfilen
(.pltd). Det här menyobjektet är endast tillgängligt när du visar eller redigerar en befintlig plattfil.

Print (Skriv ut) – skriver ut den öppna plattdatafilen.

Close (Stäng) – stänger Plate Editor (Plattredigerare).

Menykommandon för Settings (Inställningar)
Plate Size (Plattstorlek) – ger alternativ för val av plattstorlek för körningen.

Obs! CFX Dx-system kan endast använda en platta med 96 brunnar.

Plate Type (Plattyp) – låter dig välja typ av brunn i plattan som håller proverna – antingen BRWhite
eller BR Clear. För korrekt dataanalys måste plattypen som väljs överensstämmamed plattypen som
används i körningen.

Number Convention (Nummerkonvention) – låter dig markera eller avmarkera alternativet att visa
enheter i vetenskaplig notation. Enheter visas som standard med vetenskaplig notation.

Units (Enheter) – låter dig välja enheter att visa i kalkylbladen när du utför kvantifiering av okända
värden kontra en standardkurva.

Kommandon i menyn Editing Tools (Redigeringsverktyg)
Setup Wizard (Inställningsguide) – öppnar inställningsguiden där du kan definiera layout- och
analysparametrar för den aktuella plattan. Du kan använda Setup Wizard (Inställningsguide) före,
under eller efter en körning.

Spreadsheet View/Importer (Kalkylbladsvy/Importerare) – öppnar dialogrutan View (Visa) där
plattlayouten visas sommall i kalkylbladsformat. I den här dialogrutan kan du exportera och importera
plattmallsdata i .csv-format.

Flip Plate (Vända platta) – vänder plattans innehåll 180o.
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Kommandon i verktygsraden

Sparar den aktuella plattfilen.

Visar en listruta i vilken du kan öka och minska förstoringen av plattvyn.

Visar en listruta i vilken du kan välja ett skanningsläge som instruerar
instrumentet från vilka kanaler det ska samla in fluorescensdata under en
körning.

Öppnar Well Groups Manager (Brunnsgruppshanterare) där du kan skapa
brunnsgrupper för den aktuella plattan.

Öppnar en dialogruta där du kan välja alla färger och symboler för
amplifieringskurvorna.

Öppnar dialogrutan View (Visa) som visar plattlayouten som en mall i
kalkylbladsformat. I den här dialogrutan kan du exportera och importera
plattmallsdata i .csv-format.

Visar de nödvändiga stegen för att konfigurera en platta och ladda
brunnarna.
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Skapa en plattfil med Plate Editor (Plattredigerare)
Det går att skapa anpassade plattfiler i Plate Editor (Plattredigerare). Det går även att redigera och
spara tidigare sparade plattfiler eller provplattfiler som levererats med CFX Manager Dx-programvara.

Gör följande för att skapa en ny plattfil:

n Öppna en plattfil i Plate Editor (Plattredigerare).

n Välj plattyp.

Obs! Plattfilens plattyp måste vara densamma som plattan i reaktionsmodulen.

n Välj skanningsläget som ska användas i protokollet.

n Välj fluoroforerna som ska användas i plattan.

n Välj provtyp, mål och prover.

n Välj om lämpligt replikat.

n Spara plattlayouten.

Tips: Information om hur du skapar en ny platta av tidigare sparade eller provplattfiler finns i
Öppna en befintlig plattfil i Plate Editor (Plattredigerare) på sidan 113.

Öppna en ny plattfil i Plate Editor (Plattredigerare)
CFXManager Dx-programvara erbjuder olika alternativ för öppning av en ny plattfil:

n Från hemfönstret

n Från dialogrutan Startup Wizard (Startguide)

n Från dialogrutan Run Setup (Körningsinställning)

Så här öppnar du en ny plattfil från hemfönstret

u Välj File > New > Plate (Arkiv > Ny >Platta).

Fönstret Plate Editor (Plattredigerare) öppnas och visar standardplattfil för det valda instrumentet.

Tips: Se Ändra Default File Settings (Standardfilinställningar) på sidan 62 för mer
information om hur du ställer in standardfil för platta.
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Så här öppnar du en ny plattfil från Startup Wizard (Startguide)

1. Gör något av följande i hemfönstret för att öppna Startup Wizard (Startguiden) om den inte syns:

n Välj View > Startup Wizard (Visa > Startguide).

n Klicka på Startup Wizard (Startguide) i verktygsraden.

Som standard visar Startup Wizard (Startguide) fliken Run setup (Körningsinställning) med
instrumentet CFX96™ valt.

2. Välj vid behov instrumenttyp från listrutan.

3. Klicka på User-defined (Användardefinierad) som körningstyp för att skapa en ny platta.

Dialogrutan Run Setup (Inställning av körning) öppnas och visar fliken Protocol (Protokoll).

4. Klicka på fliken Plate (Platta) och sedan på Create New (Skapa ny).

Fönstret Plate Editor (Plattredigerare) öppnas och visar standardplattlayout för det valda
instrumentet.

Så här öppnar du en ny plattfil från dialogrutan Run Setup (Inställning av körning)

1. Gör något av följande i hemfönstret för att öppna dialogrutan Run Setup (Körningsinställning):

n Välj Run > User-defined Run (Körning > Användardefinierad körning).

n Klicka på User-defined Run Setup (Användardefinierad körningsinställning) på
verktygsraden.

Dialogrutan Run Setup (Inställning av körning) öppnas och visar fliken Protocol (Protokoll).

2. Klicka på fliken Plate (Platta) och sedan på Create New (Skapa ny) för att skapa en ny platta.

Fönstret Plate Editor (Plattredigerare) öppnas och visar standardplattlayout för det valda
instrumentet.
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Öppna en befintlig plattfil i Plate Editor (Plattredigerare)
CFXManager Dx-programvara tillhandahåller provplattfiler som du kan redigera och spara som en ny
platta. Du kan även skapa en ny plattfil från en tidigare sparad plattfil.

För att öppna en provplattfil

1. Välj File > Open > Plate (Arkiv > Öppna > Platta) i hemfönstret.

Windows Explorer öppnas på platsen för mappen Sample Files (Provfiler) i CFX Manager Dx.

2. Öppna mappen Sample files (Provfiler) och öppna sedan mappen Plates (Plattor).

3. Välj önskad platta och klicka på Open (Öppna).

Provplattfilen öppnas i fönstret Plate Editor (Plattredigerare).

4. Välj File > Save As (Arkiv > Spara som) och spara plattfilen med ett nytt namn eller i en ny mapp.

För att öppna en tidigare sparad plattfil

1. I hemfönstret, Välj File > Open > Plate (Arkiv > Öppna > Platta), gå till och välj målplattan och
klicka på Open (Öppna).

Målplattan öppnas i fönstret Plate Editor (Plattredigerare).

2. Välj File > Save As (Fil > Spara som) och spara plattfilen med ett nytt namn eller i en ny mapp.
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Ställa in en ny plattfil
Tips: Om plattfilen innefattar de nödvändiga parametrarna (t.ex. om du redigerar ett prov eller en
befintlig plattfil) kan du hoppa över det här avsnittet. Gå till Tilldela valfria parametrar till plattfilen
på sidan 120.

Följande parametrar krävs för nya plattfiler:

n Plate Size (Plattstorlek)

n Plate type (Plattyp)

n Scan mode (Skanningsläge)

n En Fluorophore (Fluorofor) (färgämne)

n En Sample type (Provtyp)

Välja typ och storlek för platta

Viktigt! Du måste välja en plattstorlek under plattinställning. Du kan inte ändra plattstorlek under
eller efter en körning.

Programvaran tillämpar plattstorleken och -typen på alla brunnar under körningen. Kontrollera att den
valda plattstorleken överensstämmer med plattan som du kommer att använda i körningen.

Bio-Rad-instrumenten CFX96 och CFX96 DeepWell är fabrikskalibrerade för flera olika
fluorescensfärgs- och plattkombinationer. Kalibreringen är specifik för instrumentet, färg, och typ av
platta. Säkerställ att fluoroforen som du vill använda är kalibrerad för den plattyp du väljer.

Välja skanningsläge

Systemen CFX96 och CFX96 DeepWell exciterar och detekterar fluoroforer i fem kanaler. Alla system
använder flera skanningslägen för datainsamling för att samla in fluorescensdata under en körning.

CFX Manager Dx-programvara har tre skanningslägen:

n All Channels (Alla kanaler)

o Kanalerna 1 till 5 på systemen CFX96 och CFX96 DeepWell skannas

n SYBR® /FAM

o Endast kanal 1 skannas

o Ger snabb skanning

n FRET

o Endast FRET-kanalen skannas

o Ger snabb skanning
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Välja fluoroforer

Viktigt! Innan körningen startas verifierar CFX Manager Dx-programvara att fluoroforerna som
du har angett i plattan är kalibrerade på det instrumentet. Det går inte att köra en platta om den
innehåller fluoroforer som inte har kalibrerats på det instrumentet.

Du måste ladda minst en fluorofor i plattlayouten före körningen. Du kan lägga till så många fluoroforer
som behövs vid denna tidpunkt, men plattan måste innehålla minst en fluorofor. De valda fluoroforerna
visas som alternativ för mål i Target Names (Målnamn).

I dialogrutan Select Fluorophores (Välj fluoroforer) kan du ladda fluoroforer (eller plattfärgämnen) till
reglagen för brunnsladdning i Plate Editor (Plattredigerare). Fluoroforerna som visas i dialogrutan
Select Fluorophores (Välj fluoroforer) beror på vilket skanningsläge som väljs:

n All Channels (Alla kanaler)

Alla tillgängliga fluoroforer visas.

Tips: Du kan lägga till så många fluoroforer som behövs, men det går bara att ladda en
fluorofor per kanal i varje brunn.

n SYBR®/FAM

Endast kanal 1-fluoroforer visas.

n FRET

Endast kanal 6-fluoroforen visas.

Tips: Kanal 6 FRET-fluoroforen visas bara när FRET är det valda skanningsläget. Den är
inte tillgänglig för skanningsläget All Channels (Alla kanaler).

Obs! Det går inte att lägga till eller ta bort fluoroforer direkt i dialogrutan Select Fluorophore (Välj
fluorofor). Du måste kalibrera nya fluoroforer på ett instrument med hjälp av Calibration Wizard
(Kalibreringsguide). Efter kalibreringen läggs den nya fluoroforen automatiskt till i listan.
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Välja provtyper

Viktigt! Du måste välja minst en provtyp att tilldela till plattbrunnarna före körningen.

I CFX Manager Dx-programvara finns fem provtyper:

n Unknown (Okänd)

n Standard

n NTC (ingen mallkontroll)

n Positive Control (Positiv kontroll)

n Negative Control (Negativ kontroll)

n NRT (inget omvänt transkriptas)

Du tilldelar provtyperna till plattbrunnarna.

Konfigurera en ny platta

Så här ställer du in en ny platta

1. Öppna en ny platta i fönstret Plate Editor (Plattredigerare).

2. Du ställer in plattstorlek genom att välja Settings > Plate Size (Inställningar > Plattstorlek) och
välja lämplig plattstorlek i listrutemenyn.

3. Du ställer in plattyp genom att välja Settings > Plate Type (Inställningar > Plattyp) och välja BR
White (BR vit) eller BR Clear (BR transparent) i listrutemenyn.

4. På menyn Settings (Inställningar) kan du ändra siffersystem och visningsenheter:

n Du ändrar siffersystem genom att välja Settings > Number Convention (Inställningar >
Siffersystem) och välja Scientific Notation (Grundpotensform).

Tips: Scientific Notation (Grundpotensform) är valt som standard. Om du väljer
Scientific Notation (Grundpotensform) i det här fallet rensas standardvärdet och
siffersystemet ställs in på standardformen.

n Du ändrar visningsenheter genom att välja Settings > Units (Inställningar > Enheter) och
välja ett nytt enhetsvärde.

5. Du ställer in skanningsläget genom att välja lämpligt skanningsläge i listrutan Scan Mode
(Skanningsläge) i verktygsraden i fönstret Plate Editor (Plattredigerare).
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6. Välj nödvändiga fluoroforer för plattan:

a. Klicka på Select Fluorophores (Välj fluoroforer) i den högra rutan.

Dialogrutan Select Fluorophores (Välj fluroforer) öppnas. Du ser fluoroforerna som är
tillgängliga för typen av skanningsläge som du har valt i Steg 5, till exempel:

b. Du väljer en fluorofor genom att markera dess kryssruta Selected (Vald).

Tips: Avmarkera kryssrutan Selected (Vald) för en fluorofor som du vill ta bort från
listan.

c. Du ändrar visningsfärgen för fluoroforen genom att klicka i dess ruta Color (Färg).

Obs! Färgen som du väljer representerar fluoroforen i fönstret Plate Editor
(Plattredigerare) och i diagram av typen Data Analysis (Dataanalys).

d. I dialogrutan Color (Färg) väljer du önskad färg eller klickar på Define Custom Colors
(Definiera anpassade färger) och skapar en ny färg som ska representera fluoroforen.

e. Klicka på OK för att spara ändringarna och stänga dialogrutan Select Fluorophores (Välj
fluoroforer).
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7. Du måste välja minst en brunn i vilken en provtyp ska laddas. Som standard är brunnen A1 vald.

Gör följande i plattrutan:

n Ladda flera närliggande brunnar genom att klicka på en brunn och dra den till målbrunnen.

n Ladda flera brunnar som inte ligger intill varandra genom att hålla ned Ctrl-tangenten och
klicka på varje brunn.

n Ladda en hel kolumn med samma provtyp genom att klicka på kolumnnumret.

n Ladda en hel rad genom att klicka på radens nummer.

n Ladda hela plattan genom att klicka i det övre vänstra hörnet av plattan.

Exempel:

8. Tilldela en provtyp till vald brunn eller valda brunnar i listrutemenyn Sample Type (Provtyp).
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9. Tilldela minst en fluorofor till alla brunnar som innehåller en provtyp. Det går att tilldela fler än en
fluorofor till en brunn eller grupp av brunnar.

Obs! Det går bara att tilldela en fluorofor per kanal. Det går inte att tilldela fler än en fluorofor
från samma kanal till samma brunn.

Tips: Du kan associera ett mål med fluoroforen eller tilldela endast fluoroforen till brunnen
vid denna tidpunkt och associera ett mål till fluoroforen efter att du har kört experimentet.

n Om du vill tilldela endast en fluorofor till valda brunnar markerar du kryssrutan Load (Ladda)
för den specifika fluoroforen i avsnittet Target Names (Målnamn) i den högra rutan.

n Du associerar ett mål med en fluorofor genom att välja ett målnamn i listrutan för den
specifika fluoroforen i avsnittet Target Names (Målnamn). Programvaran väljer automatiskt
dess kryssruta Load (Ladda).

10. För brunnar som innehåller provtypen Standard måste du ladda en koncentration. Alla brunnar
kan ha olika koncentrationsvärden. Som standard laddar CFX Manager Dx-programvara en
koncentration på 1,00 E + 06 i alla brunnar med provtypen Standard. Det går att ändra värdet vid
behov.

a. Välj en Standard-brunn eller -grupp av brunnar i plattrutan.

b. Klicka på Load (Ladda) i avsnittet Concentration (Koncentration) för att ladda värdet i vald
brunn eller valda brunnar.

c. (Valfritt:) Ladda en annan koncentration genom att ange det nya värdet i textrutan
Concentration (Koncentration) och trycka på Enter-tangenten.

d. Utför det här steget för alla brunnar med provtypen Standard.

Tips: Du laddar samma koncentration i alla Standard-brunnar genom att se till att <All>
(Alla) visas i listrutan under värdet för Concentration (Koncentration). Du laddar samma
koncentrationsvärde i alla brunnar med en viss fluorofor genom att klicka på listrutan och
välja fluoroforen.

11. Klicka på OK för att spara den nya plattan.
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Tilldela valfria parametrar till plattfilen
En plattfil innehåller information om innehållet i varje brunn som är laddad med prov för en körning.
Efter körningen länkar CFX Manager Dx-programvara brunnsinnehållet till de fluorescensdata som
samlats in under protokollet och tillämpar lämplig analys i fönstret Data Analysis (Dataanalys).

I CFX Manager Dx kan du tilldela parametrar till varje brunn i din platta före, under eller till och med
efter det att du kör experiment. Du kan tilldela parametrarna till en befintlig plattfil eller till en ny plattfil.
Dessa parametrar omfattar:

n Target names (Målnamn) – målet eller målen som är av intresse (gener eller sekvenser) i varje
laddad brunn.

n Sample names (Provnamn) – identifieraren eller villkoret sommotsvarar provet i varje laddad
brunn, t.ex. 0Hr, 1Hr, eller 2Hr.

Tips: Namn på mål och provnamn måste vara desammamellan brunnar för att man ska
kunna jämföra data på fliken Gene Expression (Genuttryck) i fönstret Data Analysis
(Dataanalys). Varje namn måste överensstämma när det gäller inledande stor bokstav,
interpunktion och mellanslag. Exempelvis är ”Actin” inte detsamma som ”actin,” ”2Hr” är inte
detsamma som ”2 hr,” och ”Mouse 1” är inte detsamma som ”mouse1.” För att säkerställa
konsekventa namn skriver du in namnen i sektionen Libraries (Bibliotek) i User > User
Preferences > Plate (Användare > Användarinställningar > Platta), som finns i hemfönstret.

n Biological sets (Biologiska uppsättningar) – identifieraren eller villkoret sommotsvarar en
uppsättning brunnar.

n Replicates (Replikat) – varje brunn som används för att analysera samma kombination av prov
och mål; dvs. replikera qPCR-reaktioner.

n Dilution series (Spädningsserie) – mängden som krävs för att ändra koncentrationen av
provtypen Standard inom en replikatgrupp för att skapa standardkurvdata att analysera.

Tilldela ett mål till brunnar
Tips: Du kan tilldela sammamålnamn till en eller flera brunnar. Du kan även tilldela flera mål till
samma brunn.

För att tilldela ett mål till en brunn eller en grupp av brunnar

1. I Plate Editor (Plattredigerare), se till att brunnen eller gruppen av brunnar har tilldelats en
provtyp.

Se Välja provtyper på sidan 116 för information om tilldelning av provtyper till brunnar.

120 | Systemen CFX96 Dx och CFX96 DeepWell Dx



Tilldela valfria parametrar till plattfilen

2. I plattrutan, välj brunnen eller gruppen av brunnar:

n För att välja en enstaka brunn, klicka på brunnen.

n För att välja flera angränsande brunnar, klicka på en brunn och dra till målbrunnen.

n För att välja flera ej angränsande brunnar, håll tangenten Control nedtryckt och klicka på
respektive brunn.

n För att välja en hel kolumn med samma provtyp, klicka på kolumnnumret.

n Klicka på radnumret för att välja en hel rad.

3. I den högra rutan, välj ett namn i den nedrullningsbara listan Target Name (Målnamn) för varje
vald fluorofor.

4. Upprepa Steg 3 för varje brunn eller grupp av brunnar som du måste tilldela ett mål.

Tips: Du kan tilldela samma eller ett annat målnamn för varje vald fluorofor.

5. Klicka på OK för att acceptera ändringarna och spara plattan.

För att ta bort ett målnamn

u För att ta bort ett målnamn från den valda brunnen eller gruppen av brunnar, avmarkerar du dess
kryssruta Load (Ladda).

Viktigt! Borttagning av ett målnamn från en brunn medför att även dess associerade fluorofor tas
bort. Var försiktig när du tar bort ett målnamn från en brunn.

För att lägga till ett målnamn i listan

u För att lägga till ett målnamn i den nedrullningsbara listan gör du något av följande:

n Skriv in ett namn i den nedrullningsbara listan Target Name (Målnamn) och tryck på Enter.

Tips: Målnamn som du lägger till i en lista visas i alla andra mållistor.

n Klicka på den gröna symbolen + till höger om den nedrullningsbara listan, skriv in ett namn
för målet och tryck på Enter.

n Klicka på User Preferences (Användarinställningar) i verktygsraden och lägg till namnet i
biblioteket Target Names (Målnamn) på fliken Plate (Platta).

Användarhandbok | 121



Kapitel 7 Förbereda plattor

Viktigt! Målnamn som du lägger till i den nedrullningsbara listan är endast tillgängliga för den
aktuella plattan, och endast om du tilldelar namnet till en brunn och sparar plattlayouten. Om
du inte tilldelar namnet till en brunn och sparar plattlayouten kommer namnet inte att sparas
och det är inte tillgängligt för framtida användning. För att lägga till ett målnamn permanent
ska du även lägga till det i biblioteket Target Names (Målnamn) med hjälp av dialogrutan
User Preferences (Användarinställningar). Namn som du lägger till i biblioteket är tillgängliga
när du har öppnat Plate Editor (Plattredigerare) igen. Se Ställa in standardplattparametrar på
sidan 65 för mer information.

För att ta bort ett målnamn från listan

1. Klicka på User Preferences (Användarinställningar) i verktygsraden.

Dialogrutan User Preferences (Användarinställningar) öppnas och visar fliken Plate (Platta).

2. Välj namnet du vill ta bort i biblioteket Target Names (Målnamn) på fliken Plate (Platta) och tryck
på tangenten Delete.

3. Klicka på OK för att spara ändringarna och stänga dialogrutan User Preferences
(Användarinställningar).

Viktigt! Du kan inte ta bort målnamn som du har sparat med en plattfil. Anpassade namn
som du lägger till i den nedrullningsbara listan Target Names (Målnamn) och inte använder
och sparar med plattan tas automatiskt bort från listan. Namn som du tar bort från biblioteket
Target Names (Målnamn) tas bort permanent från programmet och är inte längre tillgängliga
för användare. Var försiktig när du tar bort målnamn.

Tilldela ett provnamn till brunnar
Obs! För att tilldela ett provnamn måste du tilldela de valda brunnarna minst en fluorofor. Om de
valda brunnarna inte tilldelats någon fluorofor, avaktiveras den nedrullningsbara listan Sample
Names (Provnamn). Se Tilldela ett mål till brunnar på sidan 120 för information om tilldelning av
fluoroforer.

Tips: Du kan endast tilldela ett provnamn till varje brunn eller grupp av brunnar.

För att tilldela ett provnamn till en brunn eller en grupp av brunnar

1. I Plate Editor (Plattredigerare) säkerställer du att brunnen eller gruppen av brunnar har tilldelats
en fluorofor.

2. I plattrutan väljer du brunnen eller gruppen av brunnar.

3. I den högra rutan, välj ett namn i den nedrullningsbara listan Sample Names (Provnamn).
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4. Upprepa Steg 3 för varje brunn eller grupp av brunnar som du måste tilldela ett provnamn.

5. Klicka på OK för att acceptera ändringarna och spara plattan.

För att ta bort ett provnamn

u För att ta bort ett provnamn från en vald brunn eller grupp av brunnar avmarkerar du dess
kryssruta Load (Ladda).

För att lägga till ett provnamn till listan

u För att lägga till ett provnamn till den nedrullningsbara listan gör du något av följande:

n Skriv in ett namn i den nedrullningsbara listan Sample Names (Provnamn) och tryck på
Enter.

n Klicka på den gröna symbolen + till höger om den nedrullningsbara listan och skriv in ett
namn för provet.

n Klicka på User Preferences (Användarinställningar) i verktygsraden och lägg till namnet i
biblioteket Sample Names (Provnamn) på fliken Plate (Platta).

Viktigt! Provnamn som du lägger till i den nedrullningsbara listan är endast tillgängliga för
den aktuella plattan, och endast om du tilldelar namnet till en brunn och sparar plattlayouten.
Om du inte tilldelar namnet till en brunn och sparar plattlayouten kommer namnet inte att
sparas och det är inte tillgängligt för framtida användning. För att lägga till ett provnamn
permanent ska du även lägga till det i biblioteket Sample Names (Provnamn) med hjälp av
dialogrutan User Preferences (Användarinställningar). Namn som du lägger till i biblioteket är
tillgängliga när du har öppnat Plate Editor (Plattredigerare) igen. Se Ställa in
standardplattparametrar på sidan 65 för mer information.

För att ta bort ett provnamn från listan

1. Klicka på User Preferences (Användarinställningar) i verktygsraden.

Dialogrutan User Preferences (Användarinställningar) öppnas och visar fliken Plate (Platta)

2. Välj namnet du vill ta bort i biblioteket Sample Names (Provnamn) på fliken Plate (Platta) och
tryck på tangenten Delete.
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3. Klicka på OK för att spara ändringarna och stänga dialogrutan User Preferences
(Användarinställningar).

Viktigt! Du kan inte ta bort provnamn som du har sparat med en plattfil. Anpassade namn
som du lägger till i listan Sample Names (Provnamn) och inte använder och sparar med
plattan tas automatiskt bort från den nedrullningsbara listan. Namn som du tar bort från
biblioteket Sample Names (Provnamn) tas bort från programmet och är inte längre
tillgängliga för användare. Var försiktig när du tar bort provnamn.

Tilldela biologiska uppsättningar till brunnar
Obs! För att kunna tilldela en biologisk uppsättning måste du tilldela minst en fluorofor till de valda
brunnarna. När en fluorofor tilldelas aktiveras listrutan Biological Set Name (Namn på biologisk
uppsättning). Information om hur du tilldelar fluoroforer finns i Tilldela ett mål till brunnar på
sidan 120.

Tips: Det går att tilldela en biologisk uppsättning till varje brunn eller grupp av brunnar.

Så här tilldelar du en biologisk uppsättning till en brunn eller grupp av brunnar

1. I alternativen för View (Visa) längst ned i fönstret Plate Editor (Plattredigerare) markerar du
kryssrutan Biological Set (Biologisk uppsättning).

2. I Plate Editor (Plattredigerare) säkerställer du att brunnen eller gruppen av brunnar har tilldelats
en fluorofor.

3. I plattrutan väljer du brunnen eller gruppen av brunnar.

4. I den högra rutan gör du ett val i listrutan Biological Set Name (Namn på biologisk uppsättning).

CFX Manager Dx-programvara väljer automatiskt dess kryssruta Load (Ladda).

5. Upprepa Steg 4 för varje brunn eller grupp av brunnar som du måste tilldela en biologisk
uppsättning.

6. Klicka på OK för att acceptera ändringarna och spara plattan.

Tips: När namn på biologiska uppsättningar tilldelas till brunnar aktiveras Biological Set
Analysis Options (Analysalternativ för biologiska uppsättningar) i dialogrutan Experiment
Settings (Experimentinställningar), där du kan utföra provanalys i en av fyra konfigurationer.
Mer information finns i Ändra Experiment Settings (Experimentinställningar) på sidan 130.
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Så här tar du bort en biologisk uppsättning

u Du tar bort en biologisk uppsättning från vald brunn eller grupp av brunnar genom att rensa dess
kryssruta Load (Ladda).

Så här lägger du till en biologisk uppsättning i listan

u Du lägger till en biologisk uppsättning i listrutan ange ett namn i listrutan Biological Set Name
(Namn på biologisk uppsättning) och tryck på Enter.

Viktigt! Namn på biologiska uppsättningar som du lägger till i listrutan är endast tillgängliga
för den aktuella plattan, och bara om du tilldelar namnet till en brunn och sparar plattlayouten.
Om du inte tilldelar namnet till en brunn och sparar plattlayouten så sparas inte namnet och
är inte tillgängligt för framtida användning.

Så här visar du alla biologiska uppsättningar på plattan

u Markera kryssrutan Biological Set (Biologisk uppsättning) i alternativen för View (Visa) längst ned
i fönstret Editor (Redigerare).

Alla brunnar visar respektive namn på biologisk uppsättning om ett sådant har tilldelats. Reglaget
Biological Set Name (Namn på biologisk uppsättning) visas i den högra rutan.

Du döljer de biologiska uppsättningarna genom att avmarkera kryssrutan Biological Set (Biologisk
uppsättning) i alternativen för View (Visa).

Tilldela replikatnummer till brunnar
Viktigt! För att tilldela replikatnummer måste de valda brunnarna ha ett identiskt innehåll. Det vill
säga att de valda brunnarna måste ha samma provtyp och fluorofor. Om det är tillämpligt måste
de även vara tilldelade sammamål- och provnamn och samma biologiska uppsättning. Om de
inte är identiska aktiverar inte CFX Manager Dx-programvara detta alternativ.

För att tilldela replikatnummer till en grupp brunnar

1. I Plate Editor (Plattredigerare), se till att innehållet i gruppen av brunnar är identiskt.

2. Välj målgruppen av brunnar i plattrutan.

3. För att tilldela samma replikatnummer till alla valda brunnar skriver du in replikatnumret i rutan i
sektionen Replicate # (Replikatnummer) till höger och väljer Load (Ladda).
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4. (Valfritt) För att tillämpa en replikatserie på en uppsättning valda brunnar:

a. Klicka på Replicate Series (Replikatserie). Sektionen Replicate # (Replikatnummer) ändras
så att den visar följande alternativ:

n Replicate size (Replikatstorlek) – ett nummer som representerar antalet brunnar i varje
grupp av replikat

n Starting replicate # (Startreplikatnummer) – det första numret i replikatserien för den
valda gruppen av replikat

Obs! Som standard visar CFX Manager Dx-programvara startreplikatnumret som ett
nummer större än det sista replikatnumret som tilldelats i plattan. Om till exempel det
sista replikatnumret i plattan är fem, så är nästa startnummer sex. Du kan ändra
startnumret till vilket nummer som helst som inte redan är tilldelat.

n Laddningsriktning (Horizontal (Horisontell) eller Vertical (Vertikal))

b. Klicka på Apply (Använd) för att tillämpa parametrarna på serien och återgå till visningen av
Replicate # (Replikatnummer).

5. Klicka på OK för att acceptera ändringarna och spara plattan.

För att ta bort en brunn från en replikatserie

u Välj brunnen eller gruppen av brunnar som ska tas bort och avmarkera kryssrutan Replicate #
Load (Replikatnummerladdning).

Alternativt kan du klicka på Clear Replicate # (Rensa replikatnummer) för att rensa replikatnumret
från en vald brunn eller grupp av brunnar.
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Tilldela en spädningsserie till standardprovtyper
Som tidigare nämnts måste alla brunnar med provtypen Standard tilldelas ett koncentrationsvärde. Du
kan tilldela en spädningsserie till flera brunnar med provtypen Standard.

Obs! För att tilldela en spädningsserie till en grupp av brunnar måste brunnarna vara inkluderade
i en replikatserie. Se Tilldela replikatnummer till brunnar på sidan 125 för information om
tilldelning av brunnar i replikatserier.

Så här tilldelar du en spädningsserie till en grupp provbrunnar av typen Standard

1. Kontrollera att följande villkor är uppfyllda i Plate Editor (Plattredigerare):

n Provtypen för brunnsgruppen är Standard.

n Alla brunnar i gruppen tilldelas minst en fluorofor och alla brunnar innehåller samma
fluoroforer.

n Alla brunnar i gruppen inkluderas i samma replikatserie.

Obs! CFXManager Dx-programvara aktiverar alternativet Dilution Series
(Spädningsserie) först när alla valda brunnar uppfyller dessa kriterier.

2. Välj målgruppen av brunnar i plattrutan.

3. Klicka på Dilution Series (Spädningsserie) i sektionen Concentration (Koncentration) i den högra
rutan. Sektionen Concentration (Koncentration) ändras så att den visar följande alternativ:

n Starting concentration (Startkoncentration) – koncentrationsvärdet från vilket serien utgår

n Replicates from and to (Replikat från och till) – replikat i serien på vilka spädningsfaktorn
kommer att tillämpas

n Dilution factor (Spädningsfaktor) – mängden för ändring av koncentrationen inom varje
replikatgrupp

4. Ange värden för alternativen eller använd standardvärden.
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5. Spädningsserien minskar som standard med spädningsfaktorn. Välj Increasing (Ökande) för att
öka spädningsserien.

6. (Tillval) Spädningsfaktorn tillämpas som standard på alla fluoroforer i replikatserien. Om serien
innehåller fler än en fluorofor och du vill använda spädningen på en enskild fluorofor väljer du den
i listrutan.

7. Klicka på Apply (Använd) för att tillämpa spädningsserien på brunnsgruppen och återgå till vyn
Concentration (Koncentration).

8. Klicka på OK för att acceptera ändringarna och spara plattan.

Kopiera innehåll i en brunn till en annan brunn
Du kan kopiera innehållet i en brunn och klistra in det i en eller flera brunnar. Du kan dock kopiera
innehållet i endast en brunn. Du kan inte välja flera brunnar och kopiera deras innehåll.

Så här kopierar du innehåll i en brunn till en annan brunn

1. Välj brunnen som ska kopieras i plattrutan.

2. Högerklicka på brunnen och välj Copy Well (Kopiera brunn).

3. Välj brunnen eller brunnarna där innehållet ska klistras in:

n För att välja en enstaka brunn, klicka på brunnen.

n För att välja flera angränsande brunnar, klicka på en brunn och dra till målbrunnen.

n För att välja flera ej angränsande brunnar, håll tangenten Control nedtryckt och klicka på
respektive brunn.

4. Se till att målbrunnarna är markerade, högerklicka och välj Paste Well (Klistra in brunn).

CFX Manager Dx-programvara klistrar in den första brunnens innehåll i de markerade brunnarna.

Lägga till en kommentar till en brunn
Du kan lägga till en beskrivande kommentar till en brunn. Du kan se anteckningarna för brunnar på
fliken Quantification (Kvantifiering) i fönstret Data Analysis (Dataanalys).

Så här lägger du till en kommentar till en brunn

1. Gå till plattrutan och välj brunnen eller brunnarna där en kommentar ska läggas till.

2. Välj Well Note (Brunnskommentar) i sektionen View (Visa) i den undre rutan.

Området Well Note (Brunnskommentar) visas i den högra rutan.
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3. Skriv in innehållet för kommentar i textrutan och tryck på Retur.

Texten visas längst ned i de valda brunnarna.

Tips: Om du tidigare skapade en kommentar för en brunn kan du välja den i listrutan och
använda den för valda brunnar.

Rensa brunnar på allt innehåll
Du kan rensa en enskild brunn, en grupp av brunnar eller allt innehåll från en platta. Vid rengöring av
brunnar tas inte fluorecensdata som har samlats in under plattläsningen bort.

Om du rensar en brunn försvinner dess innehåll permanent. Var försiktig när du rensar brunnar.

Så här rensar du alla brunnsinställningar

1. I Plate Editor (Plattredigerare) väljer du brunnen eller gruppen av brunnar i plattrutan:

n För att välja en enstaka brunn, klicka på brunnen.

n För att välja flera angränsande brunnar, klicka på en brunn och dra till målbrunnen.

n För att välja flera ej angränsande brunnar, håll tangenten Control nedtryckt och klicka på
respektive brunn.

n För att välja en hel kolumn med samma provtyp, klicka på kolumnnumret.

n Klicka på radnumret för att välja en hel rad.

2. Klicka på Clear Wells (Rensa brunnar) i den högra rutan.

CFX Manager Dx-programvara rensar alla inställningar för valda brunnar.

3. Klicka på OK för att acceptera ändringarna och spara plattan.
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Ändra Experiment Settings (Experimentinställningar)
Använd dialogrutan Experiment Settings (Experimentinställningar) för att visa eller ändra listan över
mål eller prover, eller för att ange analysgrupp för genuttryck och analysalternativ om du har tilldelat
biologiska uppsättningar till brunnar i plattan.

I dialogrutan Experiment Settings (Experimentinställningar) visar fliken Targets (Mål) en lista med
målnamn för varje PCR-reaktion, till exempel målgenen eller gensekvenser av intresse.

Fliken Samples (Prover och biologiska grupper) visar en lista med namn på prover som anger målets
källa, till exempel ett prov som tagits efter en timme (1Hr) eller från en specifik individ (mouse1).

Så här ändrar du plattinställningar med dialogrutan Experiment Settings
(Experimentinställningar)

1. Gör något av följande för att öppna dialogrutan Experiment Settings (Experimentinställningar):

n Klicka på Experiment Settings (Experimentinställningar) i den högra rutan i Plate Editor
(Plattredigerare).

n Klicka på Experiment Settings (Experimentinställningar) på fliken Gene Expression
(Genuttryck) i fönstret Data Analysis (Dataanalys).

Dialogrutan Experiment Settings (Experimentinställningar) visas med fliken Targets (Mål).
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2. För att lägga till ett nytt mål eller prov går du till respektive flik och skriver ett namn i textrutan New
(Ny) och klickar på Add (Lägg till).

3. För att ta bort ett eller flera namn för mål eller prov från listan går du till respektive flik och
markerar objektets kryssruta i kolumnen Select to Remove (Markera för att ta bort) och klickar på
Remove checked item(s) (Ta bort markerade objekt).

4. CFX Manager Dx-programvara exkluderar provtypen NTC (ingen mallkontroll) från analys av
genuttryck.

För att inkludera NTC-provtyper avmarkerar du motsvarande kryssruta i sektionen Exclude the
following sample types (Uteslut följande provtyper). Du kan utesluta följande provtyper genom att
markera motsvarande kryssruta:

n NRT (inget omvänt transkriptas)

n Negative Control (Negativ kontroll)

n Positive Control (Positiv kontroll)

n Standard

5. På fliken Targets (Mål):

a. För att välja ett mål som referens för dataanalys av genuttryck väljer du det i kolumnen
Reference (Referens).

b. Rensa Show Analysis Settings (Visa analysinställningar) om du vill dölja analysinställningar
som ska tillämpas på fliken Gene Expression (Genuttryck) i fönstret Analysis Settings
(Analysinställningar).

Programvaran döljer följande kolumner:

n Color (Färg)

n Show Chart (Visa tabell)

n Auto Efficiency (Automatisk effektivitet)

n Effektivitet (%)

c. För att ändra färgen på målet så som det visas i diagrammet Gene Expression (Genuttryck)
väljer du en ny färg i dialogrutan Color (Färg) som visas och klickar på OK.

d. För att visa målet i vald färg i diagrammet Gene Expression (Genuttryck) markerar du
motsvarande kryssruta i kolumnen Show Chart (Visa diagram).

e. Som standard beräknar CFX Manager Dx automatiskt den relativa effektiviteten för ett mål
om dess data inkluderar en standardkurva.
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För att använda ett tidigare fastställt effektivitetsvärde skriver du in värdet i motsvarande cell i
kolumnen Efficiency (%) (Effektivitet) och trycker på Retur. CFX Manager Dx avmarkerar
kryssrutan Auto Efficiency (Automatisk effektivitet).

6. På fliken Samples (Prover och biologiska grupper):

a. För att välja ett prov som kontrollprov för dataanalys av genuttryck markerar du motsvarande
kryssruta i kolumnen Control (Kontroll).

b. För att tilldela kontrollvillkoret till ett prov för en körning markerar du motsvarande kryssruta i
kolumnen Control (Kontroll).

c. Om det här alternativet inte redan är valt klickar du på Show Analysis Settings (Visa
analysinställningar) för att visa eller ändra analysparametrar som ska tillämpas på fliken
Gene Expression (Genuttryck). Programvaran döljer kolumnerna Color (Färg) och Show
Chart (Visa diagram).

7. Om du har tilldelat en eller flera biologiska uppsättningar till brunnar i plattan (se Tilldela biologiska
uppsättningar till brunnar på sidan 124), väljer du ett av följande alternativ på listan visas listan
Biological Set Analysis Options (Analysalternativ för biologisk uppsättning).

n Target vs. Sample (Mål kontra prov) – endast brunnens provnamn används för beräkning
av genuttryck.

n Target vs. Biological Set (Mål kontra biologisk uppsättning) – endast namnet för den
biologiska uppsättningen används i beräkningarna.

n Target vs. Sample_Biological Set (Mål kontra biologisk provuppsättning) – provnamnet
och namnet på den biologiska uppsättningen kombineras och skapar ett enda namn som
används i beräkningarna.

n Target vs. Biological Set_Sample (Mål kontra biologisk provuppsättning) – provnamnet
och namnet på den biologiska uppsättningen kombineras och skapar ett enda namn som
används i beräkningarna.

8. Klicka på OK för att spara parametrarna i dialogrutan Experiment Settings
(Experimentinställningar) och återgå till fönstret Plate Editor (Plattredigerare).

Skapa brunnsgrupper
Brunnsgrupper delar upp en enskild platta i undergrupper av brunnar som kan analyseras separat i
fönstret Data Analysis (Dataanalys). När du har konfigurerat brunnsgrupper, välj en av dem i fönstret
Data Analysis (Dataanalys) för att analysera uppgifterna som fristående grupp. Du kan till exempel
konfigurera brunnsgrupper för att analysera flera experimentkörningar i en platta eller analysera varje
brunnsgrupp med en egen standardkurva.
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Obs! Standardbrunnsgruppen är All Wells (Alla brunnar).

Så här skapar du brunnsgrupper

1. Gör något av följande för att öppnaWell Groups Manager (Brunnsgruppshanterare):

n Klicka påWell Groups (Brunnsgrupper) i verktygsraden Plate Editor (Plattredigerare).

n Klicka på ManageWell Groups (Hantera brunnsgrupper) i fönstret Data Analysis
(Dataanalys).

Dialogrutan Well Groups Manager (Brunnsgruppshanterare) visas.

2. Klicka på Add (Lägg till) för att skapa en ny grupp. Listrutan visar gruppnamnet som Group 1
(Grupp 1) för den första gruppen.

3. Välj brunnar för brunnsgruppen i plattvyn genom att klicka dra över brunnsgruppen. Valda
brunnar visas i blått i Hanteraren.

4. (Valfritt) För att ändra namnet på gruppen väljer du dess namn i listrutan och skriver in ett nytt
namn.

5. (Valfritt) För att ta bort en brunnsgrupp väljer du dess namn i listrutan och klickar på Delete (Ta
bort).
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6. Klicka på OK för att avsluta och stänga fönstret, eller klicka på Cancel (Avbryt) för att stänga
fönstret utan ändringar.

Viktigt! För att visa brunnsgrupper väljer du Well Groups (Brunnsgrupper) i alternativen för View
(Visa) längst ned i fönstret Plate Editor (Plattredigerare).
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Objekt på högerklicksmenyn i dialogrutan Well Groups Manager
(Brunnsgruppshanterare)

I Tabell 13 listas menyobjekten som är tillgängliga i dialogrutan Well Groups Manager
(Brunnsgruppshanterare) när du högerklickar på en brunn.

Objekt Funktion

Copy (Kopiera) Brunnsinnehållen kopieras och sedan kan de klistras in i
en annan brunn eller brunnar.

Copy as Image (Kopiera som
bild)

Kopierar vyn för brunnsväljare som en bild.

Print (Skriv ut) Skriver ut vyn för brunnsväljare.

Print Selection (Skriv ut
markering)

Endast valda celler skrivs ut.

Export to Excel (Exportera till
Excel)

Exporterar data till ett Excel-kalkylblad.

Export to Csv (Exportera till
Csv)

Exporterar data som ett kommaseparerat dokument.

Export to Xml (Exportera till
Xml)

Exporterar data som ett .xml-dokument.

Export to Html (Exportera till
Html)

Exporterar datan som ett .html-dokument.

Tabell 13. Objekt på högerklicksmenyn i dialogrutan Plate Editor Well Selector
(Plattredigerare Brunnsväljare)
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Ändra kurvutseenden
Du kan ändra färg och utseende på amplifieringskurvorna under plattinställning och under en körning.
Du kan sedan enkelt se kurvorna i realtidsstatusfönstret när data hämtas in.

Så här ändrar du kurvutseenden

1. Klicka på Trace Styles (Kurvutseenden) i verktygsraden Plate Editor (Plattredigerare).

Dialogrutan Trace Styles (Kurvutseenden) för den öppna plattan visas, till exempel:

2. För att visa kurvutseenden per specifik fluorofor väljer du den i listrutan Fluorophores
(Fluoroforer).

3. Så här ändrar du kurvvisningen:

a. Välj kurvtyp i listrutan Wells (Brunnar).

b. Klicka på dess färg i kolumnen Color (Färg).

c. Välj en annan färg för kurvan i dialogrutan Color (Färg) som visas och klicka på OK.

Ändringen av brunnstyp visas i rutnätet nedan.

d. (Valfritt) Välj en symbol för kurvan i listrutan Symbols (Symboler).

4. För att snabbt ändra färguppsättning klickar du på önskat alternativ i sektionen Color Quick Set
(Snabbfärginställning).

5. Välj önskad etikettyp i sektionen Well Labels (Brunnsetiketter) för att visa brunnsetiketter i
rutnätet.

6. Klicka på OK för att spara ändringarna eller på Cancel (Avbryt) om du inte vill spara ändringarna.
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Visa plattan i kalkylbladsformat
Verktyget Spreadsheet View/Importer (Kalkylbladsvy/Importerare) visar innehållet i en platta i
kalkylbladsformat. I verktyget Spreadsheet View/Importer (Kalkylbladsvy/Importerare) går det att
exportera brunnsinnehåll i tabbavgränsat format till ett program, t.ex. Microsoft Excel. Det går även att
importera brunnsinnehåll från en tabbavgränsad applikation.

Så här använder du verktyget Spreadsheet View/Importer (Kalkylbladsvy/Importerare)

1. I verktygsfältet i Plate Editor (Plattredigerare) klickar du på Spreadsheet View/Importer
(Kalkylbladsvy/Importerare) för att öppna dialogrutan Plate Spreadsheet View (Kalkylbladsvy för
platta).

2. Dialogrutan Spreadsheet View (Kalkylbladsvy) visar innehållen i plattan för en enskild fluorofor.
Du visar plattinnehållen för en annan fluorofor genom att välja den i listrutan Fluors List
(Fluoroforlista).

3. Klicka på Export Template (Exportera mall) för att exportera en mall av plattans kalkylblad till en
Excel-fil (.csv-format). Du kan redigera mallen och importera information om brunnsinnehåll.

4. (Valfritt:) Klicka på Import (Importera) för att importera brunnsinnehåll från en kommaseparerad
fil.

5. Du sorterar kalkylbladet enligt data i en viss kolumn genom att klicka på triangeln bredvid
kolumnens namn.

Tips: Det går att redigera innehållet i alla celler i en kolumn med asterisk (*) bredvid
kolumnnamnet (till exempel *Target Name (Målnamn)).
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Obs! Välj enheterna för standardkurvdata i kolumnen Quantity (Kvantitet) genom att öppna Plate
Editor (Plattredigerare) och välja Settings > Units (Inställningar > Enheter) på menyraden. När
plattkörningen är klar visas data från dessa standarder i diagrammet Standard Curve
(Standardkurva) på fliken Quantification (Kvantifiering) i fönstret Data Analysis (Dataanalys) med
enheterna du väljer.

Objekt på högerklicksmenyn i verktyget Spreadsheet View/Importer
(Kalkylbladsvy/Importerare) för plattor

I Tabell 14 listas menyobjekten som är tillgängliga i verktyget Spreadsheet View/Importer
(Kalkylbladsvy/Importerare) när du högerklickar på en brunn i verktyget.

Objekt Funktion

Copy (Kopiera) Hela kalkylbladet kopieras.

Copy as Image
(Kopiera som bild)

Kalkylbladet kopieras som en bildfil.

Print (Skriv ut) Kalkylbladet skrivs ut.

Print Selection (Skriv ut
markering)

Endast valda celler skrivs ut.

Export to Excel
(Exportera till Excel)

Filen exporteras till ett Excel-kalkylblad.

Export to CSV
(Exportera till CSV)

Filen exporteras som en .csv-fil.

Export to Xml
(Exportera till Xml)

Filen exporteras som en .xml-fil.

Export to Html
(Exportera till Html)

Filen exporteras som en .html-fil.

Find (Sök) Den specifika texten söks.

Sort (Sortera) Kalkylbladet sorteras genom att du väljer upp till tre kolumner i
fönstret Sort (Sortera).

Tabell 14. Objekt på högerklicksmenyn i verktyget Spreadsheet View/Importer
(Kalkylbladsvy/Importerare) för plattor
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Skapa en plattlayout med användning av Setup Wizard
(Inställningsguide) för plattor

Du kan använda Setup Wizard (Inställningsguide) för att ange plattlayoutinformationen som behövs
för analys av normaliserat genuttryck, inklusive:

n Målnamn

n Provnamn

n Placering av mål och prover på plattan

n Referensgen(er)

n Kontrollprov

Setup Wizard (Inställningsguide) kan användas före, under och efter en körning.

Använda Setup Wizard (Inställningsguide) för plattor
I det här avsnittet beskrivs hur du skapar en plattlayout i Setup Wizard (Inställningsguide). För att
lättare se innehållet i varje brunn i plattan klickar du på Zoom plate (Zooma in platta) högst upp i Setup
Wizard (Inställningsguide).

Viktigt! Om du återgår till fliken Auto layout (Automatisk layout) från en annan flik i Setup Wizard
(Inställningsguide) återställs plattlayouten. Var försiktig när du väljer den fliken.

Tips: Du återställer layouten genom att välja Tools > Clear Plate (Verktyg > Rensa platta) i Setup
Wizard (Inställningsguide).

Så här använder du Setup Wizard (Inställningsguide) för plattor

1. Öppna Plate Editor (Plattredigerare).

2. Öppna Setup Wizard (Inställningsguide) genom att välja Editing Tools > Setup Wizard
(Redigeringsverktyg > Inställningsguide).

Setup Wizard (Inställningsguide) visas med fliken Auto layout (Automatisk layout).
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3. Gör följande på fliken Auto layout (Automatisk layout):

a. Klicka på en brunn i rutnätet och dra den över och ned för att ange området på plattan där du
planerar att ladda provet.

b. Ange antalet mål och prover som ska laddas.

Tips: Antalet mål och prover måste motsvara antalet valda celler. Om inte de angivna
antalen passar i det valda området ändrar du antalen eller plattvalsområdet.
Orienteringen av objekten på plattan och deras gruppering kan specificeras.

c. (Valfritt:) Ändra plattorienteringen. Du kan till exempel ställa in mål i kolumner och prover i
rader, eller gruppera efter prover.

d. Klicka på Next (Nästa) för att gå vidare till fliken Target names (Målnamn).

Obs! Om inte plattlayouten har ett vanligt mönster placerar du målen manuellt på fliken
Target names (Målnamn) eller placerar proverna manuellt på fliken Sample names
(Provnamn) på plattan. Klicka och dra för att välja flera brunnar.

4. På fliken Target names (Målnamn) anger du namnen på målgrupperna:

a. Gör något av följande:

n Ställ in Select by (Välj efter) på Target (Mål) för att byta namn på målen efter grupp.

n Ställ in Select by (Välj efter) på Well (Brunn) för att byta namn på målen efter brunn.

b. Välj en målgrupp eller -brunn i rutnätet och ange ett namn i listrutan Target name (Målnamn).
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Tips: Tryck på Tabb för att välja nästa grupp eller brunn till höger, eller på Enter för att
välja nästa grupp eller brunn nedanför. Eller håll ned Ctrl-tangenten (på flikarna Target
name (Målnamn) och Sample name (Provnamn)) och klicka på en brunn i taget för att
välja flera brunnar som inte ligger intill varandra.

c. Klicka på Next (Nästa) för att gå vidare till fliken Sample names (Provnamn).

5. Definiera provnamnen för provgrupperna på fliken Sample names (Provnamn).

6. Klicka på Next (Nästa) för att gå vidare till fliken Reference targets (Referensmål).

7. På fliken Reference targets (Referensmål) väljer du ett eller flera mål som ska användas som
referenser för normaliserat genuttryck och klickar på Next (Nästa) för att gå vidare till fliken
Control sample (Kontrollprov).

8. På fliken Control sample (Kontrollprov) väljer du ett prov som ska användas som en kontroll för
beräkningar av relativa genuttryck.

9. Klicka på OK för att spara plattlayouten och återgå till Plate Editor (Plattredigerare) där du kan
definiera plattparametrarna ytterligare. Mer information finns i Tilldela valfria parametrar till
plattfilen på sidan 120.

Eller klicka på Previous (Föregående) för att återgå till en föregående flik och göra ändringar.

Obs! Om du återgår till fliken Auto layout (Automatisk layout) återställs plattlayouten
automatiskt. Var försiktig när du klickar på Previous (Föregående).
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Kapitel 8 Köra experiment
I det här kapitlet beskrivs hur du kör anpassade (användardefinierade) eller PrimePCR™-
analysexperiment med programvaran CFX Manager™ Dx.

En körningsdatafil innehåller protokoll- och plattinformation för körningen. Filen innehåller också data
från analyserna som CFXManager Dx utför efter avslutad körning.

CFX Manager Dx-programvaran gör det enkelt att konfigurera och köra användardefinierade eller
PrimePCR-baserade experiment. Fönstret Run Setup (Inställning av körning) vägleder dig genom
gemensamma steg för konfiguration av experiment och vidarebefordrar dig till dialogrutan Start Run
(Starta körning) där du påbörjar körningen.

Åtkomst till fönstret Run Setup (Körningsinställning)
För att få åtkomst till fönstret Run Setup (Körningsinställning)

u Gör något av följande:

n På fliken Run Setup (Körningsinställning) i Startup Wizard (Startguide) klickar du antingen på
User-defined (Användardefinierad) eller PrimePCR.

n I hemfönstret klickar du antingen på User-defined Run Setup (Användardefinierad
körningsinställning) eller PrimePCR Run Setup (PrimePCR-körningsinställning) i
verktygsraden.

n I hemfönstret väljer du antingen Run > User-defined Run (Körning > Användardefinierad
körning) eller Run > PrimePCR Run (Körning > PrimePCR-körning).
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Fönstret Run Setup (Körningsinställningar)
Fönstret Run Setup (Körningsinställningar) ger snabb åtkomst till filerna och inställningarna som
behövs för att konfigurera och köra ett experiment. När du väljer att köra ett användardefinierat
experiment öppnas fönstret Run Setup (Körningsinställningar) med fliken Protocol (Protokoll). När du
väljer att köra ett PrimePCR-experiment öppnas fönstret Run Setup (Körningsinställningar) med fliken
Start run (Starta körning).

Tips: Information om PrimePCR finns i Utföra PrimePCR-experiment på sidan 162 och
information om fliken Start Run (Starta körning) finns i Fliken Start Run (Starta körning) på
sidan 152.
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1. Följande flikar vägleder dig genom konfigurationen och körningen av ett
experiment:

n Fliken Protocol (Protokoll) – välj ett befintligt protokoll att köra eller redigera,
eller skapa ett nytt protokoll i Protocol Editor (Protokollredigerare).

n Fliken Plate (Platta) – välj en befintlig platta att köra eller redigera, eller skapa
en ny platta i Plate Editor (Plattredigerare).

n Fliken Start Run (Starta körning) – visa experimentinställningarna, välj ett eller
fler instrumentblock och starta körningen.

2. Huvudfönstret visar alternativen för varje flik när du använder dem.

3. Navigeringsknappar som leder till fliken Start Run (Starta körning).

FÖRKLARING
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Fliken Protocol (Protokoll)
På fliken Protocol (Protokoll) visas en förhandsgranskning av protokollfilen som du planerar att köra.
En protokollfil innehåller instruktioner för instrumentets temperatursteg och instrumentalternativ som
styr ramphastigheten, provvolymen och lockets temperatur.

Som standard visar programvaran det protokoll som har definierats i avsnittet File Selection for Run
Setup (Filval för körningsinställningar) på fliken Files i dialogrutan User > User Preferences
(Användare > Användarinställningar). Du ändrar standardprotokollet i dialogrutan User Preferences
(Användarinställningar). Se Ändra Default File Settings (Standardfilinställningar) på sidan 62 för mer
information.

På fliken Protocol (Protokoll) kan du:

n Ska ett nytt protokoll att köra

n Välja ett befintligt protokoll att köra eller redigera

Mer information om att skapa och ändra protokoll finns i Kapitel 6, Skapa protokoll.
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Så här skapar du ett nytt protokoll

1. Klicka på Create New (Skapa ny) på fliken Protocol (Protokoll).

Protocol Editor (Protokollredigerare) öppnas.

2. Skapa ett nytt protokoll i Protocol Editor (Protokollredigerare).

3. Klicka på OK för att spara protokollet och återgå till fliken Protocol (Protokoll) i Run Setup
(Körningsinställningar).

4. Visa information om protokollet och gör något av följande:

n Om informationen är korrekt klickar du på Next (Nästa) för att gå vidare till fliken Plate
(Platta).

n Om informationen är felaktig klickar du på Edit Selected (Redigera valda) för att återgå till
fönstret Protocol Editor (Protokollredigerare). Revidera protokollet, spara ändringarna och
klicka på Next (Nästa) på fliken Protocol (Protokoll) för att gå vidare till fliken Plate (Platta).

Så här väljer du ett befintligt protokoll

1. Gör något av följande på fliken Protocol (Protokoll):

n Klicka på Select Existing (Välj befintlig) och gå till ett befintligt protokoll.

n Klicka på Express Load (Expressladdning) och välj ett protokoll i listrutan för protokoll.

Tips: Det går att lägga till protokoll i och ta bort dem från listrutan Express Load
(Expressladdning). Mer information finns i Lägga till och ta bort protokoll för
expressladdning som följer.

2. Visa information om protokollet och gör något av följande:

n Om informationen är korrekt klickar du på Next (Nästa) för att gå vidare till fliken Plate
(Platta).

n Om informationen är felaktig klickar du på Edit Selected (Redigera valda) för att öppna
Protocol Editor (Protokollredigerare). Revidera protokollet, spara ändringarna och klicka på
Next (Nästa) på fliken Protocol (Protokoll) för att gå vidare till fliken Plate (Platta).
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Lägga till och ta bort protokoll för expressladdning

Du kan ändra innehållet i den nedrullningsbara listan Express Load (Expressladdning) som finns i
Protocol Editor (Protokollredigerare). Protokollen i den här listan sparas i följande mapp:

c:\Users\Public\Documents\Bio-Rad\CFX\Users\<user_name>\ExpressLoad\

För att ändra listan Express Load (Expressladdning) med protokoll

1. Gå till och öppna mappen Express Load (Expressladdning).

2. Granska protokollfilerna (.pcrl) i mappen.

3. Gör något av följande:

n Radera protokoll från mappen för att ta bort dem från den nedrullningsbara listan.

n Kopiera protokoll till mappen för att lägga till dem i den nedrullningsbara listan.

148 | Systemen CFX96 Dx och CFX96 DeepWell Dx



Fliken Plate (Platta)

Fliken Plate (Platta)
Obs! Om protokollet som väljs på fliken Protocol (Protokoll) inte har ett plattläsningssteg för
realtidsbaserad PCR-analys är fliken Plate (Platta) dold. Lägg till minst en plattläsning i protokollet
för att visa fliken Plate (Platta).

Fliken Plate (Platta) ger en förhandsvisning av plattfilen som du planerar att läsa in. Vid en
realtidsbaserad PCR-körning innehåller plattfilen en beskrivning av innehållet för varje brunn,
inklusive dess fluoroforer, skanningsläge och typ av platta. CFX Manager Dx-programvaran använder
dessa beskrivningar för insamling och analys av data.

Som standard visar programvaran plattan som är definierad i sektionen File Selection för Run Setup
(Filval för analysinställning) på fliken Files (Filer) i dialogrutan User > User Preferences (Användare >
Användarinställningar). Du kan ändra standardplatta i dialogrutan User Preferences
(Användarinställningar). Se Ändra Default File Settings (Standardfilinställningar) på sidan 62 för mer
information.

På fliken Plate (Platta) kan du:

n skapa en ny platta för laddning

n välja en befintlig platta att ladda eller redigera.

Se Kapitel 7, Förbereda plattor för mer information om hur du skapar och ändrar plattor.
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Så här skapar du en ny platta

1. Klicka på Create New (Skapa ny) på fliken Plate (Platta).

Plate Editor (Plattredigeraren) visas.

2. Använd Plate Editor (Plattredigerare) för att skapa en ny platta

3. Klicka på OK för att spara plattan och återgå till fliken Plate (Platta) i Run Setup (Körinställning).

4. Visa information för platta och gör något av följande:

n Om informationen är korrekt klickar du på Next (Nästa) för att fortsätta till fliken Start Run
(Starta körning).

n Om informationen är korrekt klickar du på Edit Selected (Redigera valt) för att återgå till Plate
Editor (Plattredigerare). Granska plattfilen, spara ändringarna och klicka sedan på Next
(Nästa) på fliken Plate (Platta) för att fortsätta till fliken Start Run (Starta körning).

Så här väljer du en befintlig plattfil

1. Gör något av följande på fliken Plate (Platta):

n Klicka på Select Existing (Välj befintlig) och gå till en befintlig plattfil.

n Klicka på Express Load (Expressladdning) och välj en plattfil i listrutan.

Tips: Du kan lägga till plattor till eller ta bort dem från listrutan Express Load
(Expressladdning). Se Lägga till och ta bort plattfiler för expressladdning nedan för mer
information.

2. Visa information för platta och gör något av följande:

n Om informationen är korrekt klickar du på Next (Nästa) för att fortsätta till fliken Start Run
(Starta körning).

n Om informationen är korrekt klickar du på Edit Selected (Redigera valt) för att öppna fönstret
Plate Editor (Plattredigerare). Granska plattfilen, spara ändringarna och klicka sedan på Next
(Nästa) för att fortsätta till fliken Start Run (Starta körning).
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Lägga till och ta bort plattfiler för expressladdning

Du kan ändra innehållet i den nedrullningsbara listan Express Load (Expressladdning) som finns i
Plate Editor (Plattredigerare). Plattorna som finns i den här listan sparas i följande mapp:

c:\Users\Public\Documents\Bio-Rad\CFX\Users\<user_name>\ExpressLoad\

För att ändra listan Express Load (Expressladdning) med plattfiler

1. Gå till och öppna mappen Express Load (Expressladdning).

2. Granska plattfilerna (.pltd) i mappen.

3. Gör något av följande:

n Radera plattfiler från mappen för att ta bort dem från den nedrullningsbara listan.

n Kopiera plattfiler till mappen för att lägga till dem i den nedrullningsbara listan.
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Fliken Start Run (Starta körning)
På fliken Start Run (Starta körning) visas information om experimentet som ska köras. Där visas också
det eller de anslutna instrumentblocken som du kan köra experimentet på.

På fliken Start Run (Starta körning) kan du göra följande:

n Visa utförlig körningsinformation, inklusive den valda protokollfilen, plattfilen och skanningsläget.

n Lägga till anteckningar om körningen.

n Visa information om alla anslutna instrument, inklusive deras körningsstatus (igång eller inaktiva),
provvolym i µl, locktemperatur, emuleringsläge, och ID eller streckkod om tillgängligt.

Obs! Du kan ändra kolumnerna som visas i tabellen Start Run on Selected Blocks (Starta
körning på valda block). Se Ändra information i tabellen Selected Blocks (Valda block) på
sidan 153 för information.

n Välj ett eller flera block där du ska utföra körningen.

n Fjärröppna eller fjärrstäng locket på varje valt instrument.

n Starta körningen.
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Ändra information i tabellen Selected Blocks (Valda block)

Du kan ändra kolumnerna som visas i Start Run (Startkörning) i tabellen Selected Block(s) (Valda
block). Du kan också ändra standardprovvolymen och locktemperaturvärden i tabellen.
Inställningsändringarna tillämpas på körningen som ska utföras.

Så här lägger du till kolumner i tabellen Start Run on Selected Blocks (Starta körning på
valda block).

u Högerklicka på tabellen och välj ett alternativ på menyn som visas.

Så här tar du bort kolumner i tabellen Start Run on Selected Blocks (Starta körning på
valda block)

u Högerklicka på tabellen och ta bort alternativet på menyn som visas.

Så här ändrar du provvolymen eller locktemperatur för ett block

u Välj provvolym eller locktemperaturcell för målblocket och skriv in ett nytt värde i cellen.

Så här lägger du till ett körnings-ID eller en streckkod för ett block

u Välj cellen ID/Bar Code (ID/Streckkod) för målblocket och skriv in ett ID eller skanna blocket med
en streckkodsläsare.

Köra ett experiment
Viktigt! Innan du kör ett experiment måste du se till att din dators antivirusprogram inte startar en
skanning under körningen.

För att köra ett experiment

1. På fliken Start Run (Starta körning) kontrollerar du informationen för platta och protokoll i
sektionen Run Information (Körningsinformation).

2. (Valfritt) Skriv in anteckningar om körningen eller experimentet i textrutan Notes (Anteckningar).

3. Markera kryssrutan för ett eller flera block där du ska utföra körningen.

Tips: För att köra experimentet på alla block väljer du Select All Blocks (Välj alla block)
nedanför tabellen Selected Blocks (Valda block).

4. (Valfritt) Klicka på Flash Block Indicator (Blockets indikatorlampa) för att tända indikatorlampan för de
valda instrumentblocken.
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5. Sätt in experimentplattorna i blocket:

a. Klicka på Open Lid (Öppna lock). Det motoriserade locket till varje valt block öppnas.

b. Sätt in ett experimentblock i varje valt block.

c. Klicka på Close Lid (Stäng lock).

Tips: Du kan även trycka på knappen på framsidan av varje block för att öppna och stänga
locket.

6. Klicka på Open Lid (Öppna lock) och Close Lid (Stäng lock) för att öppna och stänga det
motoriserade locket till varje valt instrumentblock.

7. Visa informationen för körningen och gör något av följande:

n Om informationen är korrekt klickar du på Start Run (Starta körning).

n Om informationen är felaktig:

o Korrigera informationen i tabellen Selected Blocks (Valda block) och klicka på Start Run
(Starta körning).

o Gå tillbaka till rätt flik och gör erforderliga ändringar, spara ändringarna och klicka sedan
på Next (Nästa) för att återgå till fliken Start Run (Starta körning) och starta körningen.

För att starta en ny körning från en föregående körning

u Gör något av följande:

n Välj File > Repeat a Run (Arkiv > Upprepa en körning) i huvudprogrammets menyrad; gå till
och dubbelklicka på körningsdatafilen som du vill upprepa.

n Välj fliken Repeat Run (Upprepa körning) i Startup Wizard (Startguide) och dubbelklicka på
körningsdatafilen för körningen du vill upprepa.

Alternativt kan du klicka på Browse (Bläddra) på fliken Repeat Run (Upprepa körning) och gå
till och dubbelklicka på körningsdatafilen för körningen du vill upprepa.
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Dialogrutan Run Details (Körningsdetaljer)
När du klickar på Start Run (Starta körning) uppmanas du av CFX Manager Dx-programmet att spara
datafilen (.pcrd). Sedan startas körningen och dialogrutan Run Details (Körningsdetaljer) öppnas.
Dialogrutan Run Details (Körningsdetaljer) har tre statusflikar:

n Run Status (Körningsstatus) – använd den här fliken för att visa protokollets aktuella status,
öppna eller stänga locket, pausa en körning, lägga till repetitioner, hoppa över steg eller stoppa
körningen.

n Real-time Status (Realtidsstatus) – använd den här fliken för att visa fluorescensdata för
realtids-PCR efterhand som de samlas in.

n Time Status (Tidsstatus) – använd den här fliken för att visa ett nedräkningstidur i helskärm för
protokollet.

Dessa flikar förklaras utförligt i kommande avsnitt.

Fliken Run Status (Körningsstatus)
På fliken Run Status (Körningsstatus) visas aktuellt status för en pågående körning. I den här vyn kan
du även kontrollera locket och ändra den pågående körningen.
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1. Rutan Run Status (Körningsstatus) – visar protokollets aktuella förlopp.

2. Kontroller för Run Status (Körningsstatus) – gör att du kan styra instrumentet
eller avbryta det aktuella protokollet.

3. Rutan Run Information (Körningsinformation) – visar körningsinformation.

FÖRKLARING

Kommandon för Run Status (Körningsstatus)

Använd kommandona på fliken Run Status (Körningsstatus) för att antingen styra instrumentet från
programmet eller ändra en pågående körning.

Obs! Även om du gör ändringar i protokollet under körningen, t.ex. lägger till repetitioner, ändras
ingenting i protokollfilen som är associerad med körningen. Dessa åtgärder registreras i Run Log
(Körningslogg).

– öppnar det motoriserade locket på vissa instrument.

Viktigt! Om du öppnar locket under en körning pausas körningen under det aktuella steget
och data kan förändras.

– stänger det motoriserade locket på vissa instrument.

– lägger till fler repetitioner till det aktuella GOTO-steget i protokollet. Detta alternativ är endast
tillgängligt när ett GOTO-steg pågår.

– hoppar över det aktuella steget i protokollet.

Obs! Om du hoppar över ett GOTO-steg uppmanas du av programmet att bekräfta att du vill
hoppa över hela GOTO-slingan och fortsätta till nästa steg i protokollet.

– tänder lampan på det valda instrumentet för att identifiera de valda blocken.
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– pausar protokollet.

Obs! Denna åtgärd registreras i Run Log (Körningslogg).

– återupptar ett pausat protokoll.

– stoppar körningen innan protokollet är slut.

Obs! Om du stoppar en körning innan protokollet är slut kan data förändras.
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Fliken Real-time Status (Realtidsstatus)
På fliken Real-time Status (Realtidsstatus) visas realtids-PCR-data som samlats in vid varje cykel
under körningen efter de två första plattavläsningarna.

1. Ruta för amplifieringskurva – visar realtidsamplifieringsdata under körningen.

2. Identifierare för brunnsgrupper – om brunnsgrupper identifierades under
plattinställningen, kan användare välja en specifik brunnsgrupp för att visa dess
kurvor, brunnar och tabellinformation.

Identifierare för stegnummer – om protokollet samlar in data vid fler än ett steg
(till exempel under amplifiering och smältkurva), kan användare välja ett specifikt
steg och visa kurvorna som samlats in under det steget.

3. Ruta för brunnsväljare – visar de aktiva, inaktiva och tomma brunnarna i plattan.

4. Ruta för plattinställningstabell – visar plattinställningen i tabellformat.

FÖRKLARING
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5. Ruta för körningsdetaljer – visar realtidsstatus för körningen inklusive:

n Aktuellt steg

n Aktuell repetition

n Aktuell temperatur

n Återstående tid

n Provtemperatur

n Locktemperatur

6. Plate Setup (Plattinställning) – öppnar dialogrutan Plate Setup (Plattinställning), i
vilken användare kan ändra den aktuella plattinställningen under en körning.

På fliken Real-time Status (Realtidsstatus) kan du:

n Visa eller dölja realtidskurvor genom att markera dem i brunnsväljarrutan eller
plattinställningstabellen.

n Visa enstaka kurvor eller grupper av kurvor genom att markera dem i den nedrullningsbara listan
för brunnsgrupper.

n Redigera plattan eller byta ut plattfilen.

n Tillämpa en PrimePCR-fil på körningen.

Visa och dölja realtidskurvor

Som standard är alla fyllda brunnar aktiva och visas i tabellen för plattinställning. Aktiva brunnar är blå
i brunnsväljarrutan. Dolda brunnar är ljusgrå och oanvända brunnar är mörkgrå i brunnsväljarrutan.

Det går att dölja kurvor från aktiva brunnar under körningen. CFX Manager Dx fortsätter att samla in
data för alla brunnar. När brunnar döljs visas inte deras data i tabellen för plattinställning.

Så här döljer du realtidskurvor

u I brunnsväljarrutan klickar du på de aktiva (blå) brunnar som du vill dölja.

Så här visar du realtidskurvor

u I brunnsväljarrutan klickar du på de dolda (ljusgrå) brunnar som du vill visa.

Mer information om brunnsväljaren finns i Brunnsväljare på sidan 177.
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Redigera en Plate Setup (Plattinställning)

Så här redigerar du en plattinställning

u Klicka på Plate Setup (Plattinställning) och välj sedan View/Edit Plate (Visa/redigera platta).

Fönstret Plate Editor (Plattredigerare) visas, i vilket du kan redigera plattan medan körningen
pågår. För mer information om att redigera plattor, se Kapitel 7, Förbereda plattor.

Obs! Du kan även redigera kurvutseendena från fönstret Plate Editor (Plattredigerare).
Ändringar visas i amplifieringskurvplotten på fliken Real-time Status (Realtidsstatus).

Byta ut en plattfil

Tips: Det är särskilt lämpligt att byta ut en plattfil om du startar en körning med en Quick Plate-fil i
mappen ExpressLoad.

Såhär byter du ut en plattfil

u Klicka på Plate Setup (Plattinställning) och välj sedan ett av följande alternativ:

n Replace Plate file (Byt ut plattfil) – välj den nya plattfilen från listan i webbläsarfönstret

n Apply PrimePCR file (Använd PrimePCR-fil) – sök efter en körningsfil från vilken
plattlayouten kommer att erhållas med hjälp av Smart search (Smart sökning), eller klicka på
Browse (Bläddra) för att hitta en fil som hämtades från Bio-Rad-webbplatsen och som inte
finns i PrimePCR-mappen.

Obs! CFXManager Dx kontrollerar skanningsläge och plattstorlek för plattfilen. Dessa måste
överensstämmamed körningsinställningarna med vilka körningen påbörjades.
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Fliken Time Status (Tidsstatus)
På fliken Time Status (Tidsstatus) visas tiden som återstår tills den aktuella körningen är slutförd.
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Utföra PrimePCR-experiment
PrimePCR-experiment använder den reaktionsväg eller de sjukdomsspecifika analyser som Bio-Rad
har validerat och optimerat i våtlaboratorium och som finns i följande format:

n Beredda paneler – plattor innehållande analyser som är specifika för en biologisk reaktionsväg
eller sjukdom, dessa omfattar PrimePCR-kontroller och -referensgener

n Plattor med anpassad konfiguration – plattor som kan konfigureras i en användardefinierad layout
med möjlighet att välja analyser för intressemål, kontroller och referenser

n Individuella analyser – rör som innehåller individuella primeruppsättningar för användning i
realtidsreaktioner

För att minska den totala körtiden kan du ta bort smältsteget i protokollet. Bio-Rad rekommenderar
starkt att du inte gör några andra ändringar av ett PrimePCR-körprotokoll. Standardprotokollet är det
som har använts för analysvalidering. Avvikelser från det kan påverka resultatet. Protokolländringar
noteras på fliken Run Information (Körningsinformation) i den resulterande datafilen och i rapporter
som skapas.

Så här startar du en PrimePCR-körning

u Gör något av följande för att starta PrimePCR-körning:

n Välj PrimePCR på fliken Run setup (Körningsinställningar) i Startup Wizard (Startguide) och
välj lämplig kemi (SYBER eller prob).

n Välj en PrimePCR-körning i listan Recent Runs (Senaste körningar) på fliken Repeat run
(Upprepa körning) i Startup Wizard (Startguide).

n Välj File > New > PrimePCR Run (Arkiv > Ny > PrimePCR-körning) i hemfönstret.

n Välj File > Open > PrimePCR Run File (Arkiv > Öppna > PrimePCR-körfil) i hemfönstret.

n Dra och släpp en PrimePCR-körfil i hemfönstret.

När du har valt en PrimePCR-körning öppnas fönstret Run Setup (Körningsinställningar) på fliken
Start Run (Starta körning) med den PrimePCR-standardplattlayout som har lästs in baserat på det
valda instrumentet.
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Så här tar du bort protokollets smältsteg

u Avmarkera rutan intill Include Melt Step (Inkludera smältsteg) på fliken Protocol (Protokoll).

Så här importerar du målinformation för PrimePCR-plattor till en plattlayout

1. Gör något av följande:

n Välj Plate Setup > Apply PrimePCR File (Plattinställning > Använd PrimePCR-fil) på fliken
Real-time Status (Realtidsstatus) i dialogrutan Run Details (Körningsinformation).

n Välj Plate Setup > Apply PrimePCR File (Plattinställning > Använd PrimePCR-fil) i fönstret
Data Analysis (Dataanalys).

2. I dialogrutan PrimePCR run file (PrimePCR-körfil) klickar du på Browse (Bläddra) och går till
lämplig PrimePCR-fil (.csv).

3. Välj PrimePCR-målfilen och klicka på Open (Öppna).

CFX Manager Dx importerar målinformationen till plattlayouten.
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CFXManager™ Dx erbjuder flera metoder för att öppna och visa datafiler. Du kan:

n Välj File > Open > Data File (Arkiv > Öppna > Datafil) i hemfönstret och bläddra till .pcrd-målfilen.

n Välj File > Recent Data Files (Arkiv > Senaste datafiler) i hemfönstret och välj en av de tio senast
öppnade datafilerna i en lista.

Fönstret Data Analysis (Dataanalys)
Fönstret Data Analysis (Dataanalys) visar flera flikar som vardera visar analyserade data för en
specifik analysmetod eller körningsspecifik information. Flikar visas endast om data som har samlats
in under körningen är tillgängliga för analystypen i fråga.

Tips: Välj flikar som du vill visa i listrutan View (Visa) i fönstret Data Analysis (Dataanalys). Välj
Settings (Inställningar) > Restore Default Window Layout (Återställ standardfönsterlayout) för att
återgå till den ursprungliga fliklayouten.
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Verktygsraden för Data Analysis (Dataanalys)
Verktygsraden i fönstret Data Analysis (Dataanalys) ger snabb åtkomst till viktiga
dataanalysfunktioner.

I Tabell 15 listas funktionerna för knapparna i verktygsraden.

Knapp Namn Funktion

Plate Setup
(Plattinställning)

Visa/redigera platta: Öppnar Plate Editor
(Plattredigerare) där du kan visa och
redigera brunnars innehåll.

Ersätt plattfil: Väljer en plattfil som ska
ersätta plattlayouten.

Tillämpa PrimePCR file: Väljer en körfil som
ska ersätta plattlayouten för en
PrimePCR™-körning.

ManageWell
Groups (Hantera
brunnsgrupper)

Öppnar fönstret Well Groups Manager
(Brunnsgruppshanterare) där du kan
skapa, redigera och ta bort brunnsgrupper.

Well Group
(Brunnsgrupp)

Väljer ett befintligt brunnsgruppsnamn i
listrutemenyn. Standardvalet är All Wells
(Alla brunnar). Knappen visas endast när
brunnsgrupper skapas.

Analysis Mode
(Analysläge)

Analyserar data i läget Fluorophore
(Fluorofor) eller Target (Mål).

Help (Hjälp) Öppnar en kopia av den här handboken i
Acrobat PDF-format.

Tabell 15. Verktygsraden i fönstret Data Analysis (Dataanalys)

166 | Systemen CFX96 Dx och CFX96 DeepWell Dx



Fönstret Data Analysis (Dataanalys)

Menyraden Data Analysis (Dataanalys)
I Tabell 16 listas menyradsobjekten i fönstret Data Analysis (Dataanalys).

Menyobjekt Kommando Funktion

File (Arkiv) Save (Spara) Sparar filen.

Save As (Spara som) Sparar filen med ett nytt namn.

Repeat Run (Upprepa körning) Extraherar protokollet och plattfilen från
den aktuella körningen för att köra om den.

Close (Stäng) Stänger fönstret Data Analysis
(Dataanalys).

View (Visa) Run Log (Körningslogg) Öppnar fönstret Run Log (Körningslogg)
och visar den aktuella datafilens
körningslogg.

Quantification (Kvantifiering), Melt
Curve (Smältkurva), Gene
Expression (Genuttryck), End
Point (Ändpunkt), Custom Data
View (Anpassad datavy), QC
(Kvalitetskontroll), Run
Information (Körningsinformation)

Visar analyserade data på valda flikar i
fönstret Data Analysis (Dataanalys). Minst
en flik måste väljas.

Tabell 16. Menyradsobjekt i fönstret Data Analysis (Dataanalys)
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Menyobjekt Kommando Funktion

Settings
(Inställningar)

Cq Determination Mode (-
bestämningsläge)

Välj läget Regression eller Single
Threshold (Enkelt tröskelvärde) för att
bestämma hur Cq-värdena beräknas för
varje kurva.

Tabell 16. Menyradsobjekt i fönstret Data Analysis (Dataanalys), forts.
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Menyobjekt Kommando Funktion

Baseline Setting
(Baslinjeinställning)

Välj metoden Baseline Subtraction
(Baslinjesubtraktion) för valda
brunnsgrupper.

Analysis Mode (Analysläge) Välj och analysera data efter Fluorophore
(Fluorofor) eller efter Target (Mål).

Cycles to Analyze (Cykler att
analysera)

Välj cyklerna som ska analyseras.

Baseline Threshold
(Baslinjetröskel)

Öppnar fönstret Baseline Threshold
(Baslinjetröskel) där du kan justera
baslinjen eller tröskelvärdet.

Trace Styles (Kurvutseenden) Öppnar fönstret Trace Styles
(Kurvutseenden).

Plate Setup (Plattinställning) Öppnar Plate Editor (Plattredigerare) där
du kan visa och redigera plattan samt
ersätta den aktuella plattan med en från en
användardefinierad plattfil eller en
PrimePCR-körfil.

Include All Excluded Wells
(Inkludera alla exkluderade
brunnar)

Inkluderar alla exkluderade brunnar i
analysen.

Mouse Highlighting
(Musmarkering)

Aktiverar och avaktiverar simultan
markering av data med muspekaren.

Tips: OmMouse Highlighting
(Musmarkering) är avaktiverat kan du
tillfälligt aktivera markering genom att
trycka på Ctrl-tangenten.

Restore Default Window Layout
(Återställ standardfönsterlayout)

Återställer ordningen av fönster till
standardinställningen.

Tabell 16. Menyradsobjekt i fönstret Data Analysis (Dataanalys), forts.
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Menyobjekt Kommando Funktion

Export
(Exportera)

Export All Data Sheets to Excel
(Exportera alla datablad till Excel)

Exporterar alla kalkylbladsvyer från alla
flikar till en separat Excel-fil.

Custom Export (Anpassad export) Öppnar fönstret Custom Export (Anpassad
export) där du kan ange vilka fält som ska
exporteras och filformatet.

Export to LIMS Folder (Exportera
till LIMS-mapp)

Öppnar ett fönster där du kan spara data i
ett förutbestämt format i LIMS-mappen.

Seegene Export (Seegene-
export)

Öppnar ett fönster för definition av platsen
där data ska sparas från alla
kalkylbladsvyer till Excel-filer som är
strukturerade särskilt för användning av
Seegene, Inc.

Tools (Verktyg) Reports (Rapporter) Öppnar datafilens Report (Rapport).

Well Group Reports
(Brunnsgruppsrapporter)

Öppnar fönstret Well Group Report
(Brunnsgruppsrapport) för generering av
rapporter för angivna brunngrupper.

Import Fluorophore Calibration
(Importera fluoroforkalibrering)

Välj en kalibreringsfil som ska tillämpas för
den aktuella datafilen.

qbase+ Startar qbase+ v2.5 direkt från den aktuella
.pcrd-filen om det är installerat.

Tabell 16. Menyradsobjekt i fönstret Data Analysis (Dataanalys), forts.
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Flikinformation
Varje flik i fönstret Data Analysis (Dataanalys) visar data i diagram och kalkylblad för en specifik
analysmetod och har en brunnsväljare för val av data som du vill visa. När den öppnas visar Data
Analysis (Dataanalys) fliken Quantification (Kvantifiering) som standard. Du kan använda data i
diagrammet Amplification (Amplifiering) på fliken Quantification (Kvantifiering) för att ange lämpliga
analysinställningar för körningen.

Obs! Programvaran länkar data i rutorna för varje Data Analysis-flik (Dataanalys). Om du till
exempel markerar en brunn genom att placera muspekaren över den i brunnsväljarvyn kommer
motsvarande data att markeras i alla andra rutor.
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Stegnummerväljare
Systemen CFX96 och CFX96 DeepWell kan hämta fluorescensdata vid flera protokollsteg.
Programvaran behåller data som hämtats vid varje steg separat. Programvaran visar väljaren Step
Number (Stegnummer). Om ett protokoll innehåller minst ett datainsamlingssteg visar CFX Manager
Dx-programvara data från det första insamlingssteget.

Om protokollet innehåller fler än ett inhämtningssteg kan du välja ett annat steg i listrutan, till exempel:

När du väljer ett steg tillämpar programvaran valet på alla data som visas i fönstret Data Analysis
(Dataanalys).

Visa Well Groups (Brunnsgrupper) i Data Analysis (Dataanalys)
Brunnar i plattan kan grupperas i undergrupper för oberoende analys med användning av
brunnsgrupper. När du skapar brunnsgrupper visas deras gruppnamn i den nedrullningsbara listan
Well Groups (Brunnsgrupper) i verktygsraden i fönstret Data Analysis (Dataanalys).

Om du skapade brunnsgrupper visar programmet standardbrunnsgruppen All Wells (Alla brunnar) när
du öppnar fönstret Data Analysis (Dataanalys), och visar data för alla brunnar med innehåll i
diagrammen och kalkylbladen. Endast brunnarna som laddats med innehåll visas i brunnsväljaren,
och endast data för dessa brunnar ingår i dataanalysberäkningarna.

Obs! Om du inte skapade brunnsgrupper visas inte den nedrullningsbara listan Well Groups
(Brunnsgrupper) i verktygsraden.

Ändra brunnsinnehåll efter en körning
Under dataanalys, om du ändrar sättet på vilket data visas genom att ändra innehållet i brunnarna i
Plate Editor (Plattredigerare), så ändras aldrig de fluorescensdata som samlats in från respektive
brunn under körningen. Efter det att modulen samlat in fluorescensdata, kan du inte radera dessa data
men du kan välja att ta bort data från vy och analys.

För att ändra innehållet i brunnar efter en körning

u I fönstret Data Analysis (Dataanalys) klickar du på Plate Setup (Plattinställning) och väljer ett av
följande alternativ:

n Edit/View Plate (Redigera/Visa platta) – öppnar Plate Editor (Plattredigerare) i vilken du kan
göra manuella förändringar av layouten.

n Replace Plate file (Ersätt plattfil) – öppnar webbläsaren Select Plate (Välj platta) i vilken du
kan gå till en tidigare sparad plattfil som du kan ersätta den aktuella plattlayouten med.
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n Apply PrimePCR file (Använd PrimePCR-file) – öppnar dialogrutan Select PrimePCR file
(Välj PrimePCR-file) i vilken du kan gå till en PrimePCR™-körningsfil och använda den på
plattlayouten.

Tips: Du kan lägga till eller redigera information om innehållet i brunnen före en körning, under en
körning eller efter en slutförd PCR-körning. Du måste tilldela skanningsläge och plattstorlek före
körningen. Dessa parametrar går inte att ändra efter körningen.
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Dataanalysinställningar
Data i diagrammet Amplification (Amplifiering) på fliken Quantification (Kvantifiering) visar den relativa
fluorescensen (RFU) för varje brunn vid varje cykel. Varje kurva i diagrammet representerar data från
en enskild fluorofor i en brunn. Dessa data används för att bestämma Cq-värden för varje brunn per
fluorofor-basis. Programmet använder ett av två lägen för att bestämma Cq-värden:

n Regression – använder en multivariabel, icke-linjär regressionsmodell på enskilda brunnskurvor
och använder sedan denna modell för att beräkna ett optimalt Cq-värde.

n Single Threshold (Enstaka tröskel) – använder värdet för en enstaka tröskel för att beräkna Cq-
värdet baserat på tröskelskärningspunkten för enskilda fluorescenskurvor.

Välj Settings > Cq Determination Mode (Inställningar > Cq-bestämningsläge) för att välja Cq-
bestämningsläget.

Justera tröskeln
I läget Single Threshold (Enkelt tröskelvärde) kan du justera tröskelvärdet för en fluorofor genom att
klicka på tröskelvärdeslinjen i diagrammet Amplification (Amplifiering) och flytta muspekaren vertikalt.
Alternativt kan du specificera en exakt korsande tröskel för den valda fluoroforen.

Baslinjeinställningar
Den här programvaran fastställer automatiskt baslinjen separat för varje brunn. Baslinjeinställningen
fastställer metoden för baslinjesubtraktion för alla fluorescenskurvor. Programvaran ger tre alternativ
för baslinjesubtraktion:

n No Baseline Subtraction (Ingen baslinjesubtraktion) – visar data som relativa
fluorescenskurvor. Vissa analyser är inte möjliga i det här analysläget, och därför visar inte
programvaran flikarna Gene Expression (Genuttryck), End Point (Slutpunkt) och Allelic
Discrimination (Allelisk diskriminering).

n Baseline Subtracted (Baslinje subtraherad) – visar data som baslinjesubtraherade kurvor för
varje fluorofor i en brunn. Programvaran måste baslinjesubtrahera uppgifterna för att fastställa
kvantifieringscykler, generera standardkurvor och fastställa koncentrationen av okända prover.
För generering av en baslinjesubtraherad kurva passar mjukvaran under baslinjecyklerna den
bästa raka linjen genom den registrerade fluorescensen för varje brunn och subtraherar sedan de
data som passar bäst från bakgrundssubtraherade data vid varje cykel.

n Baseline Subtracted Curve Fit (Baslinjesubtraherad anpassning av kurva) – visar data som
baslinjesubtraherade kurvor och programvaran slätar ut den baslinjesubtraherade kurvan med
hjälp av ett centrerat medelvärdesfilter. Den här processen utförs så att varje Cq lämnas invariant.
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Utöver dessa alternativ kan du också välja Apple Fluorescent Drift Correction (Använd korrigering av
fluorescensförflyttning). För brunnar som har onormalt avvikande RFU-värden under de första få cyklerna
av en körning härleder programvaran en beräknad baslinje från intilliggande brunnar för vilka en
horisontell baslinje har genererats.

Så här ändrar du inställningen av baslinjesubtraktion

u Välj Settings (Inställningar) > Baseline Setting (Baslinjeinställning).

Analysläge
Data kan grupperas och analyseras antingen enligt fluorofor eller målnamn. När de grupperas enligt
fluorofor, visas datakurvor enligt fluorofor så som indikeras i plattinställningen för den körningen.
Enskilda fluorofordata visas i diagrammet för amplifiering och standardkurva (om det är tillgängligt) när
de lämpliga kryssrutorna för fluoroforväljare, placerade under amplifieringsdiagrammet, är markerade.

När de grupperas enligt mål visas datakurvor enligt målnamn så som det angivits i plattinställningen
för den körningen.

Användarhandbok | 175



Kapitel 9 Dataanalysöversikt

För att välja ett dataanalysläge

u Gör något av följande:

n Välj Settings > Analysis Mode (Inställningar > Analysläge).

n Välj ett läge från den nedrullningsbara menyn Analysis Mode (Analysläge) i verktygsraden.

Cykler att analysera
Du kan begränsa antalet cykler att analysera. Du kan också analysera data från en specifik
uppsättning cykler. Du kan högst analysera 50 cykler.

Obs! Borttagning av cykler från början av en körning kan ha en betydande inverkan på baslinjen.

Så här begränsar du dataanalysen till ett specifikt intervall av cykler

1. Välj Settings > Cycles to Analyze (Inställningar > Cykler att analysera).

Dialogrutan Cycles to Analyze (Cykler att analysera) visas.

2. Ange värden för start- och slutcykel och klicka på OK.

Klicka på Restore Defaults (Återställ standardvärden) i dialogrutan Cycles to Analyze (Cykler att
analysera) för att återgå till cykler som ursprungligen användes för analysen.
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Brunnsväljare
AnvändWell Selector (Brunnsväljaren) för att visa eller dölja brunnsdata i diagrammen eller
kalkylbladen i fönstret Data Analysis (Dataanalys). Endast brunnar som har lästs in med provet kan
väljas i brunnsväljaren. Programvaran färgar brunnarna i Well Selector (Brunnsväljare):

n Blå – anger valda brunnar. Data från brunnar som har valts visas i fönstret Data Analysis
(Dataanalys).

n Ljusgrå – anger icke-valda brunnar. Data från brunnar som inte har valts visas inte i fönstret Data
Analysis (Dataanalys).

n Mörkgrå – anger tomma brunnar.

Så här visar eller döljer du brunnsdata

u Gör något av följande i brunnsväljaren:

n Klicka på en brunn om du vill dölja den. Klicka på brunnen igen för att visa den.

n För att dölja flera brunnar drar du över brunnarna som du vill markera. För att visa dessa
brunnar, dra över dem igen.

n Klicka i det övre vänstra hörnet av plattan för att dölja alla brunnar. Klicka i det övre vänstra
hörnet igen för att visa alla brunnar.

n Klicka i början av en kolumn eller rad för att dölja brunnarna. Klicka på kolumnen eller raden
igen för att visa brunnarna.
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Högerklickbara menyobjekt i brunnsväljare
I Tabell 17 visas högerklickalternativ som är tillgängliga i brunnsväljarvyn.

Objekt Funktion

Well XX (Brunn XX) Visar endast denna brunn, tar bort denna brunn från vyn, ställer in
färg för brunnen eller utesluter brunnen från analys.

Valda brunnar (högerklicka och
dra)

Visar endast dessa brunnar, tar bort dessa brunnar från vyn, ställer
in färg på dessa brunnar eller utesluter dessa brunnar från
analysen.

Copy (Kopiera) Kopierar innehållet i en brunn till urklipp, inklusive Sample Type
(Provtyp) och Replicate # (Replikatnummer) som tillval.

Copy as Image (Kopiera som
bild)

Kopierar vyn för brunnsväljare som en bild.

Print (Skriv ut) Skriver ut vyn för brunnsväljare.

Print Selection (Skriv ut
markering)

Skriver ut aktuell markering.

Export to Excel (Exportera till
Excel)

Exporterar data till ett Excel-kalkylblad.

Export to Csv (Exportera till
Csv)

Exporterar data som textdokument.

Export to Xml (Exportera till
Xml)

Exporterar data som ett .xml-dokument.

Well Labels (Brunnsetiketter) Ändrar brunnsetiketterna till Sample Type (Provtyp), Target Name
(Målnamn) eller Sample Name (Provnamn).

Tabell 17. Högerklickbara menyobjekt i brunnsväljare
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Tillfälligt utesluta brunnar från analys
För att tillfälligt utesluta brunnar från dataanalys

1. Högerklicka på brunnen i brunnsväljaren. Uteslut flera brunnar genom att högerklicka och för att
markera flera brunnar, kurvor eller punkter.

2. Välj lämpligt alternativ i högerklickmenyn:

n Well > Exclude Well (Brunn > Uteslut brunn)

n Selected Wells > Exclude from Analysis (Valda brunnar > Uteslut från analys)

n Selected Traces > Exclude these wells from Analysis (Valda kurvor > Uteslut dessa brunnar
från analys)

Alternativt kan du ta bort dessa brunnar permanent från analys genom att rensa innehållet i
brunnar i Plate Editor (Plattredigerare) genom att klicka på knappen Clear Wells (Rensa brunnar).

Viktigt! Du måste ange eventuellt rensat brunnsinnehåll igen.

För att inkludera en utesluten brunn

u Högerklicka på lämplig brunn i brunnsväljaren och välj Well > Include Well in Analysis (Brunn >
Inkludera brunn i analys).
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Diagram
Varje diagram i fönstret Data Analysis (Dataanalys) visar uppgifterna i en separat graf och har
alternativ med vilka du kan justera och exportera data eller diagramgrafik.

Gemensamma högerklickbara menyobjekt för diagram
I Tabell 18 visas menyobjekt som du kan högerklicka på och som är tillgängliga i tabeller. Några av de
tillgängliga objekten är närvarande för alla diagram, och dessa objekt kan användas för att ändra hur
data visas eller för enkel export av data från ett diagram.

Objekt Funktion

Copy (Kopiera) Kopierar diagrammet till urklipp.

Save Image As (Spara bild
som)

Sparar bilden med en specificerad storlek, upplösning och filtyp.
Tillgängliga bildformat är PNG (standard), JPG, och BMP.

Page Setup
(Utskriftsformat)

Förhandsgranska och välj utskriftsformat för utskrift.

Print (Skriv ut) Skriver ut tabellen.

Set Scale to Default (Ange
skala som standard)

Återställer diagrammets standardvy efter förstoring av diagrammet.

Chart Options
(Diagramalternativ)

Öppnar fönstret Chart Options (Diagramalternativ) för att ändra
tabellen, inklusive ändring av namnet, val av gränser för x- och y-axeln,
visning av rutnätslinjer samt mindre hjälpstreck på axlarna.

Tabell 18. Högerklickbara menyobjekt för diagram

Obs! Menyobjekt som gäller för specifika diagram beskrivs i Kapitel 10, Dataanalysinformation.

Kopiera diagramdata till urklipp
Du kan kopiera innehållet i diagramvyn och klistra in det i ett program som accepterar bitmappbildfiler.

Så här kopierar du diagramdata till urklipp

1. Välj Copy (Kopiera) diagrammets högerklickmeny.

2. Öppna ett program som accepterar bitmappbilder, till exempel Microsoft Word.

3. Högerklicka och välj Paste (Klistra in) för att klistra in bitmappbilden från urklipp i programmet.
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Ändra inställningarna för Baseline Threshold (Baslinjetröskel)
I läget Single Threshold (Enkelt tröskelvärde) kan du justera tröskelvärdet för en fluorofor genom att
klicka på tröskelvärdeslinjen i diagrammet Amplification (Amplifiering) och flytta muspekaren vertikalt.
Alternativt kan du specificera en exakt korsande tröskel för den valda fluoroforen.

Tips: Du kan specificera ett cykelintervall för att bestämma baslinjen för alla datafiler på fliken
Data Analysis (Dataanalys) i User > User Preferences (Användare > Användarinställningar).

För att justera baslinjecykelns början och slut för varje brunn

1. På fliken Quantification (Kvantifiering), välj en enstaka fluorofor under amplifieringsdiagrammet.

2. Från diagrammets högerklickmeny, välj Baseline Threshold (Baslinjetröskel).

Dialogrutan Baseline Threshold (Baslinjetröskel) visas.
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3. Gör något av följande i sektionen Baseline Cycles (Baslinjecykler):

n För att välja en brunn, klicka på dess radnummer.

n För att välja flera angränsande brunnar, klicka på radnumret för den första brunnen och dra
nedåt längs kolumnen till den avslutande brunnen.

n För att välja flera ej angränsande brunnar, håll tangenten Control nedtryckt och klicka på
radnumret för respektive målbrunn.

n För att välja alla brunnar, klicka i tabellens övre vänstra hörn.

4. Justera cykeln för Baseline Begin (Baslinje börjar) och Baseline End (Baslinje slutar) för alla valda
brunnar, eller ändra cykelnumret för Begin (Börja) och End (Sluta) längst ned i kalkylbladet.

Tips: För att återställa inställningarna till de senast sparade värdena, klicka på Reset All
User Defined Values (Återställ alla användardefinierade värden).

5. Klicka på OK för att spara ändringarna och återgå till diagrammet.

För att specificera ett cykelintervall för alla datafiler

u I hemfönstret eller fönstret Plate Editor (Plattredigerare), välj User > User Preferences
(Användare > Användarinställningar) och sedan fliken Data Analysis (Dataanalys).

Sortera mål- och provdata
Obs! Det här alternativet är endast tillgängligt för genuttrycksdiagram.

Som standard visas listorna Targets (Mål) och Samples (Prover) i alfabetisk ordning. I dialogrutan Sort
(Sortera) kan du sortera visningen i omvänd alfabetisk ordning eller manuellt flytta ett villkor till en
annan plats i listan.

Så här sorterar du data för mål och prover

1. Klicka på Sort (Sortera) på diagrammets högerklicksmeny.

Dialogrutan Gene Expression Chart Sorting (Sortering i genuttrycksdiagram) öppnas.
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2. I dialogrutan klickar du på Z-A för att sortera listan i omvänd alfabetisk ordning.

3. Du flyttar ett villkor manuellt genom att välja det och klicka på lämplig knapp mellan diagrammen:

n Klicka på uppåt- eller nedåtpilen för att flytta det valda villkoret en position.

n Klicka på uppåt- eller nedåtpilen för att flytta det valda villkoret till toppen eller botten av
listan.

4. Klicka på OK för att spara ändringarna och återgå till fliken Gene Expression (Genuttryck).

Förstora ett område i diagrammet
Så här förstorar du ett område i diagrammet

u Klicka på och dra över diagrammet och klicka sedan på Zoom (Zooma in)*. Programvaran ändrar
storleken på diagrammet och centrerar det på det valda området.

Obs! *I Bar Chart (Stapeldiagram) behöver du inte klicka på popup-kommandot Zoom
(Zooma in).

Så här återställer du diagrammet till fullständig vy

u Högerklicka i diagrammet och välj Set Scale to Default (Ställ in standardskala).
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Kopiera diagram till en Microsoft-fil
Du kan kopiera datadiagram till Microsoft Word-, Excel- eller PowerPoint-dokument. Bildupplösningen
är densamma som på skärmen som bilden hämtades från

För att kopiera diagram till en Microsoft-fil

1. I fönstret Data Analysis (Dataanalys), välj Copy (Kopiera) från diagrammets högerklickmeny.

2. Öppna en tomMicrosoft-fil och klistra in innehållet från urklipp.

Alternativ: Klicka på ikonen för klicka-och-dra och dra och släpp diagrammet till en Microsoft-fil.
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Kalkylblad
Kalkylbladen som visas i Data Analysis (Dataanalys) har alternativ för sortering och överföring av
data. Sorterar kolumnerna genom en av följande metoder:

n Klicka och dra en kolumn till en ny plats i den valda tabellen.

n Klicka på kolumnrubriken för att sortera data i stigande eller fallande ordning.

Så här sorterar du upp till tre datakolumner i fönstret Sort (Sortera)

1. Högerklicka i kalkylbladet och välj Sort (Sortera).

2. Välj det första kolumnnamnet för att sortera i dialogrutan Sort (Sortera). Sorterar data i stigande
eller fallande ordning.

3. Välj en andra och tredje kolumn för att sortera och välj Ascending (Stigande) eller Descending
(Fallande).

4. Klicka på OK för att sortera uppgifterna eller klicka på Cancel (Avbryt) för att stoppa sorteringen.

Markera data på associerade diagram och brunnsväljaren genom att placera muspekaren över en
cell. Klicka i en cell för att kopiera och klistra in dess innehåll till ett annat program.

Gemensamma högerklickbara menyobjekt för kalkylblad
I Tabell 19 visas menyobjekt som du kan högerklicka på och som är tillgängliga i alla kalkylbladsvyer.

Objekt Funktion

Copy (Kopiera) Kopierar innehållet för de valda brunnarna till urklipp klistrar du in
innehållet i ett kalkylblad som Excel.

Copy as Image (Kopiera som
bild)

Kopierar kalkylbladsvyn som en bildfil och klistrar in den i en fil som
accepterar bildfiler, till exempel text-, bild- eller kalkylbladsfiler.

Print (Skriv ut) Skriver ut aktuell vy.

Print Selection (Skriv ut
markering)

Skriver ut aktuell markering.

Export to Excel (Exportera till
Excel)

Exporterar data till ett Excel-kalkylblad.

Tabell 19. Högerklickbara menyobjekt för kalkylblad
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Objekt Funktion

Export to CSV (Exportera till
CSV)

Exporterar uppgifterna till en kommaseparerad fil (.csv).

Export to Xml (Exportera till Xml) Exporterar data till en Xml-fil.

Export to Html (Exportera till
Html)

Exporterar data till en Html-fil.

Find (Sök) Söker efter text.

Sort (Sortera) Sorterar data i upp till tre kolumner.

Select Columns (Välj kolumner) Välj kolumner som ska visas på kalkylbladet.

Tabell 19. Högerklickbara menyobjekt för kalkylblad, forts.
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Export (Exportera)
I CFX Manager Dx-programvara är fyra exportalternativ tillgängliga på listrutemenyn Export:

n Export All Data Sheets

n Custom Export (Anpassad export)

n Export to LIMS (Exportera till LIMS)

n Seegene Export (Seegene-export)

Exportera alla datablad
Du kan exportera alla kalkylbladsvyerna från alla flikar i CFX Manager Dx-programvara till enskilda
filer.

För att exportera alla datablad

u Välj Export > Export All Data Sheets (Exportera > Exportera alla datablad) och välj önskad filtyp:

n CSV (*.csv)

n Text (*.txt)

n Excel 2007 (*.xlsx)

n Excel 2003 (*.xls)

n XML (*.xml)
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Skapa en anpassad exportfil
Så här skapar du en anpassad exportfil

1. Välj Export > Custom Export (Exportera > Anpassad export). Dialogrutan Custom Export
(Anpassad export) öppnas.

2. Välj exportformat i listrutan som visas.

3. Markera kryssrutorna för objekten som ska exporteras.

4. (Valfritt:) Klicka på Customize Column Names (Anpassa kolumnnamn) för att ändra
kolumnnamnen.

5. Klicka på Export (Exportera). Dialogrutan Save As (Spara som) visas.

6. I dialogrutan Save As (Spara som) anger du ett filnamn och en plats där den exporterade filen ska
sparas.

7. Klicka på OK för att spara exportfilen.
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Exportera till en LIMS-mapp
Du kan exportera data till ett LIMS-kompatibelt filformat.

Så här exporterar du data i LIMS-format

1. Välj Export > Export to LIMS Folder (Exportera > Exportera till LIMS-mapp).

Dialogrutan Save As (Spara som) visas.

2. I dialogrutan Save As (Spara som) anger du ett filnamn och en plats där den exporterade filen ska
sparas.

3. Klicka på OK för att spara exportfilen.

Exportera Seegene-formaterade data
Du kan exportera data från alla kalkylbladsvyer till Excel-filer som är strukturerade särskilt för
användning av Seegene, Inc.

Så här exporterar du data i ett Seegene-specifikt format

1. Välj Export > Seegene Export (Exportera > Seegene-export).

Dialogrutan Save As (Spara som) visas.

2. I dialogrutan Save As (Spara som) anger du en plats där de exporterade Seegene-formaterade
Excel-filerna ska sparas (.xlsx).

3. Klicka på OK för att spara exportfilerna.
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Kapitel 10 Dataanalysinformation
I CFX Manager™ Dx-programvarans fönster Data Analysis (Dataanalys) finns flera flikar på vilka du
kan se data. I det här kapitlet ges en detaljerad beskrivning av de flikarna.

Tips: Du kan välja vilka flikar som ska visas i fönstret Data Analysis (Dataanalys) på menyn View
(Visa). Den anpassade layouten sparas med datafilen.
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Fliken Quantification (Kvantifiering)
Använd data på fliken Quantification (Kvantifiering) för att ange dataanalysvillkor, inklusive
baslinjeinställningar för individuella brunnar och tröskelinställningar. Fliken Quantification
(Kvantifiering) visar data i dessa fyra vyer:

n Amplification chart (Amplifieringsdiagram) – visar de relativa fluorescenserna (RFU) för varje
brunn vid varje cykel. Varje kurva i diagrammet representerar data från en enskild fluorofor i en
brunn.

n Standard Cure (Standardkurva) – visas endast om körningen inkluderar brunnar som har utsett till
provtypsstandard (Std). Standardkurvan visar tröskelcykeln plottad mot loggen för den inledande
mängden. Förklaringen visar Reaction Efficiency (E) (Reaktionseffektivitet (E)) för varje fluorofor i
brunnarna med ett prov av typen Standard.

n Brunnsväljare – väljer brunnarna med fluorescensdata som du vill visa.

n Kalkylblad – visar ett kalkylblad för data som har samlats in för valda brunnar.

Fluoroforalternativ
För att visa fluorofordata på diagram och kalkylblad för fliken Quantification (Kvantifiering) väljer du
målfluoroforer under diagrammet Amplification (Amplifiering). För att dölja fluoroforinformation i
fönstret dataanalys avmarkerar du motsvarande kryssryta.
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Dialogrutan Trace Styles (Kurvutseenden)
I dialogrutan Trace Styles (Kurvutseenden) kan du justera utseendet på kurvorna i diagrammen
Amplification (Amplifiering) och Melt Curve (Smältkurva) på flikarna Quantification (Kvantifiering) och
Melt Curve (Smältkurva). Sedan kan du förhandsgranska ändringarna i brunnväljaren som visas i
dialogrutan Trace Styles (Kurvutseenden).

Så här justerar du kurvstilar

1. Välj bara en fluorofor under diagrammet Amplification (Amplifiering).

2. Gör något av följande för att öppna dialogrutan Trace Styles (Kurvutseenden):

n Klicka på Trace Styles (Kurvutseenden) i diagrammet Amplification (Amplifiering).

n Välj Settings > Trace Styles (Inställningar > Kurvutseenden) på menyraden Data Analysis
(Dataanalys).

n Högerklicka på en kurva och välj Trace Styles (Kurvutseenden).

Dialogrutan Trace Styles (Kurvutseenden) öppnas.

3. I dialogrutan Trace Styles (Kurvutseenden) väljer du en specifik uppsättning brunnar i
brunnväljaren i nedre delen av fönstret. Eller välj brunnar som innehåller en provtyp i
listrutemenyn i kolumnenWells (Brunnar).
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4. Gör något av följande:

n Välj en färg på de valda brunnarna genom att klicka i rutan i kolumnen Color (Färg).

n Tilldela en symbol till de valda brunnarna genom att välja en symbol i listrutan Symbol.

n Välj snabbt en färg på brunnarna efter knappetikett genom att klicka på lämplig
snabbinställning:

o Random byWell (Slumpmässig efter brunn)

o Random by Replicate (Slumpmässig efter replikat)

o Use Fluor Colors (Använd fluorfärger)

o Use Target Colors (Använd målfärger)

o Use Sample Colors (Använd provfärger)

n Tilldela brunnsetiketter genom att välja Sample Type (Provtyp), Target Name (Målnamn),
Sample Name (Provnamn) eller Symbol.

Alternativet Log Scale (Logaritmisk skala)
Välj Log Scale (Logaritmisk skala) under diagrammet Amplification (Amplifiering) för att visa
fluorescenskurvorna i en semilogaritmisk skala:

Tips: För att förstora en del av diagrammet drar du över målområdet. För att återgå till fullständig
vy högerklickar du i diagrammet och väljer Set Scale to Default (Ange skala som standard).
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Standardkurvdiagram
Programmet skapar ett diagram för Standard Curve (Standardkurva) på fliken Quantification
(Kvantifiering) om data inkluderar provtyper som definieras som Std (Standard) för minst en fluorofor i
körningen.

I diagrammet Standard Curve (Standardkurva) visas följande information:

n Namn på varje kurva (fluoroforen eller målet).

n Färg på varje fluorofor eller mål.

n Reaktionseffektivitet (E). Använd denna statistik för att optimera en multiplexreaktion och för att
utjämna data för en standardkurva.

Obs! Reaktionseffektiviteten beskriver hur stor del av ditt mål som produceras vid varje cykel
i protokollet. En effektivitet på 100 % indikerar att du fördubblar ditt mål vid varje cykel.

n Bestämningskoefficient, R2 (skrivs som R^2). Använd denna statistik för att bestämma hur korrekt
linjen beskriver data (hur god passformen är).

n Lutning

n y-skärning
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Menyalternativ i Amplification Chart (Amplifieringsdiagram)
Förutom de gemensamma alternativen i högerklickmeny för diagram (se Gemensamma högerklickbara
menyobjekt för diagram på sidan 180), listas i Tabell 20 menyalternativen som endast är tillgängliga i
diagrammet Amplification (Amplifiering).

Obs! Standard Curve Chart (Standardkurvdiagram) tillhandahåller endast de gemensamma
högerklickbara alternativen i menyn.

Menyalternativ Funktion

Show Threshold Values (Visa
tröskelvärden)

Visar tröskelvärdet för varje amplifieringskurva i diagrammet.

Trace Styles (Kurvutseenden) Öppnar fönstret Trace Styles (Kurvutseenden) för att ändra
kurvutseenden som visas på flikarna Quantification (Kvantifiering)
och Melt Curve (Smältkurva).

Baseline Thresholds
(Baslinjetrösklar)

Öppnar fönstret Baseline Thresholds (Baslinjetrösklar) för att
ändra baslinjen eller trösklar för respektive fluorofor (ändringar
visas i diagrammet Amplification (Amplifiering) på fliken
Quantification (Kvantifiering)).

Tabell 20. Höger- och vänsterklickbara menyobjekt i amplifieringsdiagrammet

Kalkylbladet på fliken Quantification (Kvantifiering)
I Tabell 21 definieras data som visas i kalkylbladet på fliken Quantification (Kvantifiering).

Information Beskrivning

Well (brunn) Brunnsposition i plattan

Fluor (Fluorofor) Fluorofor detekterad

Target (Mål) Målnamn som laddats i brunnarna i Plate Editor (Plattredigerare)

Content (Innehåll) En kombination av Sample Type (Provtyp) (obligatoriskt) och
Replicate # (Replikatnummer) (valfritt) som laddas i Plate Editor
(Plattredigerare)

Sample (Prov) Provnamn som laddats i brunnarna i Plate Editor (Plattredigerare)

Cq Kvantifieringscykel för varje kurva

Tabell 21. Innehåll i kalkylbladet på fliken Quantification (Kvantifiering)
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Ändra mål-, innehåll- eller provdata

Du kan ändra data i kolumnerna Target (Mål), Content (Innehåll) och Sample (Prov) genom att
redigera plattfilen med hjälp av Plate Editor (Plattredigeraren) även efter att du har avslutat
experimentet.

Så här ändrar du data i kolumnerna Content (Innehåll), Target (Mål) och Sample (Prov)

u Klicka på Plate Setup (Plattinställning) och välj sedan View/Edit Plate (Visa/redigera platta) för att
öppna Plate Editor (Plattredigerare).
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Fliken Quantification Data (Kvantifieringsdata)
Fliken Quantification Data (Kvantifieringsdata) visar kvantifieringsdata som har samlats in i varje
brunn. CFX Manager Dx-programvara visar data i fyra olika kalkylbladsvyer:

n Results (Resultat) – visar ett kalkylblad med uppgifterna. Det här är standardvyn.

n Standard Curve Results (Standardkurvresultat) – visar ett kalkylblad för standardkurvan.

n Plate (Platta) – visar data i varje i brunn som plattkarta.

n RFU – visar RFU-mängder i varje brunn för varje cykel.

Välj enskilda kalkylblad från listrutan som visas under fliken Quantification Data (Kvantifieringsdata).

Kalkylbladet Results (Resultat)
Kalkylbladet Results (Resultat) visar data för varje brunn i plattan.

Obs! Alla beräkningar av Std. Dev (Standardavvikelse) tillämpas på replikatgrupper som har
tilldelas i brunnarna i fönstret Plate Editor (Plattredigerare). Beräkningarna ger Cq-medelvärdet
för varje brunn i replikatgruppen.

I Tabell 22 definieras data som visas i kalkylbladet Results (Resultat).

Information Beskrivning

Well (Brunn) Brunnsposition i plattan

Fluor Fluorofor detekterad

Tabell 22. Innehåll i kalkylbladet Results (Resultat)
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Information Beskrivning

Target (Mål) Namn på amplifieringsmål (gen)

Content (Innehåll) Provtyp och replikatnummer

Sample (Prov) Provbeskrivning

Biological Set Name (Namn på
biologisk uppsättning)

Namn på biologisk uppsättning

Cq Kvantifieringscykel

CqMean (Cq-medelvärde) Medelvärde för replikatgruppens kvantifieringscykel

Cq Std. Dev (Cq-
standardavvikelse)

Standardavvikelse för replikatgruppens kvantifieringscykel

Starting Quantity (SQ)
(Startkvantitet)

Uppskattning av målets startkvantitet

Log Starting Quantity (Logg för
startkvantitet)

Logg för startkvantitet

SQ Mean (Medelvärde för
startkvantitet)

Medelvärde för startkvantitet

SQ Std. Dev (Cq-
standardavvikelse för
startkvantitet)

Standardavvikelse för startkvantiteten för flera replikat

Tabell 22. Innehåll i kalkylbladet Results (Resultat), forts.
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Kalkylblad för Standard Curve Results (Standardkurvresultat)
I kalkylbladet Standard Curve Results (Standardkurvresultat) visas den beräknade standardkurvans
parametrar.

I Tabell 23 definieras data som visas i kalkylbladet Standard Curve Results (Standardkurvresultat).

Information Beskrivning

Fluor (or Target) (Fluor eller
Mål)

Fluorofor (eller Mål) detekterat

Efficiency (Effektivitet) % Reaktionseffektivitet

Slope (Lutning) Standardkurvans lutning

Y-intercept (Y-skärningspunkt) Punkt där kurvan skär y-axeln

R^2 Bestämningskoefficient

Tabell 23. Innehåll i kalkylbladet Standard Curve Results (Standardkurvresultat)
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Fliken Quantification Data (Kvantifieringsdata)

Kalkylbladet Plate (Platta)
I kalkylbladet Plate (Platta) visas en plattkarta över data för en fluorofor i taget.

För att visa data för en specifik fluorofor

u Klicka på dess flik längst ned i kalkylbladet.

Kalkylbladet RFU
I kalkylbladet RFU visas avläsningarna av de relativa fluorescensenheterna (RFU) för varje brunn som
erhållits under varje cykel i körningen. Brunnsnumret visas högst upp i varje kolumn och cykelnumret
visas till vänster om varje rad.
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Fliken Melt Curve (Smältkurva)
Friskrivning: Inga rättigheter beviljas av Bio-Rad för användningen av smältkurvsanalys vid
högupplöst smältanalys inom området för in vitro-diagnostik som gäller människor eller djur.
Dessutom är det köparens ansvar att erhålla eventuella rättigheter till intellektuell egendom som kan
krävas för köparens specifika användningsområden.

När det gäller DNA-bindande färger och ej klyvbara hybridiseringsprober är fluorescensen starkast när
de två DNA-strängarna hybridiseras. Efterhand som temperaturen stiger mot smälttemperaturen (Tm),
sjunker därför fluorescensen med en konstant hastighet (konstant lutning). Vid Tm sker en dramatisk
reduktion av fluorescensen med en märkbar förändring av lutning. Hastigheten för denna förändring
bestäms genom plottning av den negativa första regressionen av fluorescens jämfört med temperatur
(-d(RFU)/dT). Den största förändringshastigheten av fluorescens leder till synbara toppar och
representerar Tm av de dubbelsträngade DNA-komplexen.

CFX Manager Dx-programvara plottar RFU-data som samlats in under en smältkurva som en funktion
av temperatur. För att analysera smälttoppdata tilldelar programmet en inledande och avslutande
temperatur till varje topp genom att flytta tröskeln. Botten i toppområdet specificeras av positionen för
smälttröskeln. En giltig topp måste ha en minimihöjd i relation till avståndet mellan tröskeln och höjden
på den högsta toppen.

På fliken Melt Curve (Smältkurva) visas Tm (smälttemperatur) för amplifierade PCR-produkter i fyra
vyer:

n Melt Curve (Smältkurva) – visar realtidsdata för varje fluorofor som RFU:er per temperatur för
varje brunn.

n Melt Peak (Smälttopp) – visar den negativa regressionen för RFU-data per temperatur för varje
brunn.

n Well selector (Brunnsväljare) – visar brunnar för att visa och dölja data.

n Toppkalkylblad – visar data som samlats in i den valda brunnen.

Obs! I detta kalkylblad visas upp till två toppar för varje kurva. Om du vill se fler toppar klickar
du på fliken Melt Curve Data (Smältkurvdata).
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Fliken Melt Curve (Smältkurva)

I Tabell 24 på sidan 203 definieras data som visas i kalkylbladet Melt Curve (Smältkurva).

Information Beskrivning

Well (Brunn) Brunnsposition i plattan

Fluor Fluorofor detekterad

Content (Innehåll) En kombination av provtyp och replikatantal

Sample (Prov) Namn på prov som laddats i Plate Editor
(Plattredigerare)

Melt Temp (Smälttemp) Temperaturen för smälttoppen för varje brunn

Obs! Endast de två högsta topparna visas i detta
kalkylblad.

Tabell 24. Innehåll i kalkylbladet Melt Curve (Smältkurva)
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Justera smältkurvdata
Så här justerar du smältkurvdata

u Gör något av följande:

n Klicka på och dra tröskelvärdesstaplarna i diagrammet Melt Peak (Smälttopp) för att
inkludera eller exkludera toppar i dataanalysen.

n Välj Positive (Positiva) i listrutemenyn Peaks (Toppar) för att visa kalkylbladsdata för toppar
över smälttröskelvärdeslinjen, eller välj Negative (Negativa) för att visa kalkylbladsdata för
toppar under smälttröskelvärdeslinjen.

n Öppnar fönstret Trace Styles (Kurvutseenden) där du kan ändra färgen på kurvorna i
diagrammen Melt Curve (Smältkurva) och Melt Peak (Smälttopp).

n Välj ett nummer i väljaren Step Number (Stegnummer) för att visa data för Melt Curve
(Smältkurva) i ett annat steg i protokollet. Listan visar fler än ett steg om protokollet innehåller
plattavläsningar i fler än ett smältkurvsteg.

n Välj brunnar i brunnsväljaren för att fokusera på delmängder av data.

n Välj en brunnsgrupp för att visa och analysera en delmängd av brunnarna i plattan. Välj varje
brunnsgrupp efter namn i listrutemenynWell Group (Brunnsgrupp) i verktygsraden.
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Fliken Melt Curve Data (Smältkurvdata)

Fliken Melt Curve Data (Smältkurvdata)
På fliken Melt Curve Data (Smältkurvdata) visas data från fliken Melt Curve (Smältkurva) i flera
kalkylblad, bl.a. alla smälttoppar för varje kurva. har fyra kalkylbladsalternativ för att visa
smältkurvdata:

n Melt Peaks (Smälttoppar) – visar alla data, däribland alla smälttoppar, för varje kurva. Det här är
standardvyn.

n Plate (Platta) – visar en vy av data och innehåll i varje brunn i plattan.

n RFU – visar RFU-kvantiteterna vid varje temperatur för varje brunn.

n -d(RFU)/dT – visar den negativa förändringshastigheten i RFU när temperaturen (T) ändras. Det
här är det första regressionsdiagrammet för varje brunn i plattan.

Välj varje kalkylblad i listrutan som visas under fliken Melt Curve Data (Smältkurvdata).

Kalkylbladet Melt Peaks (Smälttoppar)
Kalkylbladet Melt Peaks (Smälttoppar) visar alla smältkurvdata.

I Tabell 25 på sidan 206 definieras de data som visas i kalkylbladet Melt Peaks (Smälttoppar).
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Information Beskrivning

Well (Brunn) Brunnsposition i plattan

Fluor Fluorofor detekterad

Content (Innehåll) Provtyper listade i fönstret Plate Editor (Plattredigerare)

Target (Mål) Amplifieringsmål (gen)

Sample (Prov) Provnamn listat i fönstret Plate Editor (Plattredigerare)

Melt Temperature
(Smälttemperatur)

Smälttemperaturen för varje produkt, listad som en topp (högsta)
per rad i kalkylbladet

Peak Height (Topphöjd) Toppens höjd

Begin Temperature
(Starttemperatur)

Temperatur vid början av toppen

End Temperature
(Sluttemperatur)

Temperatur vid slutet av toppen

Tabell 25. Innehåll i kalkylbladet Melt Peaks (Smälttoppar)

Kalkylbladet Plate (Platta)
Kalkylbladet Plate (Platta) visar smältkurvdata i ett plattformat.

Obs! För att justera programvarutoppen justerar du tröskellinjen i diagrammet Melt Peak
(Smälttopp) på fliken Melt Curve (Smältkurva).

I Tabell 26 på sidan 207 definieras data som visas i kalkylbladet Plate (Platta).
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Fliken Melt Curve Data (Smältkurvdata)

Information Beskrivning

Content (Innehåll) En kombination av Sample Type (Provtyp) och Replicate # (Replikatnummer).
Provtyp är obligatoriskt medan replikat är valfritt.

Sample (Prov) Provbeskrivning

Peak 1 (Topp 1) Första smälttopp (högsta)

Peak 2 (Topp 2) Andra (lägre) smälttopp

Tabell 26. Innehåll i Kalkylbladet Plate (Platta)

Kalkylbladet RFU
I kalkylbladet RFU visas fluorescensen för varje brunn vid varje cykel som erhållits under smältkurvan.

I Tabell 27 definieras data som visas i RFU-kalkylbladet.

Information Beskrivning

Well Number (Brunnsnummer) (A1, A2, A3,
A4, A5)

Brunnsposition i plattan för de laddade
brunnarna

Temperature (Temperatur) Smältpunkten för det amplifierade målet, plottad
som en brunn per rad och flera brunnar för flera
produkter i samma brunn

Tabell 27. Innehåll i kalkylbladet RFU
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Kalkylbladet -d(RFU)/dT
Kalkylbladet -d(RFU)/dT visar det negativa förändringsvärdet i RFU när temperaturen (T) ändras.

I Tabell 28 definieras data som visas i kalkylbladet -d(RFU)/dT.

Information Beskrivning

Brunnsnummer (A1, A2, A3, A4, A5) Brunnsposition i plattan för de laddade brunnarna

Temperatur -d(RFU)/dT Negativt förändringsvärde i RFU när temperaturen (T)
ändras

Tabell 28. Innehåll i kalkylbladet -d(RFU)/dT
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Fliken End Point (Slutpunkt)
Öppnar fliken End Point (Slutpunkt) för analys av slutliga RFU (Relative Fluorescence Units) för
provbrunnarna. Programvaran jämför RFU-nivåerna för brunnar med okända prover med RFU-
nivåerna för brunnar med negativa kontroller och ”benämner” de okända som positiva eller negativa.
Positiva prover har ett RFU-värde som är större än det genomsnittliga RFU-värdet för de negativa
kontrollerna plus gränsvärdet (cutoff-värdet).

För att analysera slutpunktsdata måste plattan innehålla negativa kontroller, annars kan inte
programvaran göra bestämningen. Kör ett av följande två typer av protokoll:

n Kör ett protokoll av typen Quantification (Kvantifiering) – ställ in ett standardprotokoll. När
körningen är klar öppnar du fönstret Data Analysis (Dataanalys), justerar
dataanalysinställningarna på fliken Quantification (Kvantifiering) och klickar på fliken End Point
(Slutpunkt) för att välja en slutpunktscykel.

n Protokollet End Point Only (Endast slutpunkter) – läs in protokollet End Point Only (Endast
slutpunkter) på fliken Plate (Platta) i fönstret Run Setup (Körningsinställningar), välj eller skapa en
platta och starta körningen.

På fliken End Point (Slutpunkt) visas de genomsnittliga RFU-värdena för bestämning av huruvida
målet har amplifierats av den senaste (slut-) cykeln. Bestämmed hjälp av dessa data huruvida en
specifik målsekvens förekommer (positiv) i ett prov. Positiva mål har högre RFU-värden än
gränsvärdet (cutoff-värdet) som du definierar.
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Tips: Du skapar ett slutpunktsprotokoll genom att öppna fliken Protocol (Protokoll) (i fönstret Run
Setup (Körningsinställningar)) och välja Run > End Point Only Run (Kör > Körning av endast
slutpunkter).

När körningen är klar öppnas datafilen på fliken End Point (Slutpunkt), som består av följande avsnitt:

n Settings (Inställningar) – justerar dataanalysinställningarna.

n Results (Resultat) – visar resultaten omedelbart efter att du har justerat inställningarna.

n Well Selector (Brunnsväljare) – väljer brunnarna med de slutpunktsdata som du vill visa.

n RFU spreadsheet (RFU-kalkylblad) – visar slut-RFU som samlats in i de valda brunnarna.

Resultatdata
Sektionen Results (Resultat) visar följande data:

n Lowest RFU value (Lägsta RFU-värde) – lägsta RFU-värde i data

n Highest RFU value (Högsta RFU-värde) – högsta RFU-värde från data

n Negative Control Average (Genomsnitt för negativ kontroll) – genomsnittligt RFU för brunnar som
innehåller negativa kontroller

n Cut Off Value (Gränsvärde) – beräknas genom att toleransen (RFU eller andel av intervall som
anges i inställningarna) och medelvärdet för de negativa kontrollerna läggs till. Prover med
RFU:er som är större än gränsvärdet benämns "Positive" (Positiva). För att justera gränsvärdet
ändrar du RFU eller Percentage of Range (Andel av intervall)

Gränsvärdet beräknas med följande formel:

Gränsvärde = Genomsnitt för negativ kontroll + tolerans

Välj en tolerans med någon av följande metoder:

n RFUs (default) (RFU:er, standard) – välj den här metoden för att använda ett absolut RFU-värde
för toleransen. Det lägsta RFU-toleransvärdet är 2. Max är det absoluta värdet för det högsta
RFU-värdet minus det absoluta värdet för det lägsta RFU-värdet. RFU-standardtoleransvärdet är
10 % av det totala RFU-intervallet.

n Percent of Range (Andel av intervall) – välj den här metoden för att använda en andel av RFU-
intervallet för toleransen. Den lägsta andelen av intervallet är 1 %. Den högsta andelen av
intervallet är 99 %. Standardandelen av intervallet är 10 %.
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Fliken End Point (Slutpunkt)

Justera slutpunktsdataanalys
Så här justerar du data på fliken End Point (Slutpunkt)

u Gör något av följande:

n Välj en fluorofor i listrutan.

n Välj ett värde för End Cycle Average (Slutcykel för beräkning av medeltal) för att ställa in
antalet cykler som ska användas för att beräkna medeltalet av slutpunkts-RFU.

n Välj RFUs för att visa data i Relative Fluorescence Units.

n Välj Percentage of Range (Andel av intervall) för att visa data som en andel av RFU-
intervallet.

n Välj brunnar i brunnsväljaren för att fokusera på delmängder av data.

n Välj en brunnsgrupp för att visa och analysera en delmängd av brunnarna i plattan. Välj varje
brunnsgrupp efter namn i listrutemenynWell Group (Brunnsgrupp) i verktygsraden.

RFU-kalkylblad för analys av End Point (Slutpunkt)
Tabell 29 definierar data som visas i RFU-kalkylbladet på fliken End Point (Slutpunkt).

Information Beskrivning

Well (Brunn) Brunnsposition i plattan

Fluor Fluorofor detekterad

Content (Innehåll) En kombination av Sample Type (Provtyp) och Replicate # (Replikatantal)

End RFU (Slut-RFU) RFU vid slutpunktscykeln

Call (Bestämning) Positive (Positiv) eller Negative (Negativ), där positiva prover har ett RFU-
värde som är större än genomsnitts-RFU för de negativa kontrollerna plus
Cut Off Value (Gränsvärde)

Sample (Prov) Sample Name (Provnamn) laddat i Plate Editor (Plattredigerare)

Tabell 29. Innehåll i kalkylbladet End Point (Slutpunkt)
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Fliken Allelic Discrimination (Allelisk diskriminering)
Fliken Allelic Discrimination (Allelisk diskriminering) tilldelar genotyper till brunnar med okända prover.
Använd dessa data för att identifiera prover med olika genotyper, inklusive Allele 1 (Allel 1), Allele 2
(Allel 2), Heterozygote (Heterozygot), No Call (Ingen bestämning) (ingen amplifiering) eller
Undetermined (Obestämd).

Obs! Data för allelisk diskriminering måste komma från multiplexkörningar med minst två
fluoroforer. Varje fluorofor identifierar en allel i alla prover.

Allelisk diskrimineringsanalys kräver minst följande brunnsinnehåll:

n Två fluoroforer i varje brunn

n NTC-prover (no template control) för optimerad dataanalys

CFX Manager Dx-programvara erbjuder fyra alternativ för att visa allelisk diskrimineringsdata:

n Allelisk diskrimineringsdiagram – visar data i ett RFU-diagram för Allel 1/Allel 2. Varje punkt i
diagrammet representerar data från båda fluoroforer i en brunn. Du kan växla mellan
kartesianska och polära koordinater genom att markera och avmarkera kryssrutan Polar
Coordinates (Polära koordinater). Cartesian Coordinates (Kartesianska koordinater)
representerar RFU för Allel 1 på x-axeln och RFU för Allel 2 på y-axeln. Polära koordinater
representerar vinkeln på x-axeln och avståndet på y-axeln mellan RFU och ursprunget (median
för alla NTC).

n Brunnskalkylblad – visar allelisk diskrimineringsdata som samlats in i varje brunn i plattan.
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Fliken Allelic Discrimination (Allelisk diskriminering)

n Brunnsväljare – väljer brunnarna med alleliska data som du vill visa.

n Panelen Selected Fluorophores (Utvalda fluoroforer) – ändrar x- och y-axeletiketterna i
diagrammet för Allelic Discrimination (Allelisk diskriminering), cykeln som ska analyseras, och om
bestämningskartan ska visas.

Justera data för allelisk diskriminering
Programvaran tilldelar automatiskt en genotyp till brunnar med okända prover baserat på NTC-
positionerna och vinkeln samt avståndet för de okända datapunkterna från NTC.

Så här justerar du data för allelisk diskriminering

u Gör något av följande:

n Du visar polära koordinater genom att markera kryssrutan i diagrammet Allelic Discrimination
(Allelisk diskriminering).

n Du visar en annan fluorofor genom att välja den i listrutan i panelen Selected Fluorophores
(Valda fluoroforer).

n Du ändrar en bestämning genom att dra datapunkterna över diagrammet Allelic
Discrimination (Allelisk diskriminering) och välja ett alternativ i listan Selected Wells (Valda
brunnar):

o Allele 1 (Allel 1)

o Allele 2 (Allel 2)

o Heterozygote (Heterozygot)

o Undetermined (Obestämd)

o No Call (Ingen bestämning)

o Auto Call (Automatisk bestämning)

Tips: Välj Auto Call (Automatisk benämning) för att återgå till standardbenämningen.
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Alternativ på diagrammenyn
Utöver gemensamma alternativ på högerklicksmenyn för diagram (se Gemensamma högerklickbara
menyobjekt för diagram på sidan 180) finns det tillgängliga menyalternativ på diagrammet Allelic
Discrimination (Allelisk diskriminering), dessa anges i Tabell 30.

Menyalternativ Funktion

Zoom (Zooma in) Fokuserar diagramvyn till det valda området (genom att du klickar
på och drar markören i diagrammet).

Tips: Du återställer zoomningen och visar alla datapunkter
genom att högerklicka och välja Set Scale to Default (Ställ in
standardskala).

Well (Brunn) För den valda brunnen är alternativen: visa endast denna brunn, ta
bort denna brunn från vyn, ställ in färgen på denna kurva och
uteslut denna brunn från analysen.

Selected Wells (Valda brunnar) För de valda brunnarna (väljs genom att du klickar på och drar
markören i diagrammet) är alternativen: visa endast dessa
brunnar, ta bort dessa brunnar från vyn, ställ in färgen på dessa
kurvor och uteslut dessa brunnar från analysen.

Tabell 30. Alternativ på höger- och vänstermenyerna för diagrammet Allelic Discrimination
(Allelisk diskriminering)

Kalkylbladet Allelic Discrimination (Allelisk diskriminering)
I Tabell 31 definieras de data som visas i kalkylbladet Allelic Discrimination (Allelisk diskriminering).

Information Beskrivning

Well (Brunn) Brunnsposition i plattan

Sample (Prov) Provnamnsbeskrivning

Call (Bestämning) Allelens identitet, inklusive automatisk Allele 1 (Allel 1), Allele 2
(Allel 2), Heterozygote (Heterozygot), No Call (Ingen bestämning)
eller Undetermined (Obestämd)

Tabell 31. Innehåll i kalkylbladet Allelic Discrimination (Allelisk diskriminering)
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Fliken Allelic Discrimination (Allelisk diskriminering)

Information Beskrivning

Type (Typ) Auto (Automatisk) eller Manual (Manuell), beskriver hur
bestämningen gjordes. Automatisk indikerar att programvaran valde
bestämningen. Manuell indikerar att användaren valde
bestämningen

RFU1 RFU för Allel1

RFU2 RFU för Allel2

Tabell 31. Innehåll i kalkylbladet Allelic Discrimination (Allelisk diskriminering), forts.
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Fliken Custom Data View (Anpassad datavisning)
På fliken Custom Data View (Anpassad datavisning) visas flera paneler i ett anpassningsbart format
samtidigt.

Listrutan Load a Preset View (Läs in förinställningsvy) har ett urval av visningsformatmallar.
Standardvyn som visas beror på vilken fil som analyseras. Om det till exempel finns
smältkurvinformation visas standardvyn Amp+Melt.

216 | Systemen CFX96 Dx och CFX96 DeepWell Dx



Fliken Custom Data View (Anpassad datavisning)

Skapa en anpassad datavisning
Så här skapar du en anpassad datavisning

u Gör något av följande:

n Välj en alternativ förinställningsvy från listrutan.

n Välj en annan diagramvy från listrutan överst i varje enskild ruta.

n Ändra antalet rader och kolumner på fliken.

n Ändra mått för enskild panel. Dra staplarna i kanten av varje panel.

Klicka på Save as Preset (Spara som förinställning) för att spara den anpassade datavyn som en
förinställd mall. Klicka på Manage Presets (Hantera förinställningar) för att ta bort, byta namn på eller
återställa befintliga förinställningar.

Användarhandbok | 217



Kapitel 10 Dataanalysinformation

Fliken QC (Kvalitetskontroll)
Använd fliken QC (Kvalitetskontroll) för att snabbt bedöma kvaliteten på körningsdata baserat på
reglerna som definieras.

CFX Manager Dx-programvara erbjuder fyra alternativ för visning av kvalitetskontrolldata:

n Amplification chart (Amplifieringsdiagram) – visar RFU för varje brunn vid varje cykel. Varje
kurva i diagrammet representerar data från en enskild fluorofor i en brunn.

n QC rules table (Tabell för kvalitetskontrollregler) – visar tillgängliga kvalitetskontrollregler och
inställningar som definierar enskilda regler. Tillämpade kvalitetskontrollregler anges med en
bock.

n Well selector (Brunnsväljare) – väljer brunnarna med fluorescensdata som du vill visa.

n Sammanfattningsruta för kvalitetskontrollregel – visar den valda kvalitetskontrollregeln och
markerar brunnar som inte klarar regeln.

Ändra kvalitetskontrollkriterier
Så här ändrar du kvalitetskontrollkriterier

u Markera eller avmarkera kryssrutan Use (Använd) för att inkludera eller exkludera regeln från
kvalitetskontroll.
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Utesluta brunnar som inte klarar kvalitetskontrollen
CFXManager Dx-programvara visar brunnar som inte klarar kvalitetskontrollkriterier i kolumnen
Results (Resultat) i tabellen QC rules (Kvalitetskontrollregler) och i sammanfattningspanelen.

Så här utesluter du brunnar som inte klarar kriterier för kvalitetskontroll

u Välj Exclude Wells (Uteslut brunnar) för varje brunn som ska uteslutas.
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Fliken Run Information (Körningsinformation)
På fliken Run Information (Körningsinformation) visas protokollet och annan information om varje
körning. Använd den här fliken för att göra följande:

n Visa protokollet.

n Ange eller redigera anteckningar om körningen.

n Ange eller redigera ID eller streckkod för körningen.

n Visa händelser som kan ha inträffat under körningen. Använd dessa meddelanden för att hjälpa
till med felsökning av en körning.

Tips: Högerklicka på protokollet för att kopiera, exportera eller skriva ut det. Högerklicka i rutorna
Notes (Anteckningar), ID/Bar Code (ID/Streckkod) eller Other (Övrigt) för att klippa ut, kopiera,
klistra in, radera eller markera texten.
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Dataanalysrapporter

Dataanalysrapporter
I dialogrutan Report (Rapport) visas information om den aktuella datafilen i fönstret Data Analysis
(Dataanalys) (Smältstudie). För att öppna en rapport väljer du Tools > Reports.

Dialogrutan Report (Rapport) består av följande sektioner:

n Meny och verktygsrad – innehåller alternativ för att formatera, spara och skriva ut rapporten eller
mallen.

n Alternativlista (längst upp till vänster i dialogrutan) – innehåller alternativ att visa i rapporten.

n Alternativruta (längst ned till vänster i dialogrutan) – visar textrutor i vilka du kan skriva in
information om ett visst alternativ.

n Förhandsgranskningsruta (till höger i dialogrutan) – visar en förhandsgranskning av den aktuella
rapporten.
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Rapportkategorier för dataanalys
I Tabell 32 visas alla alternativ som är tillgängliga för en dataanalysrapport beroende på typ av data
som används i fönstret Data Analysis (Dataanalys).

Kategori Alternativ Beskrivning

Rubrik

Titel, undertitel och logotyp för rapporten

Report Information
(Rapportinformation)

Körningsdatum, användarnamn,
datafilnamn, datafilsökväg och vald
brunnsgrupp

Audit Information
(Granskningsinformation)

Ytterligare information som krävs för
granskning, inklusive signaturer

Notes (Anteckningar) Anteckningar om datarapporten

Run Setup (Körningsinställning)

Run Information
(Körningsinformation)

Körningsdatum, användarnamn,
datafilnamn, datafilsökväg och vald
brunnsgrupp

Protocol (Protokoll) Textvy av protokollsteg och alternativ

Plate Display (Plattvy) Plattvy av informationen i varje brunn för
plattan

Quantification (Kvantifiering)

Analysis Settings
(Analysinställningar)

Stegnummer för datainsamling,
analysläge och metod för
baslinjesubtraktion

Amplifiering
(Amplifieringstabell)

Amplifieringstabell för körningar som
inkluderar kvantifieringsinformation

Standard Curve Chart
(Standardkurvdiagram)

Standardkurvdiagram

Data Kalkylblad som listar data för varje brunn

Tabell 32. Rapportkategorier för dataanalys i alternativlistan
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Kategori Alternativ Beskrivning

Gene Expression (Genuttryck) – stapeldiagram

Analysis Settings
(Analysinställningar)

Analysläge, diagramdata, skalalternativ
och diagramfel

Chart (Diagram) Kopia av stapeldiagrammet

Target Names (Målnamn) Diagrammed målnamn

Sample Names (Provnamn) Diagrammed provnamn

Data Kalkylblad som listar data för varje brunn

Target Stability (Målstabilitet) Diagram för målstabilitetsvärden

Gene Expression (Genuttryck) Clustergram och Scatter Plot (Spridningsdiagram)

Analysis Settings
(Analysinställningar)

Inställningar för respektive typ av
diagram

Chart (Diagram) Kopia av diagrammet

Data Kalkylblad som listar data i varje mål

Melt Curve (Smältkurva)

Analysis Settings
(Analysinställningar)

Inställning för smältstegnummer och
tröskelvärde

Melt Curve Chart (Diagram för
smältkurva)

Diagram för smältkurva

Melt Peak Chart (Diagram för
smälttopp)

Diagram för smälttopp

Data Kalkylblad som listar data för varje brunn

Allelic Discrimination (Allelisk diskriminering)

Analysis Settings
(Analysinställningar)

Visar fluoroforer, cykel och visning av
anropskarta

Tabell 32. Rapportkategorier för dataanalys i alternativlistan, forts.
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Kategori Alternativ Beskrivning

Allelic Discrimination Chart
(Tabell för allelisk
diskriminering)

Kopia av diagrammet för allelisk
diskriminering

Data Kalkylblad som listar data för varje brunn

End Point (Slutpunkt)

Analysis Settings
(Analysinställningar)

Fluorofor, avslutande cykler vars
medelvärde ska beräknas, läge, lägsta
RFU-värde, högsta RFU-värde och
gränsvärde

Data Kalkylblad som listar data för varje brunn

QC Parameters (Kvalitetskontrollparametrar)

Data Kalkylblad som anger parametrar för
varje kvalitetskontrollregel

Tabell 32. Rapportkategorier för dataanalys i alternativlistan, forts.
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Skapa en dataanalysrapport
Du kan spara rapportlayouten som en mall och använda den igen för liknande rapporter.

Så här skapar du en datarapport

1. Gör slutliga justeringar av innehållet i brunnen, valda brunnar, diagram och kalkylblad i fönstret
Data Analysis (Dataanalys) innan du genererar rapporten.

2. Välj Tools > Reports (Verktyg > Rapporter) på menyraden Data Analysis (Dataanalys) för att
öppna dialogrutan Report (Rapport).

3. Välj alternativen du vill inkludera i rapporten. Rapporten öppnas med standardalternativ valda.
Markera eller avmarkera kryssrutorna för att ändra hela kategorier eller enskilda alternativ inom
en kategori.

Obs! Data som visas i rapporten beror på aktuella val på flikarna för fönstret Data Analysis
(Dataanalys) (Smältstudie). En kvantifieringskörning innehåller till exempel inte en
standardkurva, och därför visas dessa data i fönstret Data Analysis (Dataanalys) eller i
datarapporten.

4. Ändra ordningsföljden på kategorier och objekt i en rapport. Dra alternativen till motsvarande
plats. Objekt kan bara flyttas inom kategorierna de tillhör.

5. (Valfritt) Ange information som är relevant för det valda alternativet i rutan Report Options
(Rapportalternativ):

n Välj en informationsundergrupp att visa i rapporten.

n Välj specifika inställningar för det valda alternativet.

n Välj text som ska visas för det valda alternativet.

6. Klicka på Update Report (Uppdatera rapport) för att uppdatera Report Preview
(Rapportförhandsgranskning) med eventuella ändringar.

7. Skriv ut eller spara rapporten. Klicka på knappen Print Report (Skriv ut rapport) i verktygsraden
för att skriva ut den aktuella rapporten. Välj File > Save (Arkiv > Spara) för att spara rapporten i
filformatet PDF (Adobe Acrobat Reader-fil) och välj en plats där filen ska sparas. Välj File > Save
As (Arkiv > Spara som) för att spara rapporten med ett nytt namn eller på en ny plats.

8. (Valfritt) Skapa en rapportmall med den information du vill ha. För att spara de aktuella
rapportinställningarna i en mall väljer du Template > Save (Mall > Spara) eller Save As (Spara
som). Hämta sedan rapportmallen nästa gång du vill skapa en ny rapport.
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Skapa Well Group Reports (Brunnsgrupprapporter)
För att skapa en brunnsgrupprapport

1. Välj Tools > Well Group Reports (Verktyg > Brunnsgruppsrapporter) i fönstret Data Analysis
(Dataanalys).

2. I dialogrutan Well Groups Reports (Brunnsgrupprapporter) väljer du de brunnsgrupper,
amplifieringssteg och smältsteg som ska ingå i rapporten.

3. Ange sökvägen eller gå till destinationsmappen där rapporten ska sparas.

4. (Valfritt) Välj Choose a Report Template (Välj en rapportmall) och gå till mallfilmappen.

5. (Valfritt) Välj Open Destination Folder (Öppna destinationsmapp) för att öppna mappen och visa
rapporterna när de har skapats.

6. Klicka på Create Reports (Skapa rapporter).
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Med användning av strikt kvalificerade kontroller i dina reaktioner kan du använda programmet CFX
Manager™ Dx för att utföra en genuttryckskörning för att normalisera de relativa skillnaderna i en
målkoncentration bland prover. Vanligtvis används uttrycksnivåer för en eller flera referensgener för
att normalisera uttrycksnivåerna för en intressant gen. Referensgener tar hänsyn till
laddningsskillnader eller andra variationer som representeras i respektive prov och deras
uttrycksnivåer bör inte påverkas i det biologiska systemet som studeras.

Välj fliken Gene Expression (Genuttryck) i fönstret Data Analysis (Dataanalys) för att utvärdera
relativa skillnader mellan PCR-reaktioner i två eller flera brunnar. Du kan till exempel utvärdera relativt
antal virusgenom eller relativt antal transfekterade sekvenser i en PCR-reaktion. Det vanligaste
användningsområdet för genuttrycksstudier är jämförelsen av cDNA-koncentration i fler än en reaktion
för att uppskatta nivåerna av budbärar-RNA i steady state.

Programmet beräknar den relativa uttrycksnivån för ett mål med ett av dessa scenarier:

n Relativ uttrycksnivå för en målsekvens (Mål 1) i relation till ett annat mål (Mål 2); till exempel
mängden av en gen i relation till en annan gen under samma provbehandling.

n Relativ uttrycksnivå för en målsekvens i ett prov jämfört med sammamål under olika
provbehandlingar;. till exempel den relativa mängden av en gen i relation till sig själv under olika
tidsmässiga, geografiska eller utvecklingsvillkor.

Plattinställning för genuttrycksanalys
För att utföra en genuttrycksanalys måste innehållen i brunnarna innefatta följande:

n Två eller fler mål – de två målen som representerar olika amplifierade gener eller sekvenser i
proverna.

n Ett eller flera referensmål – minst ett mål måste vara ett referensmål för normaliserat uttryck.
Tilldela alla referensmål i fönstret Experiment Settings (Experimentinställningar) och analysera
data i läget Normalized Expression (Normaliserat uttryck) (ΔΔCq). Körningar som inte innehåller
en referens måste analyseras i läget Relative Expression (Relativt uttryck) (ΔCq).
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n Gemensamma prover – reaktionerna måste innehålla gemensamma prover (minst två krävs) för
att visa data som plottas på fliken Gene Expression (Genuttryck). Dessa prover ska representera
olika behandlingar eller villkor för var och en av målsekvenserna. Tilldela ett kontrollprov (valfritt) i
fönstret Experiment Settings (Experimentinställningar). Om ingen kontroll har valts använder
programvaran lägsta Cq som kontroll.

Kraven för inställning av Gene Expression (Genuttryck) i Plate Editor (Plattredigerare) beror på
huruvida reaktionsinnehållen är singleplex-PCRmed en fluorofor i reaktionerna, eller multiplex-PCR
med fler än en fluorofor i reaktionerna.

Guidad plattinställning
Om plattinställningen för en datafil inte innehåller informationen som krävs för analys och fliken Gene
Expression (Genuttryck) är vald visas i utrymmet som normalt är reserverat för stapeldiagrammet
anvisningar för hur du anger den här informationen. Följ stegen nedan för normaliserat genuttryck:

1. Definiera mål- och provnamn med något av följande:

n Plate Setup (Plattinställning) – öppnar fönstret Plate Editor (Plattredigerare)

n Replace Plate file (Ersätt plattfil) – öppnar webbläsaren Select Plate (Välj platta), i vilken du
kan navigera till en tidigare sparad plattfil med vilken du kan ersätta den aktuella
plattlayouten.

n Replace PrimePCR file (Ersätt PrimePCR-file) – öppnar dialogrutan Select PrimePCR file
(Välj PrimePCR-file) i vilken du kan navigera till en PrimePCR™-körningsfil och använda den
på plattlayouten.

2. Välj ett eller flera referensmål samt ett kontrollprov med hjälp av dialogrutan Experiment Settings
(Experimentinställningar).

Om plattlayouten redan innehåller mål- och provinformation krävs endast det andra steget, som
markeras med orange färg. Det här steget måste utföras före analys av normaliserat genuttryck.

Obs! Data för clustergram och spridningsdiagram visas endast om alla villkor för
normaliserat genuttryck som anges under Plattinställning för analys av genuttryck har
uppfyllts.
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Genuttrycksdiagram
CFXManager Dx-programvaran visar genuttrycksdata i flera vyer. I Tabell 33 listas
diagramalternativen som är tillgängliga i programvaran.

Knapp Namn Funktion

Bar Chart (Stapeldiagram) Visar data för normaliserat genuttryck i
stapeldiagramsformat.

Clustergram Visar data för normaliserat genuttryck i en
hierarki baserat på graden av likhet av
uttryck för olika mål och prover.

Scatter Plot (Spridningsdiagram) Visar det normaliserade uttrycket av mål för
en kontroll jämfört med ett experimentellt
prov.

Results (Resultat) Sammanfattar data från alla diagram.

Tabell 33. Alternativ för genuttrycksdiagram
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Bar Chart (Stapeldiagram)

Det relativa uttrycket av mål visas i dessa två vyer:

n Diagram för Gene Expression (Genuttryck) – visar PCR-realtidsdata som något av följande:

o ΔΔCq – relativt normaliserat uttryck beräknat med användning av kontrollprover och referensmål.

o ΔCq – relativ kvantitet av målgenen i ett prov i relation till ett kontrollprov.

n Kalkylblad – visar ett kalkylblad för genuttrycksdata.

Tips: Högerklicka på valfritt diagram eller kalkylblad för alternativ. Välj View/Edit Plate
(Visa/redigera platta) från den nedrullningsbara menyn Plate Setup (Plattinställning) för att
öppna Plate Editor (Plattredigerare) och ändra brunnsinnehållet i plattan.

Tips: Välj Sort (Sortera) från högerklickmenyn för att ändra ordningen på namnen på Target
(Mål) och Sample (Prov) i diagrammet.
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Normaliserat genuttryck

Använd den uppmätta uttrycksnivån för en eller flera referensgener som normaliseringsfaktor för att
normalisera data. Referensgener är mål som inte regleras i det biologiska systemet som studeras, till
exempel actin,GAPDH eller tubulin.

Så här konfigurerar du en analys av normaliserat genuttryck (ΔΔCq)

1. Öppna en datafil (.pcrd-tillägg)

2. Granska uppgifterna på fliken Quantification (Kvantifiering) i fönstret Data Analysis (Dataanalys).
Justera data, till exempel ändring av tröskel och analysläge.

3. Välj fliken Gene Expression (Genuttryck).

4. Klicka på Experiment Settings (Experimentinställningar) på fliken Gene Expression (Genuttryck)

5. Gör följande i dialogrutan Experiment Settings (Experimentinställningar):

a. Välj fliken Samples (Prover) och välj en kontroll. När en kontroll tilldelas normaliserar CFX
Manager Dx-programvara de relativa kvantiteterna för alla gener med kontrollkvantiteten, som är
inställd på 1.

b. Välj fliken Target (Mål) och välj referensgener. Analys av genuttryck kräver en referens bland
målen i dina prover.

6. Välj Normalized Expression (Normaliserat uttryck) (ΔΔCq) om det inte redan är valt och visa
sedan uttrycksnivåerna på fliken Gene Expression (Genuttryck).

Relativ kvantitet

Per definition är data för relativ kvantitet (ΔCq) inte normaliserade. Denna metod används för att
kvantifiera prover som inte innehåller några referensgener (mål). Forskare brukar förlita sig på ett av
följande beaktanden när de förbereder sin körning:

n Varje prov innehåller sammamängd massa av RNA eller cDNA i varje brunn.

n Alla variationer i mängden laddat biologiskt prov kommer att normaliseras efter körningen med
någon metod i dataanalysen utanför programmet. Exempelvis kan en forskare välja att dividera det
relativa kvantitetsvärdet med den normaliserande faktorn, eventuellt massan av laddad nukleinsyra
för varje prov, eller antalet celler från vilka nukleinsyran har isolerats.
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För att köra en analys av Relative Quantity (Relativ kvantitet) (ΔCq)

u På fliken Gene Expression (Genuttryck), välj Relative Quantity (Relativ kvantitet) (ΔCq) från den
nedrullningsbara listan Mode (Läge) i höger ruta.

Tips: Du kan jämföra resultat med data från andra genuttryckskörningar genom att öppna en
ny genstudie eller lägga till en datafil till en befintlig genstudie.

Sortera mål- och provdata
Obs! Det här alternativet är endast tillgängligt för genuttrycksdiagram.

Som standard visas listorna Targets (Mål) och Samples (Prover) i alfabetisk ordning. I dialogrutan Sort
(Sortera) kan du sortera visningen i omvänd alfabetisk ordning eller manuellt flytta ett villkor till en
annan plats i listan.

Så här sorterar du data för mål och prover

1. Klicka på Sort (Sortera) på diagrammets högerklicksmeny.

Dialogrutan Gene Expression Chart Sorting (Sortering i genuttrycksdiagram) öppnas.

2. I dialogrutan klickar du på Z-A för att sortera listan i omvänd alfabetisk ordning.

3. Du flyttar ett villkor manuellt genom att välja det och klicka på lämplig knapp mellan diagrammen:

n Klicka på uppåt- eller nedåtpilen för att flytta det valda villkoret en position.

n Klicka på uppåt- eller nedåtpilen för att flytta det valda villkoret till toppen eller botten av
listan.

4. Klicka på OK för att spara ändringarna och återgå till fliken Gene Expression (Genuttryck).
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Justera data för Gene Expression (Genuttryck)
När du har valt analysläge – normaliserat uttryck (∆∆Cq) eller relativ kvantitet (∆Cq) justerar du de
data du ser på fliken Gene Expression (Genuttryck) genom att ändra inställningsalternativen till höger
om diagrammet.

Tips: Du ställer in standardalternativen för data för Gene Expression (Genuttryck) i dialogrutan User
Preferences (Användarinställningar) (se Ställa in standardparametrar för genuttrycksdatafil på sidan 69).

Diagramdata

Ställ in y-axelvärdet på Linear (Linjär) skala för att aktivera alternativen för diagramdata. Med
alternativen för diagramdata kan du presentera data i diagrammet med ett av följande alternativ:

n Relative to control (I förhållande till kontroll) – rita data med axeln skalad från 0 till 1. Om du
tilldelar en kontroll i körningen väljer du det här alternativet för att snabbt visualisera målets
uppreglering och nedreglering.

n Relative to zero (I förhållande till noll) – rita datan med origo på noll.

Kontrollprov

Använd listrutemenyn Control Sample (Kontrollprov) och välj ett prov som ska användas för att
normalisera Relative Quantity (Relativ kvantitet):

Diagraminställningar

Följande alternativ (beskrivs nedan) visas när rutan Show Chart Settings (Visa diagraminställningar)
markeras: X-Axis (X-axel), Y-Axis (Y-axel), Salling (Skalning), Error Type (Feltyp) och Chart Error
Multiplier (Diagramfelsmultiplikator).

X-axelalternativ

X-axis option (x-axelalternativet) gör det möjligt att välja x-axeldata för diagrammet Gene Expression
(Genuttryck):

n Target (Mål) – ritar målnamnen på x-axeln.

n Sample (Prov) – ritar provnamnen på x-axeln.
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Y-axelalternativ

Y-axis option (y-axelalternativet) gör det möjligt att visa diagrammet Gene Expression (Genuttryck) i
en av följande tre skalor:

n Linear (Linjär) – välj om du vill visa en linjär skala.

Tips: När y-axeln ställs in på Linear (Linjär) aktiveras listrutan Graph Data (Diagramdata) där
du kan välja att rita data i förhållande till kontrollen eller i förhållande till noll.

n Log 2 (Logaritm 2) – välj om du vill utvärdera prover över ett stort dynamiskt intervall.

n Log 10 (Logaritm 10) – välj om du vill utvärdera prover över ett mycket stort dynamiskt intervall.

Skalningsalternativ

Välj Normalized Gene Expression (Normaliserat genuttryck) (ΔΔCq) och ställ in Control Sample
(Kontrollprov) på None (Inget) för att aktivera skalningsalternativen i diagrammet Gene Expression
(Genuttryck). Välj ett av följande skalningsalternativ för att beräkna och presentera data på det sätt
som bäst passar körningsutformningen:

n Unscaled (Oskalat) – presenterar det oskalade normaliserade genuttrycket.

n Highest (Högsta) – skalar det normaliserade genuttrycket för varje mål genom att dividera
uttrycksnivån för varje prov med den högsta nivån av uttryck i alla prover.

Det här skalningsalternativet använder skala-till-högsta-formeln.

n Lowest (Lägsta) – skalar det normaliserade genuttrycket för varje mål genom att dividera
uttrycksnivån för varje prov med den lägsta nivån av uttryck i alla prover.

Det här skalningsalternativet använder skala-till-lägsta-formeln.

n Average (Medelvärde) – skalar det normaliserade genuttrycket för varje mål genom att dividera
uttrycksnivån för varje prov med det geometriska medelvärdet av uttrycksnivåerna för alla prover.

Det här skalningsalternativet använder skala-till-medel-formeln.

Feltyp

Välj ett alternativ för typen av felberäkningar (felstaplar) i diagrammet Gene Expression (Genuttryck):

n Standard error of the mean (Medelvärdets standardfel) (standard)

n Standard deviation (Standardavvikelse)
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Diagrammultiplikator för felstaplar

Välj en multiplikator för felstaplarna i diagrammet Gene Expression (Genuttryck). Välj ett av dessa
heltal:
+/– 1 (standard), 2 eller 3. Typen av multiplikator ändras när du väljer feltypen:

n SEMs for standard error of the mean (SEM för medelvärdets standardfel)

n Std Devs for standard deviations (SD för standardavvikelser)

Experiment Settings (Experimentinställningar)
Tips: Den här dialogrutan är också tillgänglig i Plate Editor (Plattredigerare). Se Ändra
Experiment Settings (Experimentinställningar) på sidan 130 för mer information.

I dialogrutan Experiment Settings (Experimentinställningar) kan du visa eller ändra listan med mål
eller prover, välja referensgener, välja kontroller eller ange gruppen Gene Expression Analysis
(Genuttrycksanalys) som ska analyseras om namn på biologiska uppsättningar har lagts till i
brunnarna.

Så här öppnar du dialogrutan Experiment Settings (Experimentinställningar)

u På fliken Bar Chart (Stapeldiagram) klickar du på Experiment Settings (Experimentinställningar)
längst ned i den högra rutan.

Dialogrutan Experiment Settings (Experimentinställningar) visas med fliken Targets (Mål).
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Så här justerar du målinställningar

u Gör något av följande på fliken Targets (Mål):

n För att välja ett mål som referens för dataanalys av genuttryck väljer du namnet i kolumnen
Reference (Referens).

n För att ändra färgen på målet klickar du på dess cell i kolumnen Color (Färg) och ändrar
färgen i dialogrutan Color (Färg) som visas.

Färgförändringen visas i Gene Expression-tabellerna (Genuttryck).

n För att använda ett tidigare definierat effektivitetsvärde ska du avmarkera målets kryssruta i
kolumnen Auto Efficiency (Automatisk effektivitet) och ange ett nummer för målets
effektivitetsandel.

Programvaran beräknar den relativa effektiviteten för ett mål med Auto Efficiency
(Automatisk effektivitet) om data för ett mål inkluderar en standardkurva.

Så här ändrar du inställningarna för prov

u Gör något av följande på fliken (Prover och biologiska grupper):

n För att välja ett prov som kontroll för dataanalys av genuttryck väljer du det i kolumnen
Control (Kontroll).

n För att ändra färgen på provet klickar du på dess cell i kolumnen Color (Färg) och ändrar
färgen i dialogrutan Color (Färg) som visas.

Färgförändringen visas i Gene Expression-tabellerna (Genuttryck).

n För att visa provet i Gene Expression-diagrammen (Genuttryck) väljer du det i kolumnen
Show Chart (Visa diagram).

n För att ta bort provet från Gene Expression-diagrammen (Genuttryck) tar du bort det i
kolumnen Show Chart (Visa diagram).

Tips: Provets gruppens data blir kvar i tabellen Results (Resultat).

Så här ändrar du valen Biological Set Analysis Options (Analysalternativ för biologisk
uppsättning)

u Om du har tilldelat en eller flera biologiska uppsättningar till brunnar i plattan (se Tilldela biologiska
uppsättningar till brunnar på sidan 124), visas listan Biological Set Analysis Options
(Analysalternativ för biologisk uppsättning) i dialogrutan Experiment Settings
(Experimentinställningar) så att du kan ändra urvalet efter behov.
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n Target vs. Sample (Mål kontra prov) – endast brunnens provnamn används för beräkning
av genuttryck.

n Target vs. Biological Set (Mål kontra biologisk uppsättning) – endast namnet för den
biologiska uppsättningen används i beräkningarna.

n Target vs. Sample_Biological Set (Mål kontra biologisk provuppsättning) – provnamnet
och namnet på den biologiska uppsättningen kombineras och skapar ett enda namn som
används i beräkningarna.

n Target vs. Biological Set_Sample (Mål kontra biologisk provuppsättning) – provnamnet
och namnet på den biologiska uppsättningen kombineras och skapar ett enda namn som
används i beräkningarna.

Så här exkluderar du en provtyp från analysberäkningar

u Markera motsvarande kryssruta längst ned i dialogrutan Experiment Settings
(Experimentinställningar)

Obs! Det här utesluter kontroller och/eller standarder från analys av genuttryck.

Målstabilitetsvärde
Målstabilitetsvärden beräknas när fler än en referensgen används. Programmet CFX Manager Dx
beräknar två kvalitetsparametrar för referensgenerna:

n Koefficient Variance (Variationskoefficient) (CV) för normaliserade relativa kvantiteter av
referensgen. Ett lägre CV-värde betecknar högre stabilitet.

n M Value (M-värde) (M), ett mått på stabiliteten i referensgensuttrycket.

Rekommenderade CV- och M-värden visas längst ned i dialogrutan Stability Value (Stabilitetsvärde).

För att visa målstabilitetsvärdet

u På fliken Gene Expression Bar Chart (Stapeldiagram för genuttryck), klicka på Target Stability
Value (Målstabilitetsvärde) längst ner i den högra rutan.

Dialogrutan Stability Value (Stabilitetsvärde) visas.
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Alternativ i högerklickmeny
Högerklicka på genuttrycksdiagrammet för att markera objekt som visas i Tabell 34.

Objekt Funktion

Copy (Kopiera) Kopierar diagrammet till ett urklipp.

Save Image As (Spara bild som) Sparar tabellen som en bildfil. Ange upplösning och mått för bilden
och välj sedan filtyp (PNG, GIF, JPG, TIF eller BMP).

Page Setup (Utskriftsformat) Väljer ett utskriftsformat för utskrift.

Print (Skriv ut) Skriver ut tabellen.

Set Scale to Default (Ange skala
som standard)

Show All (Visa alla) visar alla data i stapeldiagrammet. Scroll Bar
(Rullningslist) visas om antalet prover inte kan visas i diagrammets
ram samtidigt somminimibredden på listen upprätthålls.

Chart Options
(Diagramalternativ)

Öppnar fönstret Chart Options (Diagramalternativ) för att justera
grafen.

Sort (Sortera) Sorterar ordningen av prover eller mål som visas på tabellens x-
axel.

Use Corrected Std Devs
(Använd korrigerade
standardavvikelser)

Beräknar felstaplarna med hjälp av formeln för korrigerad
standardavvikelse.

Use Solid Bar Colors (Använd
solida stapelfärger)

Visar solida staplar i diagrammet.

X–Axis Labels (Etiketter för x-
axeln)

Visar x-axelns etiketter vågrätt eller vinklade.

Tabell 34. Menyobjekt i högerklicksmenyn för genuttryck
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Datakalkylblad
I Tabell 35 definieras de data som visas i datatabellen Gene Expression (Genuttryck).

Obs! Värden i tabellen beräknas baseras på typ av graf och inställningar som har valts i den
högra rutan.

Information Beskrivning

Target (Mål) Valt målnamn (amplifierad gen) i fönstret Experiment Settings
(Experimentinställningar).

Prov Valt namn på prov i fönstret Experiment Settings
(Experimentinställningar).

Ctrl Valt kontrollnamn i fönstret Experiment Settings
(Experimentinställningar).

Relativ kvantitet eller
Expression (Uttryck)

Relativ kvantitet (ΔCq) eller normaliserat genuttryck (ΔΔCq),
beroende på valt läge.

Relativ kvantitet eller uttrycks-
SEM (eller SD)

Medelvärdets standardfel (SEM) eller standardavvikelse (SD) för
relativ kvantitet eller normaliserat uttryck, beroende på vilket
alternativ som är valt.

Korrigerad relativ kvantitet eller
uttrycks-SEM (eller SD)

Korrigerad värdeberäkning för SEM eller SD för relativ kvantitet eller
normaliserat uttryck, beroende på vilket alternativ som är valt.

Mean (Medelvärde för) Cq Medelvärde för kvantifieringscykeln.

Cq SEM (eller SD) SEM eller SD för kvantifieringscykeln, beroende på valt alternativ.

Tabell 35. Beskrivning av informationen i kalkylbladet på fliken Bar Chart (Stapeldiagram)
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Alternativet Show Details (Visa detaljer)
Tabell 36 definierar de data som visas när Show Details (Visa detaljer) väljs i högerklickmenyn i
kalkylbladet för stapeldiagrammet.

Information Beskrivning

Data Set (Datauppsättning) Fluorescensdata från en fluorofor i datafilen

Relative Quantity (Relativ
kvantitet)

Beräknad relativ kvantitet av prover

Relative Quantity SD (SD för
relativ kvantitet)

Standardavvikelse för beräkningen av relativ kvantitet

Corrected Relative Quantity SD
(SD för korrigerad relativ
kvantitet)

Beräknad standardavvikelse för den korrigerade relativa kvantiteten

Relative Quantity SEM (SEM för
relativ kvantitet)

Medelvärdets standardfel för beräkningen av relativ kvantitet

Corrected Relative Quantity
SEM (SEM för korrigerad relativ
kvantitet)

Beräknat medelvärdesstandardfel för den korrigerade relativa
kvantiteten

Relative Quantity (Relativ
kvantitet(lg))

Log2 för den relativa kvantitet som används för statistisk analys

SD RQ(lg) Standardavvikelse för den relativa kvantiteten (log2)

SEM Expression (SEM för
uttryck(lg))

Medelvärdets standardfel för uttrycket (log2)

Unscaled Expression (Ej skalat
uttryck)

Beräknat ej skalat uttryck

Unscaled Expression SD (SD
för ej skalat uttryck)

Beräknad standardavvikelse för det ej skalade uttrycket

Corrected Unscaled Expression
SD (SD för korrigerat ej skalat
uttryck)

Beräknad standardavvikelse för det korrigerade ej skalade uttrycket

Tabell 36. Information i kalkylbladet för stapeldiagrammet med Show Details (Visa detaljer)
valt
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Information Beskrivning

Unscaled Expression SEM
(SEM för ej skalat uttryck)

Beräknat medelvärdesstandardfel för det ej skalade uttrycket

Corrected Unscaled Expression
SEM (SEM för korrigerat ej
skalat uttryck)

Beräknat medelvärdesstandardfel för det korrigerade ej skalade
uttrycket

Unscaled Expression (Ej skalat
uttryck(lg))

Log2 för det ej skalade uttrycket

SD Unscaled Expression (SD ej
skalat uttryck(lg))

Standardavvikelse för det ej skalade uttrycket (log2)

SEM Unscaled Expression
(SEM för ej skalat uttryck(lg))

Medelvärdets standardfel för det ej skalade uttrycket (log2)

Expression (Uttryck) Normaliserat genuttryck

Corrected Expression SD (SD
för korrigerat uttryck)

Beräknad standardavvikelse

Expression SEM (SEM för
uttryck)

Medelvärdets standardfel

Corrected Expression SEM
(Korrigerat SEM för uttryck)

Beräknat medelvärdesstandardfel

Expression (Uttryck(lg)) Log2 för uttrycket (normaliserat uttryck) som används för statistisk
analys

SD Expression (SD för uttryck
(lg))

Standardavvikelse för uttrycket (log2)

SEM Expression (SEM för
uttryck(lg))

Medelvärdets standardfel för uttrycket (log2)

Mean (Medelvärde för) Cq Medelvärde för kvantifieringscykeln

Cq SD (SD för Cq) Standardavvikelse för kvantifieringscykeln

Cq SEM (SEM för Cq) Medelvärdesstandardfel för kvantifieringscykeln

Tabell 36. Information i kalkylbladet för stapeldiagrammet med Show Details (Visa detaljer)
valt, forts.
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Clustergram
Clustergrammet visar data i en hierarki baserad på graden av likhet i uttryck för olika mål och prover.

Obs! Du måste välja ett referensmål för att visa någon annan dataplott än relativt uttryck för
stapeldiagram.

Clustergrambilden avbildar relativt uttryck för ett prov eller mål på följande sätt:

n Uppreglering (röd) – högre uttryck

n Nedreglering (grön eller blå färg) – lägre uttryck

n Ingen reglering (svart)

n Inget värde beräknat (svart med ett vitt X)

Ju ljusare färgnyans, desto större skillnad i relativt uttryck. Om inget värde för normaliserad Cq kan
beräknas, är rutan svart med ett vitt X.

I ytterkanterna av dataplotten finns ett dendrogram, vilket indikerar klusterhierarkin. Mål eller prover
med likartade uttrycksmönster kommer att ha angränsande grenar medan de med olikartade mönster
kommer att ha ett större avstånd.

Settings (Inställningar)
Det går att ställa in följande alternativ:

n Cluster By (Klusterindela efter) – välj Targets (Mål), Samples (Prover), Both (Båda) eller None
(Ingen).

n Size (Storlek) – justerar bildstorleken och ändrar graden av diagramförstoring.

n Split Out Replicates (Dela upp replikat) – visar värdena för enskilda replikat.

Tips: Det går att ändra färgschemat för klusterdiagram och punktdiagram från röd/grön (standard) till
röd/blå genom att välja det alternativet på högerklicksmenyn i båda dessa diagram.

Alternativ i högerklickmeny
Alternativen i högerklickmenyn för clustergrammet är identiska med alternativen för
stapeldiagrammet. Se Tabell 34 på sidan 238 för tillgängliga alternativ. Välj dessutom Color Scheme
(Färgschema) för att ändra nedregleringsuttrycket från standarden Röd/Grön till Röd/Blå i
diagrammet.
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Datakalkylblad
I kalkylbladet visas värden för målet, provet och normaliserat uttryck. Klicka i kryssrutan bredvid ett
mål för att inkludera det i eller utesluta det från plotten.
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Scatter Plot (Spridningsdiagram)
Spridningsdiagrammet visar det normaliserade uttrycket av mål för en kontroll jämfört med ett
experimentprov. Linjerna i diagrammet anger regleringströskelvärdet. Datapunkter mellan linjerna indikerar
att skillnaden i uttryck för det målet (genen) är försumbar mellan proverna. Datapunkter utanför linjerna
överskrider regleringströskelvärdet och kan vara av intresse.

Diagrambilden visar följande förändringar i måluttryck baserat på regleringströskelvärdet:

n Uppreglering (röd cirkel) – relativt högre uttryck

n Nedreglering (grön eller blå cirkel) – relativt lägre uttryck

n Ingen förändring (svart cirkel)

Klicka på och dra endera tröskelvärdeslinje för att justera regleringströskelvärdet.

Inställningar
Det går att ställa in följande alternativ:

n Control Sample (Kontrollprov)

n Experimental Sample (Experimentprov)

n Regulation Threshold (Regleringströskelvärde). När du ökar eller minskar regleringsvärdet flyttas
tröskelvärdeslinjerna i diagrammet i enlighet därmed.

Alternativ i högerklickmeny
Alternativen i högerklickmenyn för spridningsdiagrammet är identiska med alternativen för
stapeldiagrammet. Se Tabell 34 på sidan 238 för tillgängliga alternativ. Välj dessutom Symbol för att
ändra symbolen som används i plotten från standardcirkeln till en av följande:

n Triangle (Triangel)

n Cross (Kors)

n Square (Fyrkant)

n Diamond (Romb)

Datakalkylblad
I kalkylbladet visas värden för målet och normaliserat uttryck för kontroll- och experimentprover. Här
visas också ommål är upp- eller nedreglerade jämfört med regleringströskeln. Klicka i kryssrutan
bredvid ett mål för att inkludera det i eller utesluta det från plotten.
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Kalkylbladet
På fliken Results (Resultat) finns ett kalkylblad som sammanfattar data från alla diagram. I Tabell 37
definieras data som visas i kalkylbladet Results (Resultat).

Information Beskrivning

Target (Mål) Målnamn (amplifierad gen)

Sample (Prov) Sample name (Provnamn)

Mean (Medelvärde för) Cq Medelvärde för kvantifieringscykeln

Mean Efficiency Corrected
(Medelvärde av
effektivitetskorrigerad) Cq

Medelvärde för kvantifieringscykeln efter justering för
reaktionseffektiviteten

Normalized Expression
(Normaliserat uttryck)

Måluttryck normaliserat till ett referensmål (ΔΔCq)

Relative Normalized Expression
(Relativt normaliserat uttryck)

Normaliserat uttryck i förhållande till ett kontrollprov, kallas även
Fold Change (X-faldig förändring)

Regulation (Reglering) Förändring i uttryck i förhållande till ett kontrollprov

Compared to Regulation
Threshold (Jämfört med
regleringströskelvärdet)

Upp- eller nedreglering av ett experimentellt prov baserat på
tröskelvärdesinställningen

Tabell 37. Information på fliken Results (Resultat)

Obs! Data för replikat finns bara i kalkylbladen på dataanalysflikar där Split Out Replicates (Dela
upp replikat) har valts (alltså Clustergram (clustergram)). Det kan bli en diskrepans mellan
uttrycksdata i genuttrycksanalysens kalkylblad om du väljer ”none” (inget) som kontrollprov på
stapeldiagrammet.
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Genstudie
Skapa en genstudie för att jämföra genuttrycksdata från ett eller flera realtids-PCR-experiment med
hjälp av en kalibrator mellan körningar som normaliserar mellan experimenten. Skapa en genstudie
genom att lägga till data från en eller flera datafiler (.pcrd-tillägg) i genstudien. Programvaran
grupperar dem till en fil (.mgxd-tillägg).

Obs! Det högsta antalet prover som går att analysera i en genstudie begränsas av storleken på
datorns RAM-minne och virtuella minne.

Kalibrering mellan körningar
Försök till kalibrering mellan körningar påbörjas automatiskt i varje genstudie för varje mål för
normalisering av variationer mellan körningar mellan mål som har analyserats i separata
realtidsbaserade PCR-körningar (det vill säga olika .pcrd-filer genererade från olika plattor).

För att programvaran ska känna igen ett prov som en kalibrator inom körning måste den ha samma
målnamn, provnamn, och, i förekommande fall, samma namn på biologisk uppsättning för varje platta
som jämförs.

Obs! Det måste finnas minst ett kalibratorprov mellan körningar i genstudien för att kalibrering
mellan körningar ska fungera. Mål utan lämpliga kalibratorprover mellan körningar behandlas
utan korrigering i genstudien (rekommenderas inte).

Kalibratorer mellan körningar kan tillämpas på två sätt:

n Per target (Per mål) – olika PCR-primrar kan ha olika effektiviteter. Kalibratorn mellan körningar
tillämpas som standard till alla brunnar på samma platta som har sammamålnamn, till exempel
Cq som genereras med samma analys.

n Entire study (Hela studien) – användaren väljer en kalibrator mellan körningen som tillämpas på
hela genstudien.

Dialogrutan Gene Study (Genstudie)
Dialogrutan Gene Study (Genstudie) har två flikar:

n Fliken Study Setup (Studieinställning) – hanterar körningarna i genstudien.

Viktigt! Data i den ursprungliga filen förändras inte om du lägger till eller tar bort datafiler i en
genstudie.

n Study Analysis tab (Fliken Studieanalys) – visar genuttrycksdata för kombinerade körningar.
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Fliken Study Setup (Studieinställning)
I Tabell 38 definieras data som visas på fliken Study Setup (Studieinställning).

Kolumnnamn Beskrivning

File Name (Filnamn) Namn på körningsdatafil (.pcrd-tillägg)

File Folder (Filmapp) Katalog som lagrar datafilen för varje körning i genstudien

Date Created (Skapades
den)

Den dag då körningsdata samlades in

Well Group Name (Namn på
brunnsgrupp)

Namnet på brunnsgruppen som valdes när filen lades till i genstudien.

Tips: För att kunna analysera en brunnsgrupp i genstudien måste
du välja brunnsgruppen i fråga i fönstret Data Analysis
(Dataanalys) innan du importerar datafilen i genstudien.

Step (Steg) Protokollsteg som inkluderar plattavläsning för insamling av
realtidsbaserade PCR-data

Run Type (Körningstyp) Antingen användardefinierad eller PrimePCR™-körning

Protocol Edited (Protokoll
redigerat)

Om det här alternativet är markerat anger det att protokollet som
användes för en PrimePCR-körning har redigerats

View Plate (Visa platta) Öppnar en karta av plattan med data från var och en av körningarna
som ingår i genstudien

Tabell 38. fliken Study Setup (Studieinställning) i dialogrutan Gene Study (Genstudie)

Förbereda en Gene Study (Genstudie)
För att förbereda en genstudie

1. Innan du importerar data till en genstudie måste följande utföras i fönstret Data Analysis
(Dataanalys):

n Verifiera att prover med samma innehåll har samma namn. I en genstudie förutsätter
programmet att brunnar med samma Target name (Målnamn) eller Sample name
(Provnamn) innehåller samma prover.

n Justera baslinjen och tröskeln (Cq) på fliken Quantification (Kvantifiering) för att optimera
data i varje körning.

n Välj brunnsgruppen du vill inkludera i genstudien.

Användarhandbok | 247



Kapitel 11 Genuttrycksanalys

För att du ska kunna visa data från en brunnsgrupp i genstudien, måste den gruppen väljas
innan du importerar datafilen.

På fliken Study Setup (Studieinställning) visas en lista över alla körningar i genstudien.

2. I dialogrutan Gene Study (Genstudie) väljer du fliken Study Setup (Studieinställning).

3. Klicka på Add Data Files (Lägg till datafiler) för att välja en fil i ett webbläsarfönster.

Tips: För att snabbt lägga till körningar till en genstudie kan du dra datafilerna (med
filnamnstillägget .pcrd) till dialogrutan Study Setup (Studieinställning).

4. CFX Manager Dx-programvara utför automatiskt genstudieanalysen efterhand som du lägger till
datafiler. Välj fliken Study Analysis (Studieanalys) för att visa resultaten.

För att ta bort körningar från genstudien

u Välj en eller flera filer i listan och klicka på Remove (Ta bort).

För att lägga till anteckningar om genstudien

u Skriv in anteckningar om filerna och analysen i textrutan Notes (Anteckningar).

Fliken Study Analysis (Studieanalys)
På fliken Study Analysis (Studieanalys) visas data från alla körningar i genstudien. Alternativen för
genuttrycksdataanalysen är desamma som för en enstaka datafil med följande undantag:

n För stapeldiagram visas kalibreringsvärden mellan körningar (om sådana beräknats) när du
klickar på Inter-run Calibration (Kalibrering mellan körningar).

Obs! Endast följande provtyper kan användas som en kalibrator mellan körningar:

o Unknown (Okänd)

o Standard

o Positive Control (Positiv kontroll)

Provtyperna Negative Control (Negativ kontroll), No Template Control (kontroll utan mall, NTC)
och No Reverse Transcriptase Control (kontroll utan reverserat transkriptas, NRT) kan inte
användas som en kalibrator mellan körningar.

248 | Systemen CFX96 Dx och CFX96 DeepWell Dx



Genstudie

Skapa en genstudierapport
För att skapa en genstudierapport

1. Justera data och diagram i genstudierapporten efter behov innan du skapar en rapport.

2. Välj Tools > Reports (Verktyg > Rapporter) i menyn Gene Study (Genstudie) för att öppna
dialogrutan Report (Rapport).

3. Välj alternativen du vill inkludera i rapporten. Rapporten öppnas med standardalternativ valda.
Markera eller avmarkera kryssrutorna för att ändra hela kategorier eller enskilda alternativ inom
en kategori.

Kategorier i genstudierapport på sidan 249 listar tillgängliga alternativ som kan visas.

4. Ändra ordningsföljden på kategorier och objekt i en rapport. Dra alternativen till önskad plats.
Objekt kan bara flyttas inom kategorierna de tillhör.

5. Klicka på Update Report (Uppdatera rapport) för att uppdatera Report Preview
(Rapportförhandsgranskning) med eventuella ändringar.

6. Skriv ut eller spara rapporten. Klicka på knappen Print Report (Skriv ut rapport) i verktygsraden
för att skriva ut den aktuella rapporten. Välj File > Save (Arkiv > Spara) för att spara rapporten i
filformatet PDF (Adobe Acrobat Reader-fil) och välj en plats där filen ska sparas. Välj File > Save
As (Arkiv > Spara som) för att spara rapporten med ett nytt namn eller på en ny plats.

7. (Valfritt) Skapa en rapportmall med den information du vill ha. För att spara de aktuella
rapportinställningarna i en mall väljer du Template > Save (Mall > Spara) eller Save As (Spara
som). Hämta sedan rapportmallen nästa gång du vill skapa en ny rapport.

Kategorier i genstudierapport
Använd dialogrutan Gene Study Report (Genstudierapport) för att ordna genstudiedata i en rapport. I
Tabell 39 listas alla tillgängliga alternativ för en genstudierapport.

Kategori Alternativ Beskrivning

Rubrik

Titel, undertitel och logotyp för rapporten

Report Information
(Rapportinformation)

Data, användarnamn, datafilnamn,
datafilsökväg och den valda brunnsgruppen

Tabell 39. Kategorier för en genstudierapport
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Kategori Alternativ Beskrivning

Gene Study File List (Lista
med genstudiefiler)

Lista med alla datafiler i genstudien

Notes (Anteckningar) Anteckningar om datarapporten

Study Analysis (Studieanalys): Bar Chart (Stapeldiagram)

Analysis Settings
(Analysinställningar)

Lista med valda analysparametrar

Chart (Diagram) Stapeldiagram för genuttryck som visar data

Target Names (Målnamn) Lista med mål i genstudien

Sample Names
(Provnamn)

Lista med prover i genstudien

Data Kalkylblad som visar data

Target Stability
(Målstabilitet)

Målstabilitetsdata

Inter-run Calibration
(Kalibrering mellan
körningar)

Data från kalibrering mellan körningar

Study Analysis (Studieanalys): Clustergram och Scatter Plot (Spridningsdiagram)

Analysis Settings
(Analysinställningar)

Inställningar för respektive typ av diagram

Chart (Diagram) Diagram för genuttryck som visar data

Data Kalkylblad som listar data i varje mål

Tabell 39. Kategorier för en genstudierapport, forts.
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Bilaga A Dataanalysberäkningar
CFXManager™ Dx-programvaran beräknar formler automatiskt och visar resultaten i flikarna Data
Analysis (Dataanalys). I den här bilagan förklaras ingående hur CFX Manager Dx-programvaran
beräknar formler.

Reaktionseffektivitet
Evidens tyder på att användning av ett noggrant mått på effektivitet för varje primer- och probe-
uppsättning ger noggrannare resultat vid analys av genuttrycksdata. Standardvärdet för effektivitet
som används i beräkningarna av genuttryck är 100 %. För att utvärdera reaktionseffektiviteten skapar
du en standardkurva med användning av seriespädningar av ett representativt prov genom ett
relevant dynamiskt intervall och registrerar sedan effektiviteten för påföljande genuttrycksanalys. Om
din körning innefattar en standardkurva så beräknar programmet effektiviteten automatiskt och visar
den under Standard Curve (Standardkurva) på fliken Quantification (Kvantifiering) när Auto Efficiency
(Automatisk effektivitet) är markerat på fliken Targets (Mål) i fönstret Experiment Settings
(Experimentinställningar).

Effektiviteten (E) i effektivitetsformlerna avser de ”effektiviteter” som beskrivs av Pfaffl (2001) and
Vandesompele et al. (2002). I dessa publikationer är en effektivitet på 2 (perfekt dubblering med varje
cykel) ekvivalent med 100 % effektivitet i detta program. Du har möjligheten att konvertera dina
effektivitetsberäkningar till de som används i programmet genom att använda följande matematiska
relationer:

n E = (% Effektivitet * 0,01) + 1

n %Effektivitet = (E – 1) * 100

Relativ kvantitet
Formeln för relativ kvantitet (ΔCq) för alla prover (GOI) är:

Obs! Den här formeln används för att beräkna relativ kvantitet om inget kontrollprov har
definierats.
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Där:

n E = Effektivitet för primer- och probsats. Effektiviteten beräknas med formeln
(% Effektivitet * 0,01) + 1, där 100 % effektivitet = 2

n C q (min) = Genomsnittligt Cq för provet med lägsta genomsnittliga Cq för GOI

n C q (prov) = Genomsnittligt Cq för provet

n GOI = Gen av intresse (ett mål)

Relativ kvantitet när en kontroll väljs
När ett kontrollprov tilldelas beräknas den relativa kvantiteten (RQ) för ett prov med en gen av intresse
(GOI) med den här formeln:

Där:

n E = Effektivitet för primer- och probsats. Effektiviteten beräknas med formeln
(% Effektivitet * 0,01) + 1, där 100 % effektivitet = 2

n Cq (kontroll) = Genomsnittligt Cq för kontrollprovet

n Cq (prov) = Genomsnittligt Cq för alla prover med GOI

n GOI = Gen av intresse (ett mål)

Standardavvikelse för relativ kvantitet
Formeln för den relativa kvantitetens standardavvikelse är

Där:

n SD Relative Quantity = standardavvikelse för relativ kvantitet

n SD CqGOI-prov = Standardavvikelse för Cq för provet (GOI)

n Relative Quantity = Relativ kvantitet för provet

n E = Effektivitet för primer- och probsats. Effektiviteten beräknas med formeln
(% Effektivitet * 0,01) + 1, där 100 % effektivitet = 2

n GOI = Gen av intresse (ett mål)
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Effektivitetskorrigerad Cq (CqE)
Formeln för effektivitetskorrigerad Cq är

Där:

n E = effektivitet

Medelvärde av effektivitetskorrigerad Cq (MCqE)
Formeln för medelvärde av effektivitetskorrigerad Cq är

Där:

n CqE = effektivitetskorrigerad Cq

n n = antal replikat

Normaliseringsfaktor
Nämnaren av den normaliserade uttrycksekvationen kallas normaliseringsfaktorn.
Normaliseringsfaktorn är det geometriska medelvärdet av de relativa kvantiteterna av alla referensmål
(gener) för ett givet prov, såsom beskrivs i följande formel:

Där:

n RQ = Relativ kvantitet

n n = antal referensmål

n GOI = gen av intresse (ett mål)
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Normaliserat uttryck
Normaliserat uttryck (ΔΔCq) är den relativa kvantiteten av målet (genen) normaliserat till kvantiteterna
av referensmålen (gener eller sekvenser) i det biologiska systemet. Du väljer referensmål genom att
öppna fönstret Experiment Settings (Experimentinställningar) och klicka på referenskolumnen för
varje mål som tjänar som en referensgen.

Formeln för normaliserat uttryck som använder beräkningen för beräknad relativ kvantitet (RQ) är

Där:

n RQ = Relativ kvantitet för ett prov

n Ref = referensmålet i en körning med ett eller flera referensmål i varje prov

n GOI = gen av intresse (ett mål)

Förutsatt att referensmålen inte ändrar uttrycksnivå i det biologiska systemet tar beräkningen av
normaliserat uttryck hänsyn till laddningsskillnader och -variationer i cellnummer som representeras i
vart och ett av proverna.

Normaliserat uttryck när en kontroll är vald
När du väljer ett kontrollprov i fönstret Experiment Settings (Experimentinställningar) ställer
programmet in uttrycksnivån för kontrollprovet på 1. I denna situation normaliserar programmet de
relativa kvantiteterna för allt mål(gen)uttryck till kontrollkvantiteten (värdet 1). Detta normaliserade
uttryck är ekvivalent med analysen av det ej skalade normaliserade uttrycket när en kontroll är vald.

Obs! Detta kallas även relativt normaliserat uttryck (RNE) och X-faldig förändring.
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Standardavvikelse för det normaliserade uttrycket
Omskalning av det normaliserade uttrycksvärdet uppnås genom att standardavvikelsen för det
normaliserade uttrycket divideras med det normaliserade uttrycksvärdet för de högsta eller lägsta
enskilda uttrycksnivåerna, beroende på det skalningsalternativ som du väljer. Formeln för
normaliseringsfaktorns standardavvikelse (SD) är

Där:

n RQ = Relativ kvantitet för ett prov

n SD = Standardavvikelse

n NF = Normaliseringsfaktor

n Ref = Referensmål

n n = Antal referensmål

När ett kontrollprov tilldelas behöver du inte utföra den här omskalningsfunktionen på
standardavvikelsen, som visas i följande formel:

Där:

n NE = Normaliserat uttryck

n RQ = Relativ kvantitet för ett prov

n SD = Standardavvikelse

n GOI = Gen av intresse (ett mål)
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Normaliserat uttryck skalat till högsta uttrycksnivå
När körningen inte innehåller kontroller kan du skala det normaliserade uttrycket (NE) för varje mål
(gen) genom att dividera uttrycksnivån för varje prov med den högsta uttrycksnivån i alla prover.
Programmet ställer in den högsta uttrycksnivån till ett värde på 1 och skalar om alla
provuttrycksnivåer. Formeln för den högsta skalningen är

Där:

n GOI = Gen av intresse (mål)

Normaliserat uttryck skalat till lägsta uttrycksnivå
När körningen inte innehåller kontroller kan du skala det normaliserade uttrycket (NE) för varje mål
(gen) genom att dividera uttrycksnivån för varje prov med den lägsta uttrycksnivån i alla prover.
Programmet ställer in den lägsta uttrycksnivån till ett värde på 1 och skalar om alla provuttrycksnivåer.
Formeln för lägsta skalning är

Där:

n GOI = Gen av intresse (mål)

Normaliserat uttryck skalat till medelhög uttrycksnivå
Om körningen inte innehåller kontroller kan du skala det normaliserade uttrycket (NE) för varje mål
(gen) genom att dividera uttrycksnivån för varje prov med det geometriska medelvärdet för
uttrycksnivån hos alla prover. Programmet ställer in genomsnittlig uttrycksnivå till ett värde på 1 och
skalar om alla provuttrycksnivåer. Formeln för genomsnittlig skalning är

Där:

n GOI = Gen av intresse (mål)

n GM = Geometriskt medelvärde för normaliserat uttryck för alla prover
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Standardavvikelse för det skalade normaliserade uttrycket
Omskalning av det skalade värdet för normaliserat uttryck (NE) uppnås genom att det normaliserade
uttryckets standardavvikelse (SD) divideras med värdet för normaliserat uttryck för den högsta (MAX)
eller lägsta (MIN) uttrycksnivån beroende på valt skalningsalternativ.

Obs! När ett kontrollprov tilldelas behöver du inte utföra den här omskalningsfunktionen på
standardavvikelsen.

Beräkningen för den här formeln är

Där:

n NE = normaliserat uttryck

n SD = standardavvikelse

n GOI = Gen av intresse (mål)

n MAX = högsta uttrycksnivå

n MIN = lägsta uttrycksnivå

Regulation (Reglering)
Regulation (Reglering) är ett mått på ökningen eller minskningen i uttrycket av ett mål för ett
experimentellt jämfört med ett kontrollprov och bestäms på följande sätt:

Om Expression (Uttryck) (experimentell) > Expression (Uttryck) (kontroll):

Om Expression (Uttryck) (experimentell) < Expression (Uttryck) (kontroll):

Obs! För Bar Chart (Stapeldiagram), baseras Expression (Uttryck) antingen på den relativa
kvantiteten eller det normaliserade uttrycket, beroende på vilket läge som valts (se Bar Chart
(Stapeldiagram) på sidan 230). För Scatter Plot (Spridningsdiagram), och Clustergram, beräknas
dock alltid reglering från det normaliserade uttrycket.
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Formler för korrigerade värden
En skillnad mellan korrigerade värden och ej korrigerade värden ses endast om en standardkurva
skapas som del av realtids-PCR-körningen. Programmet använder tre ekvationer för att bestämma
felspridning:

n Standardfel

n Standardfel för normaliserat uttryck

n Standardfel för den normaliserade genen av intresse (mål)

Formeln för standardfel är

Där:

n n = Antal referensmål (gener)

n SD = Standardavvikelse

Standardfelet för normaliseringsfaktorn i formeln för normaliserat uttryck är

Där:

n n = Antal referensmål

n SE = Standardfel

n NF = Normaliseringsfaktor

n RQ = Relativ kvantitet

Formeln för standardfel för normaliserad gen av intresse (GOI) är

Där:

n SE = Standardfel

n GOI = Gen av intresse (ett mål)

n NF = Normaliseringsfaktor

n n = antal referensmål
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och roller

I CFX Manager™ Dx-program kan du skapa användare och tilldela en roll till användarna. Roller
begränsar åtkomsten till CFX Manager Dx-funktioner. En användare kan bara tilldelas en roll åt
gången. En CFX Manager Dx-programadministratör kan emellertid ändra användarens roll när som
helst.

Tips: Det är inte nödvändigt att skapa användare för att använda CFX Manager Dx. Om du inte
skapar användare utförs all aktivitet av standardanvändarkontot admin.

Viktigt! Användaradmin är standardadministratörskontot, som du använder för att logga in första
gången i CFX Manager Dx. Du bör skapa en specifik användare för att administrera CFX
Manager Dx. Tilldela denna användare rollen som administratör och utför alla
administreringsåtgärder som denna användare.

Viktigt! CFXManager Dx-program har ingen timeoutfunktion om användaren är inaktiv under en
session. Därför rekommenderas att du implementerar säkerhetsåtgärder genomWindows- eller
tredjepartsverktyg (till exempel en skärmsläckare som kräver inloggning).

Hantera användare
I standardutgåvan av CFX Manager Dx-programvara kan användarkonton ha valfria namn och
lösenord.

Välj roller som du vill tilldela enskilda användare från rollistan i fönstret User Administration
(Användarhantering). I det här exemplet får gästanvändaren också behörighet att spara filer.

Lägga till och ta bort användare
Obs! Endast CFX Manager Dx-administratören kan lägga till och ta bort användare.

Så här lägger du till användarkonton till CFX Manager Dx

1. Välj User > User Administration (Användare > Användarhantering) i hemfönstret.

Dialogrutan User Administration (Användarhantering) visas.
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2. Skriv ett användarnamn för användaren i rutan Manage Users (Hantera användare).

3. Välj en användarroll.

Roller begränsar användarens rättigheter. Principal (Huvudanvändare) är standard.

Tips: Du kan ändra rättigheterna för varje roll. Om du ändrar rättigheterna för en roll
påverkas alla användare som är tilldelade rollen i fråga. Se Hantera rollrättigheter på
sidan 261 för mer information.

4. (Valfritt) Skriv in användarens fullständiga namn och lösenord.

5. Klicka på OK för att öppna en dialogruta och bekräfta att du vill stänga fönstret.

6. Klicka på Yes (Ja) för att stänga dialogrutan och fönstret.

Så här tar du bort en användare

1. Välj Remove (Ta bort) för varje användare som du vill ta bort i rutan Manage Users (Hantera
användare).

2. Klicka på OK för att öppna en dialogruta och bekräfta att du vill stänga fönstret.

3. Klicka på Yes (Ja) för att stänga dialogrutan och fönstret.

Obs! Listan över programvaruanvändare måste alltid inkludera en administratör.
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Hantera rollrättigheter
CFXManager Dx innefattar följande fyra roller:

n Administrator (Administratör) (obligatoriskt) – administratörer har alla rättigheter, och du kan inte
ändra de rättigheterna. Administratörer kan också lägga till och ta bort användare och ändra
rättigheterna för varje roll.

Obs! Endast en administratör kan ändra rättigheterna för roller.

n Principal (Huvudsaklig) – som standard har huvudanvändaren alla rättigheter

n Operator (Operatör) – som standard har operatörsanvändaren alla rättigheter förutom att hoppa
över cykler

n Guest (Gäst) – som standard kan gästanvändare bara läsa filer

Viktigt! När rättigheter för en roll ändras påverkas alla användare som är tilldelade den rollen. Du
kan inte anpassa rollen för en specifik användare. Var försiktig när du ändrar rollrättigheter.

Så här anger du rättigheterna för varje roll

1. Välj User > User Administration (Användare > Användarhantering) i hemfönstret.

2. Gör något av följande i rutan Manage Rights (Hantera rättigheter):

n Avmarkera kryssrutan för rättigheter som du vill ta bort från en roll.

n Du lägger till en rättighet till en roll genom att markera dess kryssruta.

3. Klicka på OK för att öppna en dialogruta och bekräfta att du vill stänga fönstret.

4. Klicka på Yes (Ja) för att stänga dialogrutan och fönstret.

Så här återställer du alla rättigheter för alla roller

u Klicka på Restore Default Rights (Återställ standardrättigheter) i dialogrutan User Administration
(Användaradministration).
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Logga in i CFX Manager Dx-programvaran
CFXManager Dx-programvaran styr vem som loggar in i programvaran via dialogrutan Login (Logga
in). När du startar programvaran visar CFX Manager Dx automatiskt dialogrutan Login (Logga in) när
två eller flera användare är listade i fönstret User Administration (Användarhantering).

CFX Manager Dx visar namnet på den inloggade användaren högst upp i hemfönstret.

Så här loggar du in i CFX Manager Dx

1. Välj ditt namn i listrutan User name (Användarnamn) i dialogrutan Login (Logga in).

2. Skriv in ditt lösenord.

3. Klicka på OK för att stänga dialogrutan Login (Inloggning) och öppna programvaran.

Byta användare
Det går att byta användare medan programvaran är igång.

Så här växlar du användare

1. I hemfönstret väljer du User > Select User (Användare > Välj användare) för att öppna dialogrutan
Login (Inloggning).

2. Välj ett namn i listrutan User Name (Användarnamn).

3. Skriv in den nya användarens lösenord.

4. Klicka på OK för att stänga dialogrutan Login (Inloggning) och öppna programvaran.
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Ändra användarlösenord
CFXManager Dx-användare kan när som helst ändra sina lösenord.

Så här ändrar du användarlösenord

1. Välj User > Change Password (Användare > Ändra lösenord) i hemfönstret för att öppna
dialogrutan Change Password (Ändra lösenord).

2. Ange ditt nuvarande lösenord i Old Password (Befintligt lösenord).

3. Skriv in ett nytt lösenord i New Password (Nytt lösenord) och upprepa lösenordet i Confirm New
Password (Bekräfta nytt lösenord).

4. Välj OK för att bekräfta ändringen.

Visa din roll och dina rättigheter
Tips: Användare som är tilldelade rollerna Principal (Chef), Operator (Operatör) eller Guest
(Gäst) kan bara se sina egna användarinställningar, rättigheter och roller.

För att visa din aktuell användarroll och dina aktuella rättigheter

u Välj User > User Administration (Användare > Användarhantering) i hemfönstret.

Kontakta din CFX Manager Dx-administratör för att ändra användarinställningar, rättigheter och roller
som listas i fönstret User Administration (Användarhantering).
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Det går att konfigurera CFX Manager™ Dx-programvaran för användning med ett system för
hantering av laboratorieinformation (LIMS). För LIMS-integration kräver CFX Manager Dx
plattinställningsinformation som genererats av LIMS-plattformen (en LIMS-fil, *.plrn), en protokollfil
som skapats med hjälp av CFX Manager Dx-programvara (*.prcl), en definierad dataexportplats och
ett definierat exportformat.

När körningen slutförs genererar CFX Manager Dx en datafil (.pcrd) och sparar den på platsen för den
definierade dataexportmappen. CFX Manager Dx kan även skapa en LIMS-kompatibel fil i .csv-format
och spara den på samma plats.

Skapa LIMS-kompatibla datafiler
I den här bilagan förklaras hur du ställer in CFX Manager Dx-programmet till att skapa, spara och
exportera LIMS-kompatibla datafiler.

Konfigurera LIMS-mappen och dataexportalternativ
Som standard sparar CFX Manager Dx LIMS-protokoll, -filer och -dataexportfiler i följande mapp:
_ C:\Users\Public\Documents\Bio-Rad\CFX_Dx\LIMS

Det går att konfigurera CFX Manager Dx så att filerna sparas i en annan mapp, och att ändra
exportalternativen för LIMS-data.

Så här konfigurerar du en LIMS-mapp och -dataexportalternativ

1. Välj Tools > Options (Verktyg > Alternativ) i hemfönstret.

2. Välj Data Export Settings (Dataexportinställningar) i dialogrutan Options (Alternativ).
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3. (Valfritt:) Välj Automatically export LIMS data at end of run (Exportera LIMS-data automatiskt efter
körningen).

Programvaran exporterar automatiskt LIMS-data efter varje körning och sparar den på den
angivna platsen.

4. Klicka på LIMS Data Export Settings (LIMS-dataexportinställningar) om du vill ändra
standardexportalternativen för LIMS-data.

Viktigt! Endast LIMS-data som har exporterats som en .csv-fil kan importeras tillbaka i CFX
Manager Dx.

5. I dialogrutan LIMS Data Export Format Settings (Inställningar av LIMS-dataexportformat) väljer
du nödvändiga exportalternativ och klickar på OK.

6. I dialogrutan Options (Alternativ) går du till och väljer en standardmapp i vilken du vill spara LIMS-
datafilerna. Du kan välja olika platser för varje filtyp:

n Protocol (Protokoll)

n LIMS file (LIMS-fil)

n Data export (Dataexport)

7. Klicka på OK för att spara ändringarna och stänga dialogrutan Options (Alternativ).

Skapa ett LIMS-protokoll
Du startar en LIMS-körning genom att skapa en CFX Manager Dx-protokollfil (*.prcl) och spara den på
den angivna platsen för LIMS-protokollmappen.

Mer information finns i Kapitel 6, Skapa protokoll.
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Skapa en LIMS-fil
En LIMS-fil (*.plrn) innehåller plattinställningsinformation och protokollets filnamn. Filen genereras av
din interna LIMS. CFX Manager Dx använder LIMS-filen för att skapa en plattfil för användning med en
protokollfil.

CFX Manager Dx tillhandahåller plattimportmallfiler som du kan redigera och skapa anpassade LIMS-
plattfiler.

Tips: Den här åtgärden bör utföras av en LIMS-specialist.

Så här skapar du en LIMS-fil

1. Välj View > Show > LIMS File Folder (Visa > Visa > LIMS-filmapp) i hemfönstret.

2. Öppna mappen LIMS Templates (LIMS-mallar) och välj en .csv-fil att importera till din interna
LIMS.

3. Redigera mallfilen med hjälp av LIMS genom att fylla i de fält som visas i Tabell 40.

4. Spara mallen med filnamnstillägget .plrn i mappen LIMS File (LIMS-fil).

Viktigt! CFXManager Dx kan endast öppna .plrn-filen. Du måste spara .csv-filen som .plrn
för att starta LIMS-körningen.

Kolumn Rad Beskrivning Innehåll Syfte

A 1 Plate Header (Plattrubrik) Redigera inte Fördefinierat

A, B, C 2 Field/Data/Instruction
(Fält/Data/Instruktion)

Redigera inte Fördefinierat

B 3 Version Redigera inte Fördefinierat

Tabell 40. Beskrivning av LIMS .csv-filinnehållet
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Kolumn Rad Beskrivning Innehåll Syfte

B 4 Plattstorlek Redigera inte Fördefinierat

B 5 Plate Type (Plattyp) Ange "BRWhite”, "BR
Clear" eller annan
kalibrerad plattyp

Krävs

B 6 Skanningsläge Ange "SYBR/FAM
Only:", "All Channels"
eller "FRET"

Krävs

B 7 Enheter Ange något av
följande: "copy
number", "fold
dilution", "micromoles",
"nanomoles",
"picomoles",
"femtomoles",
"attomoles",
"milligrams",
"micrograms",
"nanograms",
"picograms",
"femtograms",
"attograms" eller
"percent"

Krävs

B 8 Run Log (Körnings-ID) Ge en kort beskrivning
eller ange en streckkod
som identifierar den
här körningen (minst
30 tecken, komman får
ej användas)

Tillval

B 9 Run Note
(Körningskommentar)

Ange en beskrivning
av körningen

Tillval

Tabell 40. Beskrivning av LIMS .csv-filinnehållet, forts.
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Kolumn Rad Beskrivning Innehåll Syfte

B 10 Run Protocol
(Körningsprotokoll)

Ange
protokollfilnamnet
exakt som det är
skrivet.

Krävs

A 11 Data File (Datafil) Ange datafilnamn Tillval

A 12–15 TBD/tom Redigera inte Fördefinierat

A 16 Plate Data (Plattdata) Redigera inte Fördefinierat

Tabell 40. Beskrivning av LIMS .csv-filinnehållet, forts.
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Kolumn Rad Beskrivning Innehåll Syfte

A 17–113 Well Position
(Brunnsposition)

Redigera inte Fördefinierat

B-G Ch1 Dye, Ch2 Dye, Ch3
Dye, Ch4 Dye, Ch5 Dye,
FRET

Ange namnet på en
kalibrerad fluorofor (till
exempel FAM) för
varje kanal som
används

Krävs

H Provtyp Ange en av följande
provtyper: "Unknown",
(Okänd), "Standard",
"Positive Control",
(Positiv kontroll)
"Negative Control",
(Negativ kontroll)
"NTC" eller "NRT"

Krävs

F Sample Name
(Provnamn)

Ange provnamn Tillval

J-O CH1 Target, CH2 Target,
CH3 Target, CH4 Target,
CH5 Target, FRET
Target,

Ange målnamnet för
varje kanal som
används

Tillval

P Biological Set Name
(Namn på biologisk
uppsättning)

Ange namn på
biologisk uppsättning

Tillval

Q Replikat Ange ett positivt heltal
för varje uppsättning
replikat. Värdet får inte
vara noll.

Tillval

R-W CH1 Quantity, CH2
Quantity, CH3 Quantity,
CH4 Quantity, CH5
Quantity, FRET Quantity

Ange kvantitetsvärden
för eventuella
standarder. Ange
koncentrationen i
decimalform.

Krävs för alla
standarder

Tabell 40. Beskrivning av LIMS .csv-filinnehållet, forts.
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Kolumn Rad Beskrivning Innehåll Syfte

X Well Note
(Brunnskommentar)

Ange en
brunnskommentar
(högst 20 tecken)

Tillval

Y-AD Ch1Well Color, Ch2Well
Color, Ch3Well Color,
Ch4Well Color, Ch5Well
Color, FRETWell Color

Ange eventuell
användardefinierad
kurvfärg i ett 32-bitars
decimalformat med
heltal (argb)

Tillval

Tabell 40. Beskrivning av LIMS .csv-filinnehållet, forts.

Starta en LIMS-körning
För att starta en LIMS-körning

1. Gör något av följande för att öppna en LIMS-.plrn-fil:

n I hemfönstret väljer du View > Show > LIMS File Folder (Visa > Visa > LIMS-filmapp) och
öppnar målfilen (.plrn).

n I hemfönstret väljer du File > Open > LIMS File (Arkiv > Öppna > LIMS-fil) och öppnar
målfilen (.plrn).

Filen öppnas på fliken Start Run (Starta körning) i guiden Run Setup (Körningsinställning). På
fliken Start Run (Starta körning) visas information om experimentet som ska köras. Där visas
också det eller de anslutna instrumentblocken som du kan köra experimentet på.
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2. Välj ett instrument på fliken Start Run (Starta körning) och klicka på Start Run (Starta körning).

Exportera data till ett LIMS
När körningen slutförs, genererar CFX Manager Dx en datafil (.pcrd) och sparar den på platsen för den
definierade dataexportmappen.

För att exportera datafilen till ett LIMS

u Öppna .pcrd-filen och välj Export > Export to LIMS Folder (Exportera > Exportera till LIMS-mapp).

Tips: Om du väljer Automatically Export Data after Run (Exportera data automatiskt efter
körning) i LIMS Options (LIMS-alternativ), skapar CFX Manager Dx en LIMS-kompatibel datafil i
.csv-format och sparar den i sammamapp.
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Bilaga D Felsökning av anslutningsproblem för
CFX Manager Dx-programmet

Application Log (Applikationslogg)
Innan en ny körning startas, utför CFX96™ och CFX96 DeepWell-instrumenten ett självdiagnostiktest
för att bekräfta att det körs inom specifikationerna. Programmet registrerar resultaten av detta test i
filen Run Log (Körningslogg) och filen Application Log (Applikationslogg). Om du lägger märke till ett
problem i ett eller flera experiment öppnar du körnings- och applikationsloggarna för att ta reda på när
problemet uppstod.

CFX Manager™ Dx spårar information om tillståndet för ett instrument under en körning i Application
Log (Applikationslogg). Använd dessa loggar för att spåra händelser som uppstår på instrument och i
programmet samt för felsökning.

För att öppna applikationsloggen

u I hemfönstret väljer du View > Application Log (Visa > Applikationslogg).
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Felsökning
Normalt kan problemmed program- och instrumentkommunikation lösas genom omstart av datorn
och systemet. Glöm inte att spara pågående arbete innan du startar om.

Obs! Kontrollera att datorn har tillräckligt RAM-minne och ledigt hårddiskutrymme. Minimikravet
för RAM är 4 GB och minimikravet för hårddiskutrymme är 128 GB.

Strömavbrott
Vid ett strömavbrott stängs instrumentet och datorn av. Om strömavbrottet är kortvarigt återupptar
instrumentet körningen av ett protokoll, men strömavbrottet noteras i Application Log
(Applikationslogg). Beroende på datorinställningarna och längden på strömavbrottet försöker
instrumentet och programvaran att återuppta körningen beroende på protokollsteget:

n Om protokollet är i ett steg utan någon avläst platta fortsätter protokollet att köras så snart
instrumentet återfår ström.

n Om protokollet är i ett steg med en avläst platta väntar instrumentet på att programvaran ska
startas om och återuppta kommunikationen för att samla in data. I en sådan situation fortsätter
protokollet endast om datorn inte stänger av programvaran. När datorn och programvaran startas
igen fortsätter protokollet.

Ta bort prover från reaktionsmodulen vid strömavbrott

Det går att öppna ett låst motoriserat lock på en reaktionsmodul och ta bort proverna vid ett
strömavbrott.

Så här tar du bort låsplattan

1. Tryck ned låsspärren och avlägsna C1000™Dx termocykler.

2. Ställ försiktigt reaktionsmodulen på ett skrivbord eller på labbänken.

3. Placera modulen så att modulens front sticker ut 5 cm utanför kanten.
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4. Ta bort de två stora skruvarna under den främre delen av reaktionsmodulen med en insexnyckel
(under knappen för öppning av locket).

Du ska höra att låsspärren frigörs från insidan på modulen.

Viktigt! Ta inte bort de två små skruvarna på modulens främre del.

5. Tryck på och öppna reaktionsmodulens lock. Observera att spärren (mörk plast) inte längre är
fäst. Ta ut proverna ur blocket.

6. Sätt tillbaka låsspärren och fäst den med de två stora skruvarna för att återmontera
reaktionsmodulen med locket öppet.

Användarhandbok | 275



Bilaga D Felsökning av anslutningsproblem för CFX Manager Dx-programmet

Hämta filer till CFX Manager Dx-datorn
Du kan hämta data och loggfiler i instrumentet och överföra dem till hårddisken på en ansluten dator.

Obs! Alla filer i instrumentbasens realtidsdatamapp hämtas till datorn.

Så här hämtar du filer från instrumentet

1. I rutan Detected Instruments (Hittade instrument) i hemfönstret högerklickar du på
målinstrumentet och väljer något av följande:

n Retrieve Log Files (Hämta loggfiler)

n Retrieve Data Files (Hämta datafiler)

2. Välj en mapp där du vill spara de hämtade filerna.

3. Klicka på OK.

Installera CFX Manager Dx-programvaran manuellt
Så här installerar du CFX Manager Dx-programvara manuellt

1. Koppla från eventuella anslutna instrument från datorn vid behov.

Sök upp och koppla bort instrumentets USB-kabel på CFX Manager Dx-datorn. Den ände som är
ansluten till instrumentet kan sitta kvar på plats.

2. Logga in på CFX Manager Dx-datorn med administratörsbehörighet.

3. Sätt in programvaru-CD:n.

4. I Utforskaren går du till CD, högerklickar på programvarans CD-ikon och väljer Utforska för att
öppna CD-fönstret.

5. Dubbelklicka på mappen CFX_Manager för att öppna den och dubbelklicka sedan på setup.exe
för att starta guiden för programvaruinstallation.

6. Följ anvisningarna i guiden för att installera programvaran och klicka sedan på Finish (Slutför).
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Ominstallera drivrutinerna
För att ominstallera instrumentdrivrutinerna

u I hemfönstret väljer du Tools > Reinstall Instrument Drivers (Verktyg > Ominstallera
instrumentdrivrutiner).

Obs! Om du har problemmed programmets kommunikation med ett realtidssystem när du har
ominstallerat drivrutinerna och kontrollerat USB-anslutningen, bör du kontakta Bio-Rads tekniska
support.
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